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STUDENT MANUAL 

  
COURSE 
  

I-Suite 
  

UNIT 
  

1.0 – Course Overview. 
  

OBJECTIVES 
  

Upon completion of this unit, the trainee will be 
able to: 
  

  1. Identify course organization and topics. 

  



  
  

I-Suite Version 13.01.00 Introduction  1.0-4 

  
I. INTRODUCTION  

NOTE: The Introduction Unit is not "hands on." The information for this section is explained 
in a Power Point presentation. 

A. Transportation.  

1. Who needs rides to lunch, hotel, etc.?  

2. Facilities: Restrooms, drink and snack locations, emergency exits.  

3. Lunch and break schedule.  

4. Telephones and where emergency messages can be left.  

B. Time Frames. 

1. There is a lot to cover.  

2. Class will start at the time specified. 

C. Unit Topics.  

1. The following topics are covered in this training manual:  

a. 1.0 – Course Overview  

b. 1.1 - Security for I-Suite 

c. 1.2 – Getting Started with I-Suite  

d. 1.3 – Common Features  

e. 1.4 – I-Suite Options  

f. 1.5 – Working with grids and tables  

g. 1.6– I-Suite Modules 

D. Course Overview. 

1. The training manual is divided into separate units corresponding to the modules. 

2. Handouts are located at the end of each unit. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 1.1 - Security for I-Suite 

  
OBJECTIVES Upon completion of this unit, the trainee will be 

able to: 
  

  1. Learn the Rules of Behavior to which 
you must adhere. 

2. Identify the key I-Suite security 
principles. 

3. Understand that I-Suite may contain 
PII Data and how that data is protected. 

4. Understand I-Suite user accounts. 
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I. RULES OF BEHAVIOR 

A. All I-Suite users must understand and follow the Rules of Behavior, the security 
principles and practices, and know and practice their responsibilities regarding I-Suite 
security. 

NOTE: Some Incident Management Teams have a Rules of Behavior document that must be read 
and signed. 
  

B. It is everyone's responsibility to safeguard the information that is collected, stored and 
maintained by the I-Suite application. 

C. The Rules of Behavior do not replace but enhance existing agency policies. 

D. Users are to work within the confines of their authorized access or role. Users should not 
attempt to access other modules or screens in the I-Suite application to which they do 
not have authorization. User accounts and additional roles can be granted by a user with 
a DB Admin role, which is usually the incident Computer Technical Specialist (CTSP).

E. Security violations include, but are not limited to: 

1. Sharing of user name and password pairs. 

2. Sharing I-Suite information or data with individuals who do not have an official need 
to know. 

3. Violating any other security policy or procedure. 

F. If you leave your computer for any period of time, close the I-Suite application. This will 
ensure that no unauthorized person can access the I-Suite application while you are 
away. 

II. I-SUITE SECURITY PRINCIPLES 

A. A user must have an active user account in an I-Suite database in order to log into the I-
Suite application and access that database. The only exception to this rule is during the 
initial setup procedure when an initial DB Admin account is created. 

B. Only a user with a DB Admin role can create User Accounts. In most cases, this is the 
incident CTSP at the Incident. 

C. Each user must be assigned a unique user name and password to log into a database 
within the I-Suite application. 

D. A user cannot use the same user account to log into the same database at the same time, 
unless they have a DB Admin role. 

E. Backing up the I-Suite database is crucial and should be done on a regular basis. The I-
Suite application includes an automatic backup feature that allows the CTSP to backup 
the database as often as needed. For more information on backups, refer to the I-Suite 
Database Admin Training Manual. 

F. I-Suite databases should NOT be distributed to anyone except those outlined in other 
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policies (e.g. to transitioning team, owning unit, or authorized personnel).  

G. Before logging into I-Suite you must read and agree to the security statement that 
displays. 

H. Only authorized personnel can attach a repository database file. The repository database 
file does not use the same password as the database used to create it. 

I. You must have a DMS User Name and DMS Password to upload the repository and other 
export files on the I-Suite Web site (http://isuite.nwcg.gov). 

J. You must enter the database password to perform the following processes: 

• Attach a database 

• Detach a database 

• Restore a database from a backup 

• Copy a database 

• Rename a database 

• Merge databases 

K. When you create a new database, you MUST provide a password for the database. The 
requirements for the database password are: 

1. Must contain a minimum of 12 characters. 

2. Must contain at least 1 lowercase letter. 

3. Must contain at least 1 uppercase letter. 

4. Must contain at least 1 number. 

5. Must contain at least one of the following special characters: 
 
!#%&*^ 

6. Cannot be a dictionary word. 

III. PII Data 

A. PII data is Personally Identifiable Information. 

B. The I-Suite application limits access to data based on roles assigned to User Accounts. A 
user can only access data that is relevant to their assigned role. 

C. The I-Suite database may contain PII data, such as Social Security Numbers (SSN), Tax 
Identification Numbers( TIN), address and phone information. 

D. The SSN and TIN are encrypted in the database and are never visible to the user in I-
Suite. Data entry is masked with asterisks and must be entered twice for verification. 

E. All data export files are encrypted for security purposes to protect PII and other sensitive 
data. 
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III. Understand I-Suite User Accounts 

A. I-Suite user accounts consist of a unique user name and password set. They are specific 
to each database and the same account may be used in multiple databases. 

B. A user name must be 1 to 20 characters in length and cannot be "admin." The user name 
usually consists of the first letter of the user's first name and their last name (e.g. John 
Doe is jdoe). 

C. User names must be unique to the database, regardless of the case that is used. For 
example, jdoe and JDoe are considered the same user name. 

D. When you change your password for any reason, your password: 

1. Must contain a minimum of 12 characters. 

2. Must contain at least 1 lowercase letter. 

3. Must contain at least 1 upper case letter. 

4. Must contain at least 1 number. 

5. Must contain at least one of the following special characters: 
 
!#%&*^_ 

6. Cannot be a dictionary word. 

7. Cannot be one of the last 24 passwords defined for your account. 

E. The first time you log into the I-Suite application, you must change your password. 

F. You must change your password when it is reset by an administrator (usually the incident 
CTSP). 

G. Passwords are case sensitive. 

H. If you fail to login with a correct password 5 consecutive times, your user account will be 
locked. 

I. If your User Account is locked, you must contact your local I-Suite Administrator 
(CTSP) to unlock your account. 

J. The password for your User Account in I-Suite will expire 60 days for the last date the 
password was set or reset.  

K. A message will display 3 days prior to the expiration indicating that your password is 
about to expire. You have the option to change the password at that time or wait.  

L. Once your password is expired, you will be prompted to change it the next time you log 
into I-Suite. You must change your password or you cannot access the I-Suite 
application. 

M. You can change your password any time in I-Suite by selecting the Tools menu and the 
Change Password option. 

N. If no users with a DB Admin role can access the I-Suite application, contact the Help 
Desk. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 1.2 - Getting Started with I-Suite 

  
OBJECTIVES Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the components of the I-Suite 
application. 

2. Identify the different methods to obtain 
help for the I-Suite application. 



  
  

I-Suite Version 13.01.00 Introduction  1.2-5 

 
I. HELP 

A. There are several methods you can use to receive Help for the I-Suite Application: 

1. Help is available within the I-Suite application. To access the I-Suite Application 
Help, select the Help drop-down menu at the top of any I-Suite window. When the 
sub-menu displays, select the I-Suite Help option. 

2. The I-Suite Website (http://isuite.nwcg.gov) contains a wide variety of I-Suite 
documentation, including: 

a. Software Downloads 

b. Updates 

c. User Guides 

d. Quick Reference Cards 

e. Training Material 

f. Other User Documentation  

3. Contact your incident CTSP. 

4. I-Suite User Guides include information on using the different modules within I-
Suite. These are available in a PDF format on the I-Suite Website 
(http://isuite.nwcg.gov). 

5. The Training Materials demonstrate how to use the I-Suite system. These are also 
available in a PDF format on the I-Suite Website (http://isuite.nwcg.gov). 

6. For additional help, contact the I-Suite Helpdesk.  

NOTE: Contact information for the I-Suite HelpDesk is available by selecting the Support 
option listed under the Help Menu in I-Suite.  

II. I-Suite Components  

A. I-Suite is comprised of the following modules: 

1. Database Admin 

2. Data Admin  

3. Resources  

4. Demob  

5. Incident Action Plan  

6. Time  

7. Cost 

8. Custom Reports  

9. Supply 

10. Injury/Illness 
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STUDENT MANUAL 
  
COURSE I-Suite 

  
UNIT: 1.3 – I-Suite Common Features. 

  
OBJECTIVES Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the common features of the I-
Suite application.  

a. Menus.  

b. Main I-SuiteToolbar.  

c. Resource Filter buttons.  
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I. COMMON FEATURES  

A. There are many features within I-Suite that are common to most of the modules. These 
features include:  

1. The following drop-down menus are available at the top of each window in the I-Suite 
system:  

a. File menu  

b. Modules menu  

c. Filters menu  

d. Reports menu  

e. Tools menu  

f. Help menu  

3. Module Buttons are located on the left side of the Main toolbar. Click these buttons 
to open the indicated module. 

4. Action Buttons are located on the right side of the Main toolbar. These buttons allow 
you to Add, Edit and Delete entries in the I-Suite system. These buttons also enable 
you to Preview and Print reports and Refresh the window. 

5. Identify the Incident on the top right side of the I-Suite window. 

II. FILTERS AND GRID 

A. Identify where the Filters and Grid are located: 

1. The Filter toolbar is located beneath the Main toolbar. Click the buttons in this toolbar 
to filter the Resources grid by Aircraft, Crews, Equipment, Overhead, All 
Personnel, or display All records. 

2. The Filter Bar is located above the Resources grid. 

3. Exclude Demobed is located next to the Filter buttons. 

4. Exclude Filled is located under Exclude Demobed. 

5. The Resources grid is located in the center portion of the window, beneath the 
toolbars. If a plus sign (+) displays next to a resource, click the plus sign to display 
subordinate resources. 

NOTE: The Resources grid displays on most, but not all, I-Suite windows. 

NOTE: Depending on which module is open, there may be additional buttons and 
checkboxes. 

III. I-SUITE MENUS  

A. Identify File menu items.  

1. Open Database - Open an incident database in I-Suite. 
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2. Print - Print a report. 

3. Refresh Data - Refresh the data on your window. 

4. Exit - Close the I-Suite application. 

B. Select an option from the Modules drop-down menu to open that module in the I-Suite 
system.  

C. Select an option from the Filters drop-down menu to filter the Resources grid. 

D. Identify the type of Reports you can print from the Reports menu:  

1. Cost Reports 

2. Demob Reports 

3. Plan Reports 

4. Supply Reports 

5. Time Reports 

6. Custom Reports 

7. Injury/Illness Reports 

E. Identify Tools menu items.  

1. Options - Define various I-Suite settings. 

NOTE: The settings you can change in Options depends on the permissions that are assigned 
to you in the I-Suite system. 

2. Quick Stats - Quickly view Stats in the I-Suite system. 

3. Change Password - Change your I-Suite password. 

F. Identify Help menu items.  

1. I-Suite Help - Opens Help information for the I-Suite application.  

2. About - Displays version information for I-Suite. 

3. Support - Displays contact information for the HelpDesk. 

NOTE: The Time, Cost and Supply modules have their own menus that display when you 
are in those modules. The functions within those menus are relevant to the selected module 
(i.e. under the Cost menu is Graphs, Accruals, etc.) 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 1.4 – I-Suite Options. 

  
OBJECTIVES Upon completion of this unit, the trainee will be 

able to: 
  

  1.  Select options in the I-Suite application. 

2. Change grid colors.  

3. Select columns to display.  

4. Change the order in which grid columns 
display.  
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I. OPTIONS 

A. Identify options to use in the I-Suite application.  

NOTE: The options you can change are based on the rights assigned to you in the I-Suite 
system.  

NOTE: All customizations are specific to the user. Each user account can apply their own 
customized views for each module. 

II. GRID SETTINGS  

A. Change Grid colors. 

NOTE: Color changes apply to the grids in all modules. 

1. Colors for the grids can be changed on the General tab on the Options window. 

2. You can select a different color for each Grid Area. 

3. Double click the Color Box to open the Color Palette. 

4. When you change the color, you can preview the change under the Grid Colors area 
on the General tab. 

NOTE: Access the Options window from the Tools menu. 

B. Identify the grid columns to display and the order in which to display them. 

1. Identify the grid columns to display on the Options window. 

2. Grid columns can be defined for each module in I-Suite. 

3. The columns that are available for the grid display under Resource Grid Columns. 

4. The columns with checkmarks next to them are the ones that display in the grid. 

5. The order in which the columns display in the grid is the same order in which they 
display under Resource Grid Columns. 

NOTE: You can change the order of the columns in the grid by dragging them to a different 
position under Resource Grid Columns. 

C. Show the Data Saved Message Box. 

1. If the checkbox Show Data Saved Message Box is checked on the General tab on the 
Options window, the Data Saved message displays when the Save button is clicked 
on a window. 

2. If the checkbox Show Data Saved Message Box is not checked, the Data Saved 
message does not display when the Save button is clicked on a window. 

D. Format T-Card Labels. 

1. T-Card labels can be formatted on the Resources/Labels tab on the Options window.
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NOTE: A special printer must be defined to print T-Card labels. 
III. RESOURCE OPTIONS 

A. Other column titles in the Resources grid: 

1. Other column titles for the Resources grid can be changed on the Resources tab on the 
Options window. 

2. Use the box next to the default Other column title to change the title (i.e. to change 
the name of the Other 1 column, enter the new name in the box next to Other 1).  

NOTE: When the title for the Other columns are changed on the Resources tab in Options, 
the changes are saved to the database. This means that all users will see the changes. 

B. Additional kind codes for QuickStats: 

1. Additional Kind Codes for QuickStats can be defined on the Resources tab on the 
Options window.  

2. The Kind/Position drop-down contains a list of kind codes you can add to QuickStats.

3. When you add a new code, it displays in the Additional Kinds used for QuickStats 
grid. 

NOTE: When you add additional kind codes for QuickStats, the changes are saved to the 
database. This means that all users will see the changes. 

C. Each user can identify the Default Checkin Date and Time they want to use in I-Suite.  

1. Define the Default Checkin Date and Time on the Resources tab on the Options 
window. 

2. You can set the the Default Checkin Date and Time to one of the following: 

• System Date - Select this option to automatically use the system date 
and time for the  Check-in.  

• Blank - Select this option leave the Check-In Date and Time blank.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 1.5 – Working with Grids. 

  
OBJECTIVES Upon completion of this unit, the trainee will be 

able to: 
  

  1. Work with grids in the I-Suite 
application.  

2. Filter resources. 

3. Sort resources.  
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I. GRIDS  

A. Work with grids in the I-Suite application.  

B. Filter Resources 

C. Sort Resources 

NOTE: The Grids that display in I-Suite depend on the module that is open.  

II. FILTER RESOURCES 

A. Filter Buttons: 

1. All - Displays all resources in the grid. 

2. Aircraft - Only displays aircrafts in the grid. 

3. Crews - Only displays crews in the grid. 

4. Equipment - Only displays equipment in the grid. 

5. Overhead - Only displays overhead resources in the grid. 

6. All Personnel - Only displays personnel in the grid. 

NOTE: A Leader column displays in the grid when the All Personnel filter is selected. A 
checkmark in this column identifies the resource as a leader. 

B. Filter Bar : 

NOTE: You do not have to enter an entire search term. When you enter the first few 
characters of a term for any column, all entries that begin with those characters display in the 
grid.  

1. Filter terms are entered in the Filter boxes above the columns in the grid.  

2. When defining a filter, you only need to type one or two characters in the Filter box. 
I-Suite filters the grid as you type. 
 
EXAMPLE: To search for all resources with a name that begins with the letter S, 
type that letter in the Filter box above the Name column. 

3. Use the Clear Filter Bar button to clear any filters entered in the Filter Bar. 

III. SORT RESOURCES 

A. Column Headings: 

1. When you click a column heading in the grid, the entries are sorted by that column. 

2. You can sort the grid in either Ascending or Descending order. When you click the 
column heading once, it is sorted in Ascending order. Click it again to sort it in 
Descending order. 
 
EXAMPLE: To sort grid data by request number, click the Request Number 
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column heading. If the data is in Ascending order and you want to display it in 
Descending order, click the column heading a second time. 

B. Multiple Sorts: 

1. You can use multiple sorts for the data in the grid. For example, you could click the 
Overhead button. Then enter S in the filter bar above the Name column and FS 
above the Agency column. Then click the Kind Desc heading to sort the column in 
ascending order. 

NOTE: To use multiple columns to sort the data in the grid, hold down the Shift key and 
click each column heading you want to include in the sort. 

C. Print the Sorted/Filtered Grid. 

1. If you want to print a filtered/sorted grid, you would first need to Filter the grid. Then 
Sort it in the appropriate order. 

2. When you click the Print button in the Main toolbar, a report with the filtered grid is 
sent to your default printer. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 1.6 – I-Suite Modules. 

  
OBJECTIVES Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify how roles determine access to 
each of the I-Suite modules. 

2. Identify the I-Suite modules.  
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I. USER ROLES 

A. Identify how roles determine access to each of the I-Suite modules. 

1. Access to each of the I-Suite Modules is determined by the user's assigned role. A 
User's role may include access to multiple modules (e.g. Resources and Time). 

II. I-SUITE MODULES 

A. Identify the function of the I-Suite Modules: 

1. Database Admin - This module is used to Manage the Database. Access this module 
from the Modules drop-down menu. The following Action buttons display on the 
left side of the window: 

a. Attach - attaches databases to the I-Suite application.  

b. Detach - detaches database from the I-Suite application. 

c. Backup - backs up the databases. 

d. Restore - restores a backup database. 

e. Copy/New DB - creates and copies databases. 

f. Rename - renames a database. 

g. Create Repository - creates a data repository file that can be uploaded to the 
repository site. 

h. Purge SSN/EIN - changes all social security numbers and EINs to 9's. 

i. Import Data - imports data into I-Suite.  

j. Export Data - creates export data files from I-Suite.  

k. IMS - merges databases. 

l. Users - sets up I-Suite users and defines their permissions in the I-Suite 
system. There are two levels of users - Admin (server rights), and I-Suite 
(database rights). An Export and Import option are available to move users 
between databases. 

NOTE: A unique user name and password must be defined for each user in the database.  

2. Data Admin - All incident data and lookup tables are managed through the Data 
Admin Module. Use the options in this module to: 

a. Define incidents in I-Suite.  

b. Manage accounting codes.  

c. Define non-standard lookup tables.  

3. Resources - The Resources Module is the primary data entry point for I-Suite. Keep 
the following points in mind when using the Resources module: 

a. The Add/Edit screen can be accessed from each module. 
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b. Enter Common Data for each resource in the area just beneath the 
Resources grid. 

c. Module tabs display at the bottom of the Resources window. The tabs that 
display are based on the permissions that the user has in I-Suite. 

4. Demob - The Demob module provides additional fields and reports for demob 
planning, reassignment and release.  

a. Use the Action buttons - P (Group Pending), D (Group Demob), and N (No 
Grouping) - on the left side of the Demob toolbar to change the status 
assigned to resources. Use the other buttons to generate Demob reports. 

b. The Default Data from check-in displays in the area on the left side of the 
window.  

c. Tentative Release information is defined in the center section on the Demob 
window.  

d. Actual Release information is defined in the area on the right side of the 
window.  

5. IAP - The IAP module utilizes the I-Suite database to create several of the ICS forms. 

a. Use the buttons in the IAP toolbar to create and maintain ICS forms. 

b. Forms created in IAP display in the Tree View. 

c. The user can create the following ICS forms in IAP: ICS202, ICS203, 
ICS204, ICS205, ICS206 and ICS220.  

6. Time - The Time Module allows the user to manage time records, create payment 
documents and reports. Use this module to: 

a. Post personnel, crew, and contract time.  

b. Post commissary adjustments. 

c. Edit roster data.  

d. Print invoices (OF-286 and OF-288). 

7. Cost - The Cost Module is a tool to analyze and report cost data. Use this module to: 

a. Generate daily cost records.  

b. View daily cost records. 

c. Edit daily cost records.  

8. Custom Reports - Custom reports may be created using the Report Designer or by 
using the Advanced Designer.  

a. Report Designer: Use pre-defined views and fields to design and run 
reports.  

b. Advanced Designer - Use SQL statements to design and run reports.  

9. Supply - The Supply Module allows the user to: 
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a. Track, issue and return items for resources and locations. 

10. Injury/Illness - The Injury/Illness module allows the user to: 

a. Track injuries, illnesses and prevention for an incident. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 2.0 – Database Admin: Overview. 

  
TRAINING AIDS: Computer projector, screen, computer (one for 

instructor and one per trainee). 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Identify the purpose of the Database 
Admin module. 
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NOTE: Although Database Admin is the primary responsibility of the Computer Technical 
Specialist (CTSP), if you are only using one module in I-Suite or if you are an separate 
individual using I-Suite (i.e., not networked) you will need to be familiar with the Database 
Admin module to setup your system.  

I. DATABASE ADMIN  

NOTE: You must be assigned the Database Admin role and be working on the I-Suite server 
computer to perform Database Admin functions. 

A. The purpose of the Database Admin module is to:  

1. Manage the incident database, which includes:  

a. Creating an incident database.  

b. Attaching an incident database.  

c. Detaching an incident database.  

d. Backing up an incident database.  

e. Restoring an incident database.  

f. Copying an incident database.  

g. Renaming an incident database.  

2. Define I-Suite users and roles.  

3. Import ROSS data into I-Suite.  

4. Create the data repository file.  

5. Export financial and injury/illness data. 

6. Purge SSN/EIN’s from the database.  

7. Merge an incident database.  

NOTE: Procedures for Merging a database can be found in the Help system and the 
Database Admin User Reference Manual.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 2.1 – Database Admin: Managing Your Incident 

Database. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Manage an Incident Database: 

a. Creating an incident database.  

b. Attaching an incident database.  

c. Detaching an incident database.  

d. Backing up an incident database 
manually.  

e. Backing up an incident database 
automatically.  

f. Restoring an incident database.  

g. Copying an incident database.  

h. Renaming an incident database.  

i. Identifying the current versions of the I-
Suite application, database, and 
installation.  
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I. MANAGE INCIDENT DATABASE  

A. Create an incident database.  

B. Copy an incident database. 

C. Attach an incident database.  

D. Detach an incident database.  

E. Back up an incident database manually.  

F. Back up an incident database automatically.  

G. Restore an incident database.  

H. Rename an incident database.  

I. Identify the current versions of your I-Suite application, database, and installation.  

NOTE: Use your team's naming standards to name the new incident database. General 
Database Naming Rules are as follows: 

• The database name should include the incident name.  

• The name must not include any spaces, semi-colons, dollar signs, or any characters not 
allowed by MS Windows File Naming Conventions.  

NOTE: All activities in the Database Admin module can only be performed on the I-Suite 
Server. 

II. CREATE NEW DATABASE/COPY DATABASE 

A. To create a blank incident database: 

1. From the Modules drop-down menu, select Database Admin to open the Database 
Admin window.  

2. Click the Copy/New DB button to open the Copy Database window.  

3. Click the Create New Database button. 

4. In the Database Name box, type the name you want to assign to the new database. 

NOTE: The database name should follow the General Database Rules that were previously 
defined. 

5. In the Database Password box, type the password to assign to the database.  

6. Retype the password in the Verify Password box to make sure it was entered 
correctly. 

NOTE: The password you define must be at least 12 characters long and include at least one 
lowercase letter, one uppercase letter, one number, and one Special Character. The only 
Special Characters you can use are !#%&*^_. You cannot use any other special characters in 
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the password.  

6. Click the OK button to create the new database. 

NOTE: The File Path Of New Database box displays the complete file location of the new 
incident database.  

B. To create a new database by copying the master database:  

1. Open the Database Admin module.  

2. On the Database Admin window, click the Copy/New DB button.  

3. From the Name of Database to Copy drop-down list, select the database you want to 
copy.  
 
Notice that the path for the database automatically displays in the Database File 
box when you select a database. If the path is not correct, you can either type a new 
path in this box or use the browse button to select the path. 

4. In the Database Password box, type the password for the database you are copying. 

5. Under New Database, type the name to assign to the new database in the Database 
Name box.  

NOTE: Follow your team's naming standards to name the new incident database. Make sure 
you follow the General Database Naming Rules that were previously defined. 

6. In the Database Password box, type the password to assign to the new database. 
Retype the password in the Verify Password box to make sure it was entered 
correctly. 

7. Click the OK button to create the new database. 

NOTE: The Copy Database procedure automatically attaches the new copy of the incident 
database.  

III. ATTACH/DETACH DATABASE 

A. Attach an incident database.  

1. Open the Database Admin module.  

2. On the Database Admin window, click the Attach button to open the Attach 
Database window.  

3. Click the browse button next to IDB.GPG File of database to attach.  

4. On the Browse for Existing Database File window, click to select the master 
database file (extension .gpg) you want to attach. Then click the OK button.  
 
The name of the database you are attaching displays in the Attach as box. This is 
the name the system automatically assigns to the database. You cannot change this 
name. 
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NOTE: You cannot use the attach function to attach the Master (ISuite.gpg) database.  

5. In the Database Password field, type the password for the database you are attaching.

B. Detach an incident database.  

NOTE: Make sure no one is using the database when it is detached or their unsaved data will 
be lost. 
 
When you detach a database, other users will no longer have access to the database. 

1. Open the Database Admin module.  

2. Click the Detach button to open the Detach Database window.  

3. From the Name of Database to Detach drop-down list, select the database you want 
to detach. 

4. In the Database Password box, type the password for the database you are detaching.

5. Click the OK button. 

6. A message displays indicating that you are about to detach the database. Click the Yes 
button to continue. 

7. If there are open connections to the database, a message displays indicating that there 
are connections open. Click the Yes button to close the connections and detach the 
database. 

IV. BACKUP DATABASE 

A. To Manually backup an incident database: 

1. Open the Database Admin module.  

2. On the Database Admin screen, click the Backup button.  

3. On the Backup Database window, click the Manual Backup tab.  

4. From the Database drop-list, select the database you want to backup. 

5. I-Suite automatically inserts a name for the backup in the Name box. This name 
contains the name of the database and the date and time of the backup. If needed, 
you can change this entry. 

6. I-Suite automatically inserts the path C:\Program Files\ISuite\Database\Backup into 
the Backup To box. If needed, you can change this path by either typing a new one 
or using the Browse button to select the path. 

NOTE: If you change the default path for the backup, I-Suite will back the database up to 
both the default path and the directory specified in the Backup To box. 

7. Click the Backup Now button.  

B. To automatically backup an incident database:  

NOTE: Once initiated, automatic backups will continue at the specified intervals until 
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automatic backups are deactivated.  

1. Open the Database Admin module.  

2. On the Database Admin window, click the Backup button.  

3. On the Backup Database window, click the Auto Backup tab.  

4. Click to check the Auto Backup Enabled checkbox.  

5. Under Selected Databases, click to check the checkbox next to each of the Databases 
you want to include in the backup procedure.  

6. From the Backup Interval drop-down list, select the total amount of time the system 
should wait before performing the backup.  

7. In the Backup Destination box, either type the path for the directory where you want 
to save the backup copy or use the browse button to select the path. 

NOTE: If you change the default path for the backup, I-Suite will back the database up to 
both the default path and the directory specified in the Backup To box 

8. Click the Save button, and then click the Close button to close the Backup Database 
window. Click the OK button to acknowledge that automatic backups have been 
activated.  

NOTE: If you close the I-Suite application, Automatic Backups will not occur. For security 
reasons, lock your computer screen when you leave the computer.  

V. RESTORE DATABASE 

NOTE: You can restore either the .bak or the .gpg file. 

A. Restore an incident database.  

1. Open the Database Admin module.  

2. On the Database Admin window, click the Restore button to open the Restore 
Database window.  

3. Click the browse button next to Restore From.  

4. On the Browse for Existing Database Backup File window, click to select the 
backup file (bak) you want to restore. Then click the OK button.  

5. In the Restore as database box, type the name to assign to the restored database. 

NOTE: Restoring the database with the same name as the original database will rename the 
original database with 1 appended to the end of the name. 
 
The Database Name should follow the same General Database Naming Rules that were 
previously defined. 

6. In the Database Password box, type the password for the database you are restoring. 
Then click the OK button.  
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VI. RENAME DATABASE 

A. To rename an incident database: 

1. Open the Database Admin module.  

2. Click the Rename button. 

3. From the Name of Database to Rename drop-down list, select the database you want 
to rename. 
 
Notice that the path for the database automatically displays in the Master Data File 
Source of Database box when you select a database. If the path is not correct, you 
can either type a new path in this box or use the browse button to select the path. 

4. In the New Database Name box, type the new name for the database. 

5. In the Database Password box, type the password for the renamed database. 

NOTE: Make sure you follow the General Database Naming Rules that were previously 
defined.  

6. Click the OK button to rename the database. 

VII. DATABASE VERSION 

A. To identify the current versions of your I-Suite application, database, and installation.  

1. From the  Help drop-down menu, select About.  

2. Review the version information on the About window. 

3. Click the OK button to close the window when you have finished reviewing the 
information. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 2.2 – Database Admin: Managing Users and 

Roles. 
  

OBJECTIVES Upon completion of this unit, the trainee will be 
able to: 
  

  1. Manage Users and Roles: 

a. Creating Database Admin users.  

b. Creating new users.  

c. Managing users.  

d. Exporting Users 

e. Importing Users 

f. Disconnecting Users  
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I. MANAGE USERS AND ROLES 

A. Create the Database Admin user.  

B. Create a new user.  

C. Manage users.  

D. Export users. 

E. Import users. 

F. Disconnect users. 

II. DATABASE ADMIN USER 

NOTE: The Database Admin user is a special account that is added to the I-Suite server, 
rather than a database in I-Suite. 

A. To create an initial Database Admin user: 

1. Open I-Suite on the server.  

2. After reading the security message that displays, click the Yes button to continue. 

3. Click the Initial Server Setup button on the Login window.  

4. On the New User window, complete the following:  

a. In the User Name box, type a User Name for the Database Admin user.  

b. Type the First Name and Last Name of the new Database Admin user in 
the appropriate boxes.  

c. In the New Password box, type a New Password following the 
requirements specified on the window.  

d. In the Confirm Password box, enter the New Password.  

4. To save the New User, click the Save button.  

NOTE: All rights except for the Injury/Illness module are automatically assigned to the 
Database Admin. To change the rights for the Database Admin, refer to step III-B - Manage 
Users.  

III. I-SUITE USERS 

NOTE: I-Suite users are added to a selected database. 

A. To create a new user: 

1. Open the Database Admin module.  

2. Click the Users button to open the User Management window.  

3. Click the  ISuite Users tab. 

4. From the Database drop-down list, select the database to which you are adding the 
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user. Then click the Connect button. 

5. In the User Name box, type the user name to assign to the person.  

6. Enter the person's First Name and Last Name.  

7. Type a temporary Password for the person in the Password box. Type the password a 
second time in the Verify Password box to make sure it was entered correctly. 

NOTE: The password you enter is a temporary password for the person. When they log into 
the system for the first time, they will be required to enter a new password.  

8. To activate the user account, click to check the Active checkbox.  

9. Click to check the appropriate rights for the user (e.g. Resources, Time, Cost, etc. ).  

NOTE: If you click the All Rights button, all rights except Injury/Illness are assigned to the 
user. You must click to check the Injury/Illness checkbox to assign those rights to a user. 

10. After you have defined the user's rights, click the Save button to save the user to the 
system.  

11. To add another New User, click the Add button. Then follow the preceding 
instructions for adding a new user.  

NOTE: Each user must have a unique user name to log into a database. You cannot have 
multiple users logged into a database with the same user name. If you try to log into the 
database under a user name that is already logged in, a message displays indicating that they 
are already logged into the system (e.g. jdoe is currently logged in on IBM-98se4200). 

B. To manage users: 

1. Open the Database Admin module.  

2. On the Database Admin window, click the Users button to open the User 
Management window.  

3. Under Users on the I-Suite Users tab, click to select a User Name.  

4. To change the rights of the User, click to check or uncheck the rights you want to 
assign (e.g. Resources, Time, Cost, etc.).  

NOTE: Deselecting a user's rights restricts the user's access to those modules in I-Suite. 

5. To activate or deactivate the user, click to check or uncheck the Active checkbox.  

6. When you are finished, click the Save button to save your changes. Then click the 
Close button to close the User Management window. 

IV. EXPORT USERS 

NOTE: This process exports all users with an Active status to a file. The export includes all 
of the user information, including their permissions. After you export users from a database, 
use the Import Users option to import the users into a different database. 

A. To export users from a database: 
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1. Open the Database Admin module. 

2. Click the Users button to open the User Management window. 

3. Click the Export Users button to open the User Export window. 

4. From the Name of database with users to export drop-down list, select the 
appropriate database.  

5. In the Export File Name box, type the name to assign to the user file you are 
exporting.  

6. Click the OK button to export the users to a file.  

7. When the message Isuite User Data Export complete message displays, click the 
OK button to close the window.  

8. When the User Export window re-displays, notice that the path where the file was 
exported displays in the Export File Name box. Click the Close button to close the 
User Export window.  

V. IMPORT USERS 

NOTE: You must first export the users to a file before you can import them into a different 
database (See section IV. Export Users). 

1. Open the Database Admin module. 

2. Click the Users button to open the User Management window. 

3. Click the Import Users button to open the User Import window. 

4. From the Name of database for User Data Import drop-down list, select the database into 
which you want to import the users. 

5. Click the Browse button next to the User Data file for import box to search for the user 
data file you want to import. On the Browse for Existing User Data File window, click the 
file you want to import then the OK button to insert it into the User Data file for import 
box.  

6. In the Generic password for imported users box, type a temporary password to assign to 
all of the imported users.  

7. In the Confirm password for imported users box, re-type the temporary password to 
ensure it was entered correctly.  

8. Click the OK button to import the users to the selected database.  

9. A message displays identifying any fields that were not updated for the users. Click the OK 
button to close this window.  

10. When the Isuite User Data Import Successful message displays, click the OK button to 
close the window.  

11. Click the Close button on the User Import window to close the window.  

VI. DISCONNECT USER 
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A. To clear a user connection if problems occur when logging into the system: 

1. Open the Database Admin module. 

2. In the Connection Information grid, click the user that you want to disconnect. 

3. Click the Disconnect User button in the bottom right-hand corner of the window. 

4. When the confirmation window displays, click the Yes button to disconnect the user. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 2.3 – Database Admin: Importing ROSS Data. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Import ROSS data into I-Suite. 
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I. ROSS FILE DOWNLOAD AND IMPORT 

A. Check Internet Settings 

B. Download ROSS File 

C. Import ROSS data into I-Suite. 

D. Import Excluded Resources  

II. IMPORT ROSS DATA 

A. Check Internet Settings Prior to Download 

IF THE INSTRUCTOR HAS AN INTERNET CONNECTION, THEY MAY WANT TO DEMOSTRATE THE 
ROSS DOWNLOAD PROCEDURE. 

1. In Internet Explorer, select the Tools menu and the Internet Options. 

2. Click the Security tab and select the Trusted sites option. 

3. Click the Sites button. 

4. In the Add this website to the zone box, enter http://fam.nwcg.gov and click the 
Add button. 

5. Click the Close button to close the Trusted sites window. 

6. Click the Custom Level button. 

7. Under Active X controls and plug-ins, select Enable for the following options: 

• Download unsigned ActiveX controls. 

• Initialize and script ActiveX controls not marked as safe for scripting. 

8. Click the OK button on the Trusted Sites Zone window to apply the changes. 

9. Close Internet Explorer. 

B. Download a ROSS data file.  

NOTE: For training purposes, you will be importing the ROSS Data File provided by the 
instructor.  

NOTE: This process can be run either from ROSS or directly from Internet Explorer. If you 
run this process from ROSS, select the Administration/Reports Menu option, then skip to step 
6. When running the process directly from Internet Explorer, complete all steps. 

1. Open your Internet browser.  

2. In the Address box, type http://fam/nwcg.gov/crn/cgi-bin/cognos.cgi.  

3. From the Namespace drop-down on the Login page, select ROSSLDAPSSL and click 
the OK button.  

4. Enter your ROSS User ID and Password. Click the OK button to log into Cognos. 
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5. On the Public Folders tab, select ROSS. 

6. Select the User Community Reports option. 

7. Select the System Extracts option. 

8. Select the I-Suite Import File option. 

9. Click the Incident label on the top left side of the page to expand or collapse the 
incident selection area. 

10. To filter the list of incidents, enter the filter criteria and click the Filter button. 

11. Select an incident from the list. 

12. Click the View Report button. 

13. After the report opens on the page, click the Create ISuite Extract button to extract 
the data in the report for I-Suite. 

14. In the Enter a Filepath and Filename box, enter the path and name to assign to the 
file you are extracting. Click the OK button to extract the file. 

NOTE: The path and name defaults to c:\Isuite.text. The Isuite.txt file will overwrite an 
existing Isuite.txt file. If needed, you can change this name and path. If you change the file 
name, make sure the extension .txt is appended to the end of the name or the file will not 
import into the I-Suite system. 

15. When the extract is complete, a message displays indicating that the extract was 
successful. Click the OK button to close the message. 

16. Click the Log Off option on the top left corner of the page. 

17. Close Internet Explorer. 

C. Import ROSS data into I-Suite.  

NOTE: ROSS Data Files are updated every two hours. You can import ROSS data into an I-
Suite Database as many times as needed.  

NOTE: There might be more characters in ROSS data than are allowed for the corresponding 
data in I-Suite. If this occurs, you will be prompted to shorten the data.  

1. Open the Database Admin module.  

2. Click the Import Data button.  

NOTE: The Status Bar in the bottom left corner of the Ross Import window identifies the 
database into which you are importing data. It also shows the current step on which you are 
working in the process.  

3. On the ROSS Import window, click the Import from File option under Import 
Type. 

4. Click the browse button next to Import File Name.  

5. On the Browse for Existing ROSS Import File window, click the Look in drop-
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down list. Then select the folder into which you copied the ROSS data file.  

6. Click to select the ROSS data file to be imported into I-Suite, and then click the OK 
button.  

7. On the ROSS Import window, click the Load Data button. 

8. After the data has finished loading, the Match/Add Incident step displays as the first 
step under Import Steps on the ROSS Import window. Click the >> button to move 
the ROSS Incident to the I-Suite Incidents grid, and then click the Next button.  
 
OR  

9. If you want to match a ROSS incident to an I-Suite incident, click the Selector 
button to select the ROSS incident. Then click the Selector button to select the I-
Suite incident. Click Match to match the incidents. Then click the Next button.  

NOTE: I-Suite uses Ross IDs to match Resources in the Ross Data File with resources in the 
I-Suite Database. One or more of the following steps may be required, depending on the 
Resource Matches: 

• PREVIOUS MATCHES – Previously Matched Ross and I-Suite Resources.  

• VALIDATE MATCHES 1 – Ross and I-Suite Resources matched by Request 
Number and Name.  

• VALIDATE MATCHES 2 – Ross and I-Suite Resources matched by Request 
Number. This step requires the user to manually match a ROSS resource to an I-
Suite resource. 

• MANUALLY MATCH/ADD – Ross Resources that were not matched to I-Suite 
Resources. Ross Resources can be manually matched or added to I-Suite 
Resources.  

• VALIDATE CREWS – Crew Members with similar Request Numbers that 
were not matched to a Crew.  

9. To complete the Add Resources step, click the >> button to add all resources from the 
ROSS Resources grid to the I-Suite Resources grid. To add individual resources, 
click the Selector for each ROSS resource, and then click the > button.  

10. After all of the appropriate ROSS Resources have been added to the I-Suite 
Resources grid, click the Next button to import the ROSS resources into the I-Suite 
database.  

11. To complete the Previous Matches step, compare the ROSS Resources to the I-
Suite Resources. If matched resources that should not be matched are found, click 
the Selector button for the I-Suite resource, and then click Unmatch. To edit the I-
Suite resources, type directly into the I-Suite grid.  

12. When you are finished editing I-Suite resources, click the Next button.  

13. To complete the Validate Matches step, compare ROSS Resources that were 
matched to I-Suite Resources.  
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14. If you find there are resources that were incorrectly matched, click the Selector 
button to select the I-Suite resource. Then click the Unmatch button. To edit an I-
Suite resource, type directly into the I-Suite grid.  

15. When you are finished editing the I-Suite resources, click the Next button.  

16. To complete the Manually Match/Add Resources step, click the Selector button to 
select the ROSS resource and the I-Suite resource. Then click the Match button. 
To edit an I-Suite resource, type directly into the I-Suite grid.  

17. To add all resources from the ROSS Resources grid to the I-Suite Resources grid, 
click the >> button. To add individual ROSS resources to the I-Suite Resources 
grid, click the Selector button for each ROSS resource, and then click the > button. 

NOTE: An "X" displays in the Ross Resources grid next to each resource that was manually 
matched to an I-Suite Resource.  

18. I-Suite automatically places crew members into the appropriate crews. To complete 
the Validate Crews step, review the list of crew members listed in the grid for each 
crew. If a crew member was assigned to the wrong crew, click the Selector button 
for the incorrect crew member and click the < button to remove the crew member 
from the crew. 

NOTE: The I-Suite system will not import a crew member that was removed from a crew. To 
import that resource as a single resource, you must use the Import From Previous Exclusions 
option after completing the ROSS Import process. 

18. Click the Next button. Then repeat the Validate Crews step for all remaining 
unassigned crew members.  

19. When all of the crews are validated, click the Next button to move to the next step 
in the import process. 

20. To complete the Excluded Resources step, review the list of excluded resources 
that displays.  

NOTE: A list of excluded resources only displays if you did not import all of the resources in 
the ROSS Import file. 

21. When you have finished reviewing the excluded resources, click the Next button to 
display the message Import process is complete. Click the OK button to close the 
window.  

III. Import Excluded Resources 

A. To import resources that were excluded when importing a ROSS Import file: 

NOTE: This process is only available if you did not import all resources in a ROSS Import 
file. 

1. Open the Database Admin module. 

2. Click the Import Data button. 
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3. Click the Import from Previous Exclusions option under Import Type. 

4. From the Import Incident drop-down list, select the ROSS Import File that included 
the resources that were excluded from the import. 

5. Click the Load Data button. 

6. Complete the remaining import steps listed under the Import Steps area on the Ross 
Import window. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 2.4 – Database Admin: Creating Export Files. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Export Data by creating a Data 
Repository File. 

2. Identify how to export Financial and 
Injury/Illness Data. 
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I. EXPORT FILES 

A. Create the data repository file.  

B. Identify how to export Financial and Injury/Illness Data. 

II. DATA REPOSITORY EXPORT  

A. Create an I-Suite data repository file.  

NOTE: You must have a DMS User Name and Password to access the I-Suite Data 
Repository Site. For more information, contact your incident commander or the I-Suite 
HelpDesk. 

1. Open the Database Admin module.  

2. Click the Export Data button to open the Data Export window. 

3. Under Export Type, click the Repository option. 

4. From the Database drop-down list, select the attached database for which you are 
creating the repository file. 

5. Under Select incident to be used in the file name, click to check the checkbox for 
one or more incident(s) to export.  

6. Click the OK button to create the Repository file. 

7. When the End of Incident window displays, identify whether this is the end of the 
incident. If it is, click the Yes button. If it is not, click the No button. 

8. When the system has finished creating the repository files, a Repository Files 
Created window displays. Click the OK button to close the window.  

B. Upload an I-Suite data repository file.  

NOTE: The default folder in which I-Suite Data Repository Files are saved is C:\Program 
Files\ISuite\Database\Backup\Repository.  

 Start your Internet browser.  

 In the Address box, type http://isuite.nwcg.gov.  

 On the Welcome to I-Suite webpage, click Data Repository.  

 On the Security Alert window, click the Yes button.  

 On the I-Suite Login window, type your DMS User Name and DMS Password in 
the appropriate boxes, and then click the OK button.  

 On the I-Suite Upload Form, click the browse button next to the File box. Browse 
to where the file is located. Then click the file to select it.  

 Click the Upload button.  

III. FINANCIAL AND INJURY/ILLNESS EXPORTS 

A. The Financial option under Export Type is used by the CTSP to export Financial data 
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(Accrual and Casual Pay). The Injury/Illness option under Export Type is used by the 
CTSP to export Injury/Illness data. 
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STUDENT MANUAL 
  

COURSE: I-Suite 
  

UNIT: 2.5 – Database Admin: Purging SSN/EIN’s from 
the database. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Purge SSN/EIN’s from the database. 
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I. PURGE SSN/EIN  

A. Purge SSN/EIN’s from the database.  

II. PURGE PROCESS 

A. To purge SSN/EIN’s from the database: 

1. Open the Database Admin module.  

2. Under Databases, click to select the Database you want to purge. Then click the 
Purge SSN/EIN button.  

3. On the Clear SSN’s and EIN’s window, click the Yes button to set all SSN’s and 
EIN’s in the database to 9’s. 

4. When the second Clear SSN’s and EIN’s window displays, click Yes to confirm that 
you want to set all SSN’s and EIN’s in the database to 9’s.  

NOTE: Because the purge process cannot be reversed, two warning messages for the 
procedure display.  
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STUDENT MANUAL 
  

COURSE: I-Suite 
  

UNIT: 2.6 – Database Admin: Auditing. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Audit activity in the I-Suite system. 
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I. AUDITING  

A. View I-Suite Login History. 

B. View External Access History 

C. View User Account History 

D. View External Account History  

II. View I-Suite Login History 

A. To view a history of logs into and out of different databases in the I-Suite System: 

1. Open the Database Admin module.  

2. Click the Auditing button.  

3. Make sure the I-Suite Login History tab is selected. 

NOTE: The Login History identifies the user name logged into the database, the name of the 
database into which the user is logged, whether the login attempt was successful and the date 
and time when the login occurred. 

3. When you have finished viewing the login history, click the Close button to close the 
Auditing window.  

VIEWING A LOGIN HISTORY 
II. View External Access History 

A. To view a history of external user accounts that accessed an I-Suite database in an 
external application: 

1. Open the Database Admin module. 

2. Click the Auditing button. 

3. Click the External Access History tab. 

4. If External Auditing is Disabled, click the Enabled option under External Account 
Auditing. Then and click the Save button to enable this auditing function.  

NOTE: Enabling the External Account Auditing function starts the auditing process. The 
external access audit history will only contain a history of external accounts that accessed an 
external application from that point on. It will not include any history that occurred prior to 
that point. 

5. Click the Import External Account Data button to import all of the external access 
history that occurred since this function was either last enabled or run. 

NOTE: Depending on the amount of history that is available, it may take several minutes for 
the system to import the current external access history. 

6. When you have finished viewing the external access history, click the Close button to 
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close the Auditing window.  

VIEWING AN EXTERNAL ACCESS HISTORY 
III. View User Account History 

A. To view a history of changes made to User and Admin Accounts in the I-Suite system: 

1. Open the Database Admin module. 

2. Click the Auditing button. 

3. Click the User Account History tab. 

NOTE: The User Account history identifies the user name, the audit event, the database 
associated with the account, the user who created the account and the date and time when the 
account was created. 

4. When you have finished viewing the User Account history, click the Close button to 
close the Auditing window. 

VIEWING AN EXTERNAL ACCESS HISTORY 
IV. View External Account History 

A. To view a history of changes made to External User Accounts in the I-Suite system: 

1. Open the Database Admin module. 

2. Click the Auditing button. 

3. Click the External Account History tab. 

NOTE: The External Account History identifies the user name, the audit event, the database 
associated with the External User Account, the user who created the account and the date and 
time when the account was created. 

4. When you have finished viewing the External Account history, click the Close button 
to close the Auditing window. 

VIEWING AN EXTERNAL ACCESS HISTORY 
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Table of Contents 
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I-Suite Data Admin 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 3.0 – Data Admin: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the purpose of the Data Admin 
module.  

2. Manage incident data.  

3. Manage lookup tables.  
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NOTE: Use Data Admin to Manage Incident Data and Lookup Tables. 

I. DATA ADMIN  

A. Identify the responsibilities of the Data Administrator:  

1. Manage incident data.  

2. Manage lookup tables.  

NOTE: Only those users assigned Data Admin rights can access the Data Admin module. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 3.1 – Data Admin: Manage Incident Data. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Manage incidents.  

2. Manage accounting codes.  
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I. INCIDENT DATA  

A. Manage incidents.  

B. Manage accounting codes.  

II. MANAGE INCIDENTS 

A. To manage incidents: 

NOTE: Multiple incidents can be included in one database. Each incident must have a unique 
default accounting code. 

NOTE: Required information is identified with an asterisk (*) before the label. 

1. From the Modules drop-down menu, select Data Admin.  

2. On the Data Admin window, click the Incident Data tab.  

3. To add a new incident to the database:  

a. Under Feature, click to select Incident.  

b. In the Incident Name box, type the name to assign to the incident.  

c. In the first Incident Number box, type the State for the incident. In the 
second box, type the Unit ID for the incident. In the third box, type the 
Incident Number assigned to that incident (e.g. MT-LNF-000001).  

d. From the Incident Jurisdiction drop-down list, select the agency that has 
jurisdiction for the incident. 

NOTE: The Incident Jurisdiction facilitates cost accrual category decisions. 

a. In the Location box, type the location of the incident. 

b. From the State drop-down list, select the appropriate state. 

c. In the Start Date box, enter the date when the incident started or when the 
first cost was incurred, whichever is earliest. You can either type the date or 
select it from the drop-down calendar. 

NOTE: When the incident end's, you can enter an end date into the End Date box. This 
information is not required. 

g. From the Agency drop-down list, select the agency to assign to the incident.

NOTE: An Agency is required. You cannot define an Accounting Code until an Agency is 
selected. 

h. In the Accounting Code box, type the accounting code to assign to the 
incident. 

NOTE: You must first select an Agency before you can define an Accounting Code 
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i. If you selected the FS Agency, a Region/Unit  drop-down list is available. 
Select the appropriate unit code or region from this drop-down list.  

NOTE: The Region/Unit is not required. If a Region/Unit is selected, it prints on the OF-288 
in Block 3 (Unit 1 Acct Code). 

j. Click the Save button. 

4. To edit an incident:  

a. On the Data Admin window, click the Incident Data tab.  

b. Under Feature, click to select Incident.  

c. In the Data Admin grid click the Incident Name you want to edit.  

d. Under Incident - Edit Mode, edit the data, as needed. Click the Save button 
to save your changes.  

NOTE: You must edit Accounting Codes on the Accounting Codes window.  

III. MANAGE ACCOUNTING CODES 

A. To manage accounting codes: 

NOTE: Because changes will impact all users, use caution when adding or editing accounting 
codes. Only add accounting codes that belong to the selected Incident. Adding an accounting 
code to an incident that does belong to that incident can negatively impact incident cost data. 

1. Open the Data Admin module.  

2. Click the Incident Data tab.  

3. To add a new accounting code to the database:  

a. Under Feature, click to select Accounting Code.  

b. From the Incident Name drop-down list, select the appropriate incident 
name.  

c. From the Agency drop down list, select the appropriate agency. 

NOTE: If you select an Agency that already has an accounting code defined for the incident, 
a warning message will display when you save the accounting code. You can select Yes to 
continue saving the accounting code or No to cancel. 

d. In the Accounting Code box, type the new accounting code for the incident.

e. If you selected the FS Agency, a Region/Unit drop-down list is available. 
Select the appropriate region or unit from this drop-down.  

f. To set the new accounting code as the default accounting code for the 
selected incident, click to check the Incident Default checkbox.  

g. Click the Save button to save the accounting code.  

4. To edit an accounting code:  
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a. On the Data Admin window, click the Incident Data tab.  

b. Under Feature, click to select Accounting Codes.  

c. From the Incident Name drop-down list, select the appropriate incident 
name. 

d. In the Data Admin grid , click to select the Accounting Code you want to 
edit.  

e. Under Accounting Codes - Edit Mode, edit data, as needed.  

f. Click the Save button to save your changes.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 3.2 – Data Admin: Manage Lookup Tables. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Manage lookup tables. 

2. Add a new Kind to the Kind Codes 
Lookup table. 



I-Suite Version 13.01.00  Data Admin  3.2-10 

  
I. LOOKUP TABLES  

A. Manage lookup tables.  

B. Add a new Kind to the Kind Codes Lookup table.  

II. MANAGE LOOKUP TABLES  

A. To manage lookup tables: 

NOTE: Because changes to Lookup tables will impact all users, use caution when making any 
changes to the Lookup tables. If the Resource Unit Leader (RESL) and Computer Technical 
Specialist (CTSP) are assigned to an incident, they should coordinate any changes with the 
Time Unit Leader (TIME). 

NOTE: The I-Suite system includes default values in the Lookup tables.  

1. Open the Database Admin module.  

2. On the Data Admin window, click the Lookup Tables tab.  

3. To add a new item to a lookup table:  

a. Under Feature, click to select the appropriate Lookup Table.  

b. Enter the appropriate information into the text boxes that display. The text 
boxes that display are based on the Lookup Table you have selected.  

c. After entering all required information (identified with an asterisk[*]) and 
any optional information, click the Save button.  

4. To edit a lookup table:  

a. On the Data Admin window, click the Lookup Tables tab.  

b. Under Feature, click to select the Lookup Table you want to edit.  

c. Enter the appropriate information into the text boxes that display. The text 
boxes that display are based on the Lookup Table you have selected. 

d. After entering all required information and any optional information, click 
the Save button.  

NOTE: The only Standard lookup table in which data can be edited is the Kind Codes table. 
Standard indicates that the lookup data is standard in that version of the database. Data in all 
non-standard lookup tables can be edited. 

5. To delete a Non-Standard Lookup option: 

a. On the Data Admin window, click the Lookup Tables tab. 

b. Under Feature, click to select the Lookup Table with the option you want 
to delete. 

c. In the Lookup grid, click the Non-Standard lookup option you want to 
delete. 
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d. Click the Delete button in the Main toolbar at the top of the window. 

e. When the confirmation message displays, click the Yes button to remove the 
option from the Lookup table. 

NOTE: You can only delete Non-Standard lookup tables. You cannot remove Standard 
lookup tables. 

B. To add a new Kind to the Kind Codes Lookup table:  

NOTE: In the following exercise, you will practice adding Kinds to the Kind Codes Lookup 
table. While this exercise deals specifically with the Kind Codes Lookup table, the same 
concepts apply to all reference tables. 

NOTE: A straightforward rule-of-thumb for creating a new Kind is to identify a resource 
similar in values to the new Kind. For example, an ATV is similar to a four-wheeler, or a golf 
cart is like a potable-water tender. 

NOTE: For this exercise, refer to the “Create a Resource Kind” handout.  

1. Open the Data Admin module.  

2. Click the Lookup Tables tab. 

3. Under Feature, click to select Kind Codes.  

4. Find a resource that is similar to the new Kind you are creating. Write down the 
specific quantity, units, and categories assigned to this resource.  

5. To add a new Kind Code, click the Add button.  

6. Under Kind Codes, enter the appropriate information including:  

a. Kind Code  

b. Quantity  

c. Units  

d. Rate Type  

e. Report Category  

f. Indicate if Direct resource or Line Overhead 

g. Daily Form  

h. Aircraft Type .  

7. To save your changes, click the Save button. Click the Close button to close the 
window.  
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Unit 4 
I-Suite Resources 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 4.0 – Resources: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the primary purpose of the 
Resources module.  

2. Identify Options on the Resources 
window.  



  

I-Suite Version 13.01.00 Resources  4.0-4 

  
I. RESOURCES  

A. Review the Resources module.  

NOTE: The Resources module shares data with other I-Suite modules.  

1. The primary purpose of the Resources module is to provide a standardized method to 
check-in resources when they arrive at an incident. This makes record keeping and 
status assessment easier.  

2. Resources also produces various incident reports, including the 209 Report Data 
Table, Section Report, Qualifications Report, and Daily Incident Reports. 

II. RESOURCES WINDOW 

A. Review the Resources window: 

1. The Print T Card Label button displays to the right of the Filter toolbar. Use this 
button to print T Card Labels at your default printer, which is defined in 
Tools/Options. 

2. The Resources grid displays beneath the toolbars in the center part of the window. 
This grid contains a list of all resources currently defined in the system. 

3. When you click either the Edit or Add button in the Main toolbar, a Manage 
Resource area displays at the bottom of the window. Use this area to edit or add 
resources. 

4. Depending on the user rights assigned to you, the following tabs may display at the 
bottom of the window: 

• Plans - This tab displays for users with Resource rights.  

• Time - This tab displays for users with Time rights.  

• Cost - This tab displays for users with Cost rights. 

5. A toolbar displays at the bottom of the Manage Resources area. The buttons in this 
toolbar include: 

a. Close 

b. Add 

c. Clear 

d. Previous 

e. Next 

f. Save 

g. Roster (For a non-person resource) 

h. Add New Component (For a Strike Team/Task Force) 

i. Add Existing Resources/Remove Component ( Strike Team/Task Force) 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 4.1 – Resources: Options. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Define Resource Options, which 
includes: 

• Selecting Resource Grid Columns and 
set order.  

• Changing “Other” Column Titles.  

• Setting Default Check-in Date.  

• Changing Quick Stats kinds.  

• Displaying Quick Stats.  

• Defining Label Settings 
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I. RESOURCE OPTIONS 

A. Select Resource Grid Columns and set order.  

B. Change “Other” Column Titles.  

C. Set Default Check-in Date.  

D. Change Quick Stats kinds.  

E. Display Quick Stats.  

F. Define Label Settings. 

II. RESOURCES GRID  

A. To identify the columns to display in the grid and the order in which to display them:  

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Resources tab. Then click to select the lower Resources tab.  

NOTE: The lower Resources tab on the Options window allows you to define the options 
available on the Resources window. 

3. Under Resource Grid Columns, click to check the checkbox next to each of the 
columns you want to display in the grid. 

NOTE: You can also click to highlight a column, and then click the Show button to display 
that column in the grid. If you want to remove the selected columns from the Resources grid, 
click the Hide button. 

3. To adjust the order in which the columns display in the Resources grid, click a 
column. Then click the Move Up or Move Down button to move the column. 

4. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window.  

III. "OTHER" COLUMN TITLES 

A. To change "Other" Column Titles: 

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Resources tab. Then click the lower Resources tab.  

NOTE: The "Other" columns are useful for filtering specific information (e.g. Team 
Member, EMT, etc). 

3. If you want to change the titles that display for the "Other" columns, type the new 
name for the column in the box next to the default Other column title to change the 
title (i.e. to change the name of the Other 1 column, enter the new name in the box 
next to Other 1). You can change the title for the following columns: 

a. Other 1.  
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b. Other 2.  

c. Other 3.  

NOTE: When the title for the Other columns are changed on the Resources tab in Options, 
the changes are saved to the database. This means that all users will see the changes. 

4. When finished, click the Save button, and then click OK to close the Options 
window.  

IV. DEFAULT CHECK-IN DATE AND TIME 

A. To set the Default Check-in Date and Time: 

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Resources tab. Then click the lower Resources tab.  

3. If you want to automatically insert the system date and time for the Check-In Date 
and Time, click the System Date option in the Default Check-In Date and Time 
box.  
 
If you want to leave the Check-In Date and Time blank, click the Blank option in 
the Default Check-In Date and Time box.  

V. QUICK STATS 

NOTE: Quick Stats contains useful information for the IC or Section Chiefs for a quick 
picture of incident resources. 

A. To change the kinds included in Quick Stats:  

NOTE: When you add additional kind codes for QuickStats, the changes are saved to the 
database. This means that all users will see the changes. 

1. From the Tools drop-down list, select Options to open the Options window.  

2. Click the Resources tab. Then click the lower Resources tab.  

3. Under Additional Kinds used for QuickStats, select the code you want to add from 
the Kind/Position drop-down list. Then click the Save button.  
 
To remove Kind Codes for QuickStats, click the selector button next to the code 
listed under  Additional Kinds used for QuickStats. Then click the Delete button 
at the bottom of the Options window.  

4. When finished, click the Save button to save your changes. Click the OK button to 
close the Options window.  

B. To display Quick Stats: 

1. From the Tools drop-down menu, select Quick Stats.  

VI. RESOURCE LABELS 

NOTE: Use this option to set the default printer for T-Card labels. 
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A. To define Label settings: 

1. From the Tools drop-down menu, select Options to open the Options window. 

2. Click the Resources tab. Then click the Labels tab. 

3. From the Special Purpose Label Printer drop-down list, select the label printer to 
use. 

4. In the First Fontsize box, enter the font size to use for the first line on the label. 

5. In the Second Fontsize box, enter the font size to use for the second line of the label. 

6. In the Top Offset box, enter the print offset to use at the top of the label. This 
identifies the amount of space to insert at the top of the label.  

7. In the Left Offset box, enter the print offset to use on the left side of the label. This 
identifies the amount of space to insert on the left side of the label. 

8. From the Font Name drop-down list, select the type of font to print on the label. 

9. Click the Save button to save your changes. Click the OK button to close the Options 
window.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 4.2 – Resources: Filtering Data. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Use the Filter bar.  

2. Filter using Exclude Demobed/Exclude 
Filled.  

3. Filter with the filter buttons.  

4. Sort using table column headers.  
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I. FILTER RESOURCES 

A. Use the Filter bar.  

B. Filter using Exclude Demobed/Exclude Filled.  

C. Filter using the Aircraft, Crews, Equipment, Overhead, All Resources, and All Personnel 
buttons.  

D. Sort using table column headers.  

II. FILTER BAR  

A. To use the Filter bar: 

NOTE: You can search for specific characters in any column. 

1. Open the Resources module.  

2. On the Filter Bar, click in the Filter box above the column you want to filter.  

3. In the Filter box, type the first several characters of the term by which you want to 
filter the data.  
 
EXAMPLE: Type AIR in the Filter box above the Kind Desc column heading to 
only display resources with Kind descriptions that begin with AIR.  

4. To remove your filter, either delete the characters that you typed or click the Clear 
Filter Bar button to the left of the Filter Bar.  

NOTE: If your team is part of the Supply Pilot and you have the Resources grid open in the 
Resource's module, you can scan an incident card to identify the resource associated with that 
card. 

NOTE: You can filter by multiple columns at the same time by entering filter criteria in each 
of the columns you want to use. 

III. EXCLUDE DEMOBED/EXCLUDE FILLED 

A. To use the Exclude Demobed checkbox to filter:  

1. Open the Resources module.  

2. On the Resources window, click to check the Exclude Demobed checkbox. This 
removes all demobed resources from the grid.  

B. To use the Exclude Filled checkbox to filter: 

1. Open the Resources module. 

2. On the Resources window, click to check the Exclude Filled checkbox. This removes 
all resources with a Filled status from the grid. 

IV. FILTER TOOLBAR 

A. To filter using the Aircraft, Crews, Equipment, Overhead, All Resources, and All Personnel 
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buttons:  

1. Open the Resources module.  

2. On the Resources window, click the Aircraft, Crews, Equipment, Overhead, All 
Resources, or All Personnel button to filter the grid based on your selection.  

V. SORT RESOURCES GRID 

A. Sort using table column headers.  

1. Open the Resources module.  

2. In the Resources grid, click the column heading you want to use to sort the 
information in the grid. For example, if you click the Name column heading, the 
information is sorted in Name order.  

3. Click the heading once to sort the information in Ascending order. Click the heading a 
second time to sort in Descending order. 

NOTE: To use multiple columns to sort the data in the grid, click an initial column heading 
by which to sort. Then hold down the Shift key and click each additional column heading. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 4.3 – Resources: Managing Data and Resources. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the importance of data entry 
guidelines.  

2. Identify common data.  

3. Manage all incidents as one.  

4. Manage incidents separately.  

5. Add Resources (Aircraft, Overhead, 
Crews, Equipment).  

6. Create a Strike Team/Task Force Parent 
Record.  

7. Attach new resources to a Strike 
Team/Task Force Parent Record. 

8. Attach existing resources to a Strike 
Team/Task Force Parent Record.  

9. Edit Resources (Aircraft, Overhead, 
Crews, Equipment). 

10. Refresh Data 

11. Delete Resources 
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I. MANAGE RESOURCES 

A. Identify the importance of data entry guidelines.  

B. Identify common data.  

C. Manage all incidents as one.  

D. Manage incidents separately.  

E. Add Resources (Aircraft, Overhead, Crews, Equipment) using an ICS 211 or optional 
check in form.  

F. Create a Strike Team/Task Force (Parent Record).  

G. Attach new resources to a Strike Team/Task Force Parent – Method 1.  

H. Attach existing resources to a Strike Team/Task Force Parent – Method 2.  

I. Edit Resources 

J. Refresh Data 

K. Delete Resources 

II. DATA ENTRY GUIDELINES 

A. Review and discuss the importance of data entry guidelines. 

NOTE: ROSS Import data will follow ROSS data standards. ROSS information that is 
imported into I-Suite includes Resource Name, Request Number, and Mob Date. It may also 
include Agency, HomeUnit, KindCode, and JetPort if they are defined in ROSS. 
 
Make sure you check the imported ROSS information at check-in for accuracy. There may be 
incorrect or missing data. Also check Crew Rosters with the CRWB. 

NOTE: If you are working with a team, follow the team's protocol or Standard Operating 
Procedures for data entry. 

1. In Resources, data is organized and presented based on the ICS 211 form.  

2. Before saving a resource, you must define the required information.  

NOTE: If information is required, an asterisk (*) displays to the left of the label. 

This required information includes: 

a. Request Number.  

NOTE: The request number must begin with one of the following letters: A, C, E, I, O, or S. 

b. Account Code.  

c. Resource Name.  

d. Kind/Position.  
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e. Status.  

f. Configuration.  

g. When Status is D, Actual Release Date. 

NOTE: The Agency and Unit ID are important fields, but they are not required. Entering 
incorrect data in these fields is worse than having no data defined. An incorrect Agency code 
will generate incorrect Cost data.  

3. Before rostering resources or adding additional qualifications, you must define the 
required information and save the resource.  

III. COMMON DATA 

A. To review common data: 

1. From the Modules drop-down menu, select Resources.  
 
OR  
 
Click the Resources button in the Main toolbar.  

2. On the Resources window, click the Add button.  

NOTE: Entry items located above the tabs (i.e. just below the Manage Resource – Add 
Mode label) are common to all I-Suite modules.  

NOTE: Data entry items for specific modules are located on their respective tabs (i.e. on the 
Plans, Cost, and Time tabs). The tabs that display are based on the rights assigned to the user.

NOTE: Resources is the primary data entry point for I-Suite data. The quality of the initial 
data is critical to successful integration of the data in other I-Suite modules. 

NOTE: Understanding the concept of data sharing is critical. Data is shared between all I-
Suite modules. Changes, additions, or deletions from any functional area effects the other I-
Suite modules. Successful integration requires cooperation and established Data Ownership 
Rules. If you are working with a team, follow the team's protocol or Standard Operating 
Procedures for data entry. 

IV. MANAGE INCIDENTS 

A. To Manage all incidents as one: 

NOTE: This is used if multiple incidents are created in the same database.  

1. On the top right side of the window, click to check the Manage All Incidents As One
checkbox.  

2. When the Manage All Incidents as One message displays, click the OK button.  

NOTE: When adding a resource with Manage All Incidents As One selected, an Incident 
Name drop-down box displays on the Manage Resource – Add Mode window. Verify that 
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the correct incident appears in the Incident Name box.  

B. Manage incidents separately.  

1. On the top right side of the window, click to uncheck the Manage All Incidents As 
One checkbox.  

2. From the Incident drop-down list, select the Incident you want to manage.  

NOTE: When Managing Incidents Separately, make sure you verify that the correct 
incident is selected in the Incident box. 

V. ADD RESOURCES 

A. To add Resources (Aircraft, Overhead, Crews, Equipment) using an ICS 211 or optional 
check-in form:  

1. Open the Resources module.  

2. Click the Add button in the Main toolbar.  

3. On the Manage Resource – Add Mode window, enter the following information: 

a. Request Number 

b. Account Code 

c. Resource Name 

NOTE: When the Person checkbox is checked, Resource Name is replaced with Last Name 
and First Name. On the Plans tab, an Other Quals section displays.  

d. Cell Phone 

e. Kind/Position 

f. Trainee checkbox (Optional) 

g. Status 

h. Unit ID (Optional) 

i. Agency (Optional) 

d. Configuration 

e. Actual Release Date (Optional when Status is not D) 

f. Actual Release Time (Optional) 

4. On the Plans tab, define the following information, as needed: 

NOTE: The Plans tab only displays when the user has Resource rights. 

a. Check-In Date 

NOTE: When the Check-In Date is more than 5 days prior to the system date, a warning 
message will be displayed 
.  
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b. Check-In Time 

c. Num Personnel 

d. Demob City 

e. Demob State 

f. Jetport 

g. Travel Method 

NOTE: When the Travel Method is Air or A/R, a Travel Questions button displays beneath 
the Travel Method field. Click the button to respond to Travel Questions for the resource. 

a. Mobilization Date 

b. First Work Day 

c. Length of Assignment (Days) 

d. Demobilization Date 

NOTE: The Demobilization Date is calculated from the First Work Day and Length of 
Assignment. Discuss with your Resource Unit Leader. 

k. Other (1, 2, & 3) 

l. Vehicle ID 

m. Original Order/Request Number 

n. Incident Card # 

NOTE: The Incident Card # is only applicable for the Supply Pilot Release. If your team is 
currently part of the Supply Pilot, you can either enter the incident card number for a resource 
into the Incident Card # box or scan the number on the resource's incident card. If you enter 
the number, you only need to enter the actual numeric digit. You do not need to enter any 
leading zeros or the underscore and letter at the beginning of the number (e.g., for the number 
_P000000004, you would only need to enter 4). 

k. Plans Remarks 

4. Click the Save button.  

5. To enter other quals for a person:  

a. Under Other Quals, select the appropriate kind code from the Kind Code 
drop-down list.  

b. If the person is a trainee for the selected kind code, click to check the 
Trainee checkbox.  

c. To save other quals, click the Save Quals button.  

6. To roster a person to a resource:  

NOTE: The Person checkbox must be unchecked to Roster a person to a resource. 
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NOTE: To Roster a person, the resource must be saved. 

a. Click the Roster button.  

b. On the Roster Resource – Add Mode area, enter the appropriate 
information for the person being rostered to the resource including: 

• Request Number 

• Leader checkbox (Optional) 

• Last Name 

• First Name 

• Cell Phone 

• Kind/Position 

• Trainee checkbox (Optional) 

• Status 

• Unit ID (Optional) 

• Agency (Optional) 

• Actual Release Date (Optional when Status is not D) 

• Actual Release Time (Optional) 

c. On the Plans tab, enter the following information, as needed: 

• Check-in Date 

• Check-in Time 

• Demob City 

• Demob State 

• Jetport 

• Travel Method 

• Mobilization Date 

• First Work Day 

• Demobilization Date 

• Other 1 

• Other 2 
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• Other 3 

• Vehicle ID 

• Original Order/Request Number 

• Plans Remarks 

• Other Quals 

NOTE: The Plans tab only displays when the user has Plan rights. 

d. On the Time tab, enter the appropriate Time data. 

NOTE: The Time tab only displays when the user has Time rights. 

e. On the Cost tab, enter the appropriate Cost data. 

NOTE: The Cost tab only displays when the user has Cost rights. 

e. Click the Save button.  

NOTE: There are two methods for creating a Strike Team/Task Force. Use the First Method 
when a group of resources not defined in the I-Suite database was ordered as a Strike 
Team/Task Force.  
 
Use the Second Method when assembling a Strike Team/Task Force at the incident from 
resources that already exist in the I-Suite database.  
 
Both methods require you to create a Parent Record or Place Holder. You then need to add 
or attach the Strike Team/Task Force Components to the Parent Record. 

B. Create a Strike Team/Task Force (Parent Record).  

1. Open the Resources module.  

2. Click the Add button in the Main toolbar.  

3. On the Manage Resource – Add Mode window, enter the appropriate information, 
including ALL required information.  

a. When selecting the Kind/Position, select a type applicable to the type of 
Strike Team (e.g. select “ES3” for a type 3 strike team).  

b. When selecting the Configuration, select S/T. Notice that the label Manage 
Resources – Add Mode changes to Add Strike Team / Task Force. The 
Roster button is replaced with two new buttons for adding components.  

NOTE: You cannot roster people to a Strike Team / Task Force parent.  

c. On the Plans and other tabs, complete the information, as needed.  

4. To complete the Strike Team/Task Force parent record, continue with Method 1 or 
Method 2.  
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NOTE: Use Method 1 to add Strike Team Or Task Force Components that do not already 
exist in the I-Suite database. 

NOTE: If you add the Strike Team Leader last, you will not have to change the KindCode.  

C. To attach new resources to a Strike Team/Task Force Parent – Method 1: 

1. On the Add Strike Team/Task Force window, click the Add New Component 
button.  

2. When the Add New Strike Team/Task Force message displays, click Yes to save the 
parent record.  

3. On the Add New Strike Team/Task Force Component window, enter the 
appropriate common information.  

NOTE: The Configuration defaults to C for component.  

4. On the Plans tab and other tabs, complete the information, as appropriate.  

NOTE: In the Num Personnel box, type the total number of people on the Strike Team/Task 
Force component. 

5. Roster crew members, as needed.  

6. To save the Strike Team/Task Force Component after entering the appropriate 
information, including ALL required information, click the Save button.  

7. When the Data Saved message displays, click the OK button.  

8. Continue adding components, as needed.  

9. After adding the final component, click the Close button.  

NOTE: Several boxes are automatically completed based on the Parent Record. Review this 
information for accuracy. Make sure you change the Kind Code when Rostering people. 

NOTE: Use Method 2 to add Strike Team or Task Force Components that already exist in the 
I-Suite database. 

D. To attach existing resources to a Strike Team/Task Force Parent – Method 2: 

1. On the Add Strike Team/Task Force window, click the Add Existing Resource 
button.  

2. When the Add Strike Team/Task Force message displays, click the Yes button to 
save the parent record.  

3. On the Add Existing Strike Team/Task Force Component window, click one or 
more resources listed in the grid to add to the Strike Team/Task Force. Then click 
the Add button.  

4. Repeat step 3 for each resource you want to add to the Strike team/Task Force. 

NOTE: If you want to remove a resource that was added to the Strike/Team Task force, click 
the resource in the grid at the top of the window. Then click the Remove Component(s) 
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button that displays beneath the grid. 

5. After adding all appropriate components to the Strike Team/Task Force, click the 
Close button.  

VI. EDIT RESOURCES 

A. Edit Resources (Aircraft, Overhead, Crews, Equipment). 

1. Open the Resources module. 

2. In the Resources grid, click to select the resource you want to edit. 

3. Click the Edit button in the Main toolbar. 

4. On the Manage Resource - Edit Mode window, edit the appropriate information. 

5. Click the Save button to save your changes. 

B. Refresh Data. 

1. Click the Refresh button in the toolbar. 

C. Delete a Resource. 

1. Open the Resources module. 

2. In the Resources grid, click to select the resource you want to delete. 

3. Click the Delete button in the Main toolbar. 

4. Review the delete warning message. 

5. To commit the delete request, click the Yes button. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 4.4 – Resources: Resources Reports. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Run and print standard reports. 
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I. RESOURCE REPORTS 

A. Run and print standard reports.  

II. PRINT RESOURCE REPORTS 

A. Run and print standard Resource reports.  

NOTE: I-Suite includes a number of features you can use to produce standard Resource 
reports. 

1. Click the Reports button in the toolbar. Then click to select the Plans tab.  
 
OR  
 
From the Reports drop-down menu, select Plans Reports.  
  

2. Under Reports, click to select one of the following reports:  

a. Aircraft Report  - This report identifies the aircraft on the incident. You can 
print the report for:  

• aircraft that is checked-in, pending, or in staging,  

• demobed or reassigned aircraft,  

• aircraft pending demob,  

• aircraft that is not demobed,  

• filled aircraft assignments,  

• unfilled aircraft assignments,  

• or all aircraft resources.  

b. Crew Report - This report identifies the crews on the incident. You can 
print the report for:  

• crews that are checked-in, pending, or in staging demobed or 
reassigned crews,  

• crews pending demob,  

• crews that are not demobed,  

• filled crew assignments,  

• unfilled crew assignments,  

• or all crew resources.  
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c. Equipment Report - This report identifies the equipment on the incident. 
You can print the report for: 

• equipment that is checked-in, pending, or in staging,  

• demobed or reassigned equipment,  

• equipment pending demob,  

• equipment that is not demobed,  

• filled equipment assignments,  

• unfilled equipment assignments,  

• or all equipment resources.  

d. Overhead Report - This report identifies the overhead personnel on the 
incident. You can print the report for:  

• overhead personnel that are checked-in, pending, or in staging,  

• demobed or reassigned overhead personnel,  

• overhead personnel pending demob,  

• overhead personnel that are not demobed,  

• filled overhead personnel assignments,  

• unfilled overhead personnel assignments,  

• or all overhead personnel resources.  

e. 209 Resource List - This report contains ICS-209 information for Block 29 
of the FAMWEB ICS 209 generated by the Situation Unit Leader.  

NOTE: The 209 Report uses the number of people from the Strike Team/Task Force parent.  

f. Qualifications Report - This report identifies the positions/kind codes 
defined in the I-Suite database and those resources that are assigned to the 
positions. You can filter the information in this report to include: 

• One, several, or all kind codes. 

NOTE: If the All Kinds checkbox is checked, all kinds are included. If the All Kinds 
checkbox is not checked, only those kinds listed under Selected Kinds are included. To 
include a kind, click the kind under Kind Codes. Then click the > button to move it under 
Selected Kinds. 

NOTE: Use the Kind Search filter box to quickly find kind codes to use as a filter. When you 
enter data into this box, the kind code that matches is highlighted. Click the > button to move 
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the kind under Selected Kinds. 

• No Trainees (Exclude Trainees) 

• Trainees Only 

NOTE: An asterisk (*) notes that the person is currently assigned to that position. 

g. Section Report - This report identifies those resources assigned to different 
sections (e.g. Command Staff, Operations Section, etc.).  

h. ST/TF Report - This report identifies the members of the Strike Teams and 
Task Forces that were included in the report. You can only include Strike 
Teams and Task Forces that are currently active (e.g., Check-In, Pending 
Demob) at the selected incident. 

  
3. For the Report you selected in step 2, complete the Report Settings, as appropriate. 

Several of the reports include the following options:  

NOTE: Some standard reports do not have Report Settings (i.e. the 209 ). 

a. Under Sort, click to select the sorts to use when creating the report. Click the 
sort options in the order in which you want the information sorted.  

b. If you want to include the Strike Team/Task Force Components in the report, 
click to check the Include strike team/task force components checkbox. 

c. If you want to include sub-totals for the first sort that you selected, click to 
check the Subtotals on first sort checkbox. 

4. To preview and then print the report, click the Preview button. Then click the Print 
Report button.  

5. To print the report without previewing, click the Print button. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 5.0 – Demob: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the Demob Module's Purpose.  

2. Identify Demob Options.  
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I. DEMOB  

A. Identify the Demob module's purpose.  

NOTE: The Demob module shares data with other I-Suite Modules.  

1. The primary purpose of the Demob module is to assist in preplanning and 
demobilization of resources.  

II. DEMOB WINDOW 

A. Review the Demob window:  

1. Demob Toolbar.  

a. P Button (Group Pending) - Click a group of resources in the grid. Then 
click the P button to change the status of the selected group to Pending.  

b. D Button (Group Demob) - Click a group of resources in the grid. Then click 
the D button to change the status of the selected group to Demobed. 

NOTE: When you click either the P or D button, the Save button changes to Save & Next. 
You must click this button to save the changed status to the resource and make changes to the 
grid. When you click the Save & Next button, the changes are saved and the next selected 
record displays.  

c. N Button (No Grouping) - If you have used the P or D button to change the 
status of a group of resources, you can change the status back by clicking 
the N button. You must click the N button before saving any changes to the 
resources. If you saved the status change to a resource, it will not be 
changed back to the original status code. 

d. Demob Report Buttons - Prints the following reports when you click the 
respective buttons: 

• Tentative Poster 

• Available for Release 

• Air Travel Request 

• Check Out 

• Actual Demob 

• Ground Support  

e. Resources Selected in Grid - When this checkbox is checked and you click 
a Report Button, the report is generated for the resource(s) selected in the 
grid. 

2. The Resources grid contains a list of the resources currently in the I-Suite database. 

3. Demobilization information for a Resource is automatically defined on the left side of 
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the window.  

a. Select an Equipment or Crew Resource – No Quals display.  

4. Tentative Release information for a resource is defined in the middle section of the 
window.  

a. All tentative information is entered here.  

b. Select Return Travel Method of A/R or AIR – Additional information 
about Air Travel displays.  

5. Actual Release information is defined on the right side of the window.  

a. All actual information is entered here. 

6. The following buttons display at the bottom of the Demob window: 

a. Close - Closes the Demob window. 

b. Previous - Moves to the previous record in the Resources grid. 

c. Next - Moves to the next record in the Resources grid. 

d. Save - Saves any changes made to the Demob information. 

7. You can print additional reports by selecting the Reports drop-down menu, and then 
clicking Demob Reports.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 5.1 – Demob: Options. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Select Demob Grid Columns and set 
order.  

2. Customize the Checkout Form (ICS 221). 

3. Select Travel Questions and set order.  
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I. DEMOB OPTIONS  

A. Select Demob Grid Columns and set order.  

B. Customize the Checkout Form (ICS 221). 

C. Select Travel Questions and set order.  

II. RESOURCE GRID 

A. To identify the columns to display in the grid and the order in which to display them: 

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Demob tab. Then click to select the lower Demob tab.  

3. Under Resource Grid Columns, click to check the checkbox next to each of the 
columns you want to display in the Resources grid.  

NOTE: You can also click to highlight a column, and then click the Show button to display 
that column in the grid. If you want to remove the selected columns from the Resources grid, 
click the Hide button.  

4. To adjust the order in which the columns display on the Demob window, click a 
column. Then click the Move Up or Move Down button to move the column.  

5. When you have made all of your changes, click the Save button to save your changes. 
Then click the OK button to close the Options window.  

III. CHECKOUT 

A. To customize the Checkout Form (ICS 221): 

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Cick the Demob tab. Then click to select the Checkout tab.  

3. Under the Logistics Section, click to check each of the options you want to include in 
the Logistics section of form ICS-221. You can include:  

a. Supply Unit  

b. Communications Unit  

c. Facilities Unit  

d. Ground Support Unit.  

4. If you want to include the Documentation Unit in the Planning Section of the ICS-
221 form, click to check the Documentation Unit checkbox.  

5. If you want to include the Demob Unit in the Planning Section of the ICS-221 form, 
click to check the Demob Unit checkbox.  

6. If you want to include the Time Unit in the Finance Section of the ICS-221 form, 
click to check the Time Unit checkbox.  

7. If you want to include the Security Unit in the Other Section of the ICS-221 form, 
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click to check the Security Unit checkbox.  

8. To include additional information in the Other Section of the ICS-221 form, type the 
name of the option in either of the blank boxes under the Other Section. When the 
name is defined, click to check the checkbox next to the option to select it.  

NOTE: An example of additional information is "Washing Station." 

9. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window.  

IV. TRAVEL QUESTIONS 

A. To select Travel Questions and set the order: 

1. From the Tools drop-down menu, select Options.  

2. On the Options window, click the Demob tab. Then click to select the Travel 
Questions tab.  

3. To display a listed question in the Air Travel grid for Demob, click to check the 
Display checkbox next to the question.  

4. To adjust the order in which a travel question displays, click to select the Question, 
and then click the Move Up or Move Down button to adjust the order.  

5. To add a new travel question: 

NOTE: You must click in the grid for the Add button to display. 

a. Click the Add button.  

b. In the Question box, enter your new travel question.  

c. Click to check the Display checkbox, if appropriate.  

d. Click the Save button to save the new question.  

6. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window.  

NOTE: Travel Questions only display in Demob if the Travel Method for the selected 
resource(s) is defined as AIR or A/R (Air with Rental) in the Common Data or Tentative 
Release areas. Travel questions and answers print on the Commercial Air Travel Request 
Form. 

NOTE: If you uncheck Display for a Travel Question, the responses to the question no 
longer display. Although the responses do not display, they are still saved in the database. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 5.2 – Demob: Demob a Resource. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Demob a Resource, which includes: 

• Defining demobilization information 
for a resource.  

• Defining tentative release information 
for a resource.  

• Defining actual release information for 
a resource.  
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I. DEMOB RESOURCES 

A. Define demobilization information for a resource.  

B. Define tentative release information for a resource.  

C. Define actual release information for a resource.  

II. DEMOB INFORMATION  

A. To define demobilization information for a resource: 

1. From the Modules drop-down menu, select Demob. 
 
OR  
 
Click the Demob button in the Main toolbar.   

2. In the Resources grid, click to select the appropriate resource.  

NOTE: To remove demobed resources from the Resources grid, click to check the Exclude 
Demobed checkbox. To only display those resources that were demobed in the Resources 
grid, click to check the Demobed Only checkbox.  

3. On the Demob window, check the following resource information that is auto-filled 
on the left side of the window. Enter any missing information.  

a. Status  

b. Demob City  

c. Demob State  

d. Jetport  

e. Travel Method  

f. Mobilization Date  

g. First Work Day 

NOTE: When you enter a First Work Day and Length of Assignment (Days), the system 
automatically calculates the Demobilization Date and inserts it into the Demobilization Date 
box. To change this date, increase or decrease the Length of Assignment Days by the number 
of days needed to adjust the Demobilization Date. This is important if you are creating 
Demob Reports from the Demob data (e.g. Last Day Work). Some Demob Dates may need to 
be adjusted to reflect the current incident status (e.g. rain putting the fire out). 

h. Length of Assignment (Days). 

i. Plans Remarks.  

j. If the resource is a person, enter the appropriate information in the Other 
Quals area. 
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4. When finished, click the Save button to save your changes.  

NOTE: If you need to edit Common Data that does not appear on the Demob window (e.g. 
Unit ID), click the resource in the grid. Then click the Edit button in the Main toolbar. Edit 
the information in the Manage Resource - Edit Mode area that displays. Follow incident 
established protocols or Standard Operating Procedures when editing any incident data. 

III. TENTATIVE RELEASE INFORMATION 

A. To define tentative release information for a resource: 

1. In the Resources grid on the Demob window, click to select the appropriate resource. 

2. Under Tentative Release, enter the following information: 

a. Available for Reassignment  

NOTE: When the Available for Reassignment checkbox is checked, Y (for Yes) displays in 
the Available for Release Report, along with additional Quals. This information will also 
display on the Commercial Air Travel Request.  

b. Tentative Release Date (trigger for resource being listed on Tentative Poster 
and Available for Release report.) 

c. Tentative Release Time  

d. Return Travel Method (auto-fills from Common Data.) 

NOTE: If the Return Travel Method is different from the Arrival Travel Method, make 
sure you change the entry in this box. This is important when you are creating Travel Method 
Reports. 

e. Remarks (if necessary)  

NOTE: If your remarks will not fit in the Remarks box, click the Remarks button to display 
a Tentative Release Remarks window where you can enter additional remarks. 

NOTE: Remarks do not print on the Available for Release Report. 

f. Dispatch Notified.  

NOTE: When the Dispatch Notified checkbox is checked, the resource will no longer be 
included in the Available for Release Reports. The assumption is that the report will be 
faxed to Dispatch. This resource should not be sent in again. If the resource needs to be sent 
again, click to check the Resources Selected in Grid checkbox, then select the resource in the 
grid. Click the Available for Release button to print the report again. 

g. If the Return Travel method is A/R or AIR, add air travel information in 
the area that displays at the bottom of the window. This information 
generates the Commercial Air Travel Request. 

• Name on Picture ID - For Airline security, there must be a legal 
name on reservations. 
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• Depart from Jetport (Local to Incident) - This is the jetport 
from which the resource is departing. 

• Travel time from ICP to Airport (Hours) (Minutes) - This is 
important information for Ground Support in scheduling shuttles 
to an airport. 

• Special Instructions 
NOTE: If your Special Instructions will not fit in the box, click the Special Instructions 
button to display a Special Instructions window where you can enter additional instructions. 
Special Instructions print on the Commercial Air Travel Request Form. However, you can 
only fill the window 1/3 in order for the information to print on the form. Preview the form 
and make adjustments to the information before printing. 

• If an air travel request is sent to dispatch, click to check the Air 
Travel to Dispatch checkbox. 

• If you received an itinerary from dispatch, click to check the 
Itinerary Received From Dispatch checkbox.  

NOTE: Click to check the checkbox next to each travel question for which a Yes response is 
appropriate.  

3. When finished, click the Save button to save your changes.  

IV. ACTUAL RELEASE INFORMATION 

A. To define actual release information for a resource: 

1. In the Resources grid on the Demob window, click to select the appropriate resource. 

2. Under Actual Release, enter the following information:  

a. Actual Release Date  

NOTE: Cannot enter an Actual Release Date unless the Status code is D or R. When the 
Status is D, the Actual Release Date is required. When Actual Release Date is more than 5 
days after the system date a warning message will be displayed.  

b. Actual Time of Departure  

c. Estimated Date of Arrival  

NOTE:  Cannot enter an Estimated Date of Arrival unless the Status code is D or R. When 
Estimated Date of Arrival is more than 5 days after the system date a warning message will 
be displayed.  

  
d. Estimated Time of Arrival  

e. Rest Over Night  

NOTE: When the Rest Over Night checkbox is checked, the system prints RON location 
information on the Actual Demob Report. 
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f. Remarks (if necessary)  

NOTE: If your remarks will not fit in the Remarks box, click the Remarks button to display 
an Actual Release Remarks window where you can enter additional remarks. 

NOTE: Remarks do not print on the Actual Demob Report. 

g. Dispatch Notified  

NOTE: When the Dispatch Notified checkbox is checked, the resource will no longer be 
included in the Actual Demob Reports. The assumption is that the report will be faxed to 
Dispatch. This resource should not be sent in again. If the resource needs to be sent again, 
click to check the Resources Selected in Grid checkbox, then select the resource in the grid. 
Click the Actual Demob button to print the report again. 

3. When finished, click the Save button to save your changes.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 5.3 – Demob: Demob Reports. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Generate reports using the Demob report 
buttons.  

2. Generate standard Demob reports.  
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I. DEMOB REPORTS  

A. Generate reports using the Demob report buttons.  

B. Generate standard Demob reports.  

II. DEMOB REPORT BUTTONS 

A. Generate reports using the Demob report buttons.  

NOTE: You can print some of the Demob reports from the main Demob window. 

NOTE: To only include Resources selected in the grid, click to check the Resources Selected 
In Grid checkbox. This overrides any other requirements or parameters defined for a report. 

1. In the Demob toolbar, click one of the following Demob buttons to print the defined 
report:  

NOTE: For descriptions of these reports, refer to section III. Standard Demob Reports. 

a. Tentative Poster 

b. Available for Release  

c. Air Travel Request  

d. Check Out  

e. Actual Demob 

f. Ground Support.  

NOTE: When you click one of these buttons, the report automatically displays in the Preview 
window. To print the report, click the Print Report button on the Preview window. If you 
want to define parameters for printing the report, use the options on the Demob Report 
window, rather than the report buttons on the Demob window. For these instructions refer to 
section III. Standard Demob Reports. 

III. STANDARD DEMOB REPORTS 

NOTE: There are several options in I-Suite you can use to print Standard reports. 

NOTE: If the Resources Selected in Grid checkbox is checked, the report prints for the 
Resource(s) selected in the grid, regardless of the requirements. 

A. To generate standard Demob reports: 

1. From the Demob module, click the Reports button in the Main toolbar to open the 
Demob Reports window.  
 
OR  
 
From the Reports drop-down menu, select Demob Reports to open the Demob 
Reports window. 
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OR 
 
Click one of the Demob Report buttons. 

2. Click to select one of the following reports:  

a. Checkout Form - The Demobilization Checkout Form (ICS-221) is 
completed for a resource that is being demobilized. Demobilization 
Checkout Forms are only generated for resources that do NOT have a 
checkmark in the Checkout Form Printed checkbox.  
 
To generate a Checkout Form: 

• Under Sort, double click each sort to use in the report. The Sort 
moves from the left frame to the right frame. The sort order is 
based on the order in which you select the sort options.  

• To remove a selected sort, click the sort you want to remove in the 
right frame under Sort. Then click the <  button.  

• To customize the Checkout Form, click the Customize Checkout 
Form button. Then refer to instructions in the Options section 
(5.1) for customizing the Checkout form.  

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox.  

• To preview or print the report, click the Preview or Print button. 

NOTE: If you click the Checkout button and the Resource Selected in Grid option is NOT 
checked, a message displays indicating that All Resources That Have Not Had a Checkout 
Form Printed (#) Will Be Printed. 

o If you click the Yes button to continue, a checkout form is printed for the number of 
resources indicated. The forms do not print in any particular order. Make sure this is 
what you want to do before clicking the Yes button. 

o If you click the No button, no action occurs. 

To print individual forms, click to check the Resources Selected in Grid option. Select 
specific resources. Then click the Checkout button. 

Use the Demob Report window to print sorted checkout forms. A message displays 
indicating that All Resources That Have Not Had a Checkout Form Printed (#) Will Be 
Printed. Selected individual forms cannot be printed from this window. 

NOTE: If a resource has a supply item that is not consumable issued to them in the Supply 
Module in I-Suite and an ICS 221 Checkout Form is printed for them, a statement prints on 
the Checkout Form indicating that the resource or one of its subordinates has supply items 
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issued to them. 

NOTE: After a checkout form prints for a resource, the message “Do you want to 
automatically check the Checkout Form Checkbox?” displays. Click to check Yes, which 
prevents the form from being printed again. If you need to print another form for that resource, 
click to check the Resources Selected in The Grid checkbox. Select the resource in the grid 
and print the form. 

b. Demob Planning Report - This report identifies resources and their current 
status for the incident. 
 
To generate a Demob Planning Report: 

• Under Select, click to select the resource status category to 
include in the report.  

• Under Sort, double click to select each sort to use in the report. 
The Sort moves from the left frame to the right frame. The sort 
order is based on the order in which you select the sort options. 

• To remove a selected sort, click the sort you want to remove in the 
right column under Sort. Then click the <  button.  

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox.  

• To include subtotals on the first sort, click to check the Subtotals 
on first sort checkbox. 

• To preview or print the report, click the Preview or Print button. 

c. Mob/Demob Report - This report identifies those resources that were 
demobilized.  

• To identify how the report is organized, click to select By Section, 
By Resource Kind, or By Demobilization Date. 

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox.  

• To preview or print the report, click the Preview or Print button. 

d. Qualifications Report - This report identifies the positions/kind codes 
defined in the I-Suite system and those resources that are assigned to the 
positions.  
 
To generate a Qualifications Report: 

• Click to select the Qualifications Report option. 

• To only include certain kind codes in the report, double click a 
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kind code under Kind Codes to move it under Selected Kinds. 
To include all kind codes, click the All Kinds option. 

NOTE: Use the Kind Search filter box to quickly find kind codes to use as a filter. When you 
enter data into this box, the kind code that matches is highlighted. 

• If you do not want to include Trainees in the report, click the 
Exclude Trainees option. If you want to only include Trainees in 
the report, click the Trainees Only option. 

• To preview or print the report, click the Preview or Print button. 

e. Section Report - This report identifies those resources assigned to different 
sections (i.e. Command Staff, Operations Section, etc.). 

• Under Sort, double click to select each sort to use in the report. 
The Sort moves from the left frame to the right frame. The sort 
order is based on the order in which you select the sort options. 

• To remove a selected sort, click the sort you want to remove in the 
right column under Sort. Then click the <  button.  

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox.  

• To preview or print the report, click the Preview or Print button. 

f. Tentative Poster - This report identifies those resources that are tentatively 
ready to be released. Only those resources that meet the following 
requirements are included in the report, unless the Resources Selected In 
Grid checkbox is checked:  

• The Resource Type is C, E, O, or A.  

• The Resource contains a Tentative Release Date and Time.  

NOTE: If the Tentative Poster does not print, double check the Tentative Release Date and 
Time. This information is critical for generating the Poster. 

• The Release Date is within a specified date range (when using a 
date range). 

• The Status is not D (Demob).  

NOTE: The I-Suite system only excludes resources with a D Status when printing the 
Tentative Poster from the Demob Reports screen. If a user selects a resource in the Resource 
grid that has a D Status and then clicks the Tentative Poster button on the Demob screen, the 
I-Suite System will print the Tentative Poster, regardless of the D Status.  

To generate a Tentative Poster: 

• In the Date Range boxes, enter the range of dates to include in the 



  

I-Suite Version 13.01.00  Demob  5.3-19 

report. 

• To include strike team/task force components in the report, click 
to check the Include strike team/task for components checkbox.

• To preview or print the report, click the Preview or Print button. 

NOTE: Each Calendar Date prints on a separate page with resources grouped by E, O, C, or 
A's being released for each day of the report. 

NOTE: This is the poster that most teams print on the poster size paper. 

NOTE: If a resource appears on the Tentative Demob Poster that was actually Demobed, 
the Tentative Demob Date may be later than the Actual Demob Date (i.e. resource left 
earlier than planned). Change the Tentative Demob Date to the same or a previous date to the 
actual demob date and the resource will not be included on the poster. This will only occur if 
the user selects a resource with a D Status in the Resource grid and clicks the Tentative 
Poster button on the Demob screen. 

g. Available for Release - This report identifies those resources that are 
available for release. Only those resources that meet the following 
requirements are included in the report, unless the Resources Selected In 
Grid checkbox is checked:  

• The Resource Type is C, E, O, or A.  

• The Resource Status is not D (Demobed). 

• The Dispatch Notified checkbox is not checked.  

• The Resource contains a Tentative Release Date and Time.  

NOTE: If the Available for Release report does not print for the resource, double check the 
Tentative Release Date and Time. This information is critical for generating this report. 

To print an Available for Release report: 

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox. 

• To preview or print the report, click the Preview or Print button. 

• When the prompt displays asking whether you want to 
automatically check the Dispatch Notified of Tentative Release 
checkbox, click the Yes button if you want to check it. Click the 
No button if you do not want to check it.  

NOTE: If you want to reprint an Available for Release report, click to check the Reprint 
checkbox on the Select Report window. Then select the date and time when it was originally 
printed from the Date Time Printed drop-down list. To assign a new date to the report, click 
to check the New Print Date checkbox. Then click the Preview or Print button to print or 
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preview the report. 

h. Air Travel Request - This form is used to request commercial air travel. A 
form only prints for those resources that meet the following requirements, 
unless the Resources Selected In Grid checkbox is checked:  

• The Resource Status is P (Pending).  

• The Return Travel Method for the resource is A/R or Air.  

• The Air Travel to Dispatch checkbox is not checked.  

The following Tentative Release information must be defined to avoid printing 
blank fields in the Commercial Air Travel Request form:  

• Tentative Release Date and Time 

• Resource Name (may auto-fill - check against the name on the 
resource's picture ID. Fill-in if this does not auto-fill.) 

• Departing Airport Code (usually closest to the incident or where 
the rental car was rented) 

• Special Remarks (e.g. aisle seat because leg is in splint.) 

• Travel Time (Hours) (Minutes) from the incident to the Departure 
airport. 

• Travel Questions - Click to check the checkbox next to each 
question for which a Yes response is appropriate. All questions 
and answers print. 

The following additional items will print on the form if the data was entered: 

• Resource Name 

• Demob City, State 

• Jetport (arrival airport from check-in information) 

• If the Reassignment checkbox was checked under Tentative 
Release on the Demob window: 

• Reassignment Pending Demob prints in the upper right corner. If 
the checkbox is not checked, only Demob prints. 

• Last Date available to work. Based on Length of assignment entry 
calculating days remaining of tour. Returns last date of tour. 

• Other quals will be listed. 

To print an Air Travel Request Form: 

• Click the  Air Travel Request option on the Select Report 
window. 
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• To preview or print the report, click the Preview or Print button. 

• When the prompt displays asking whether you want to 
automatically check the Air travel to Dispatch checkbox, click 
the Yes button to check it. Click the No button if you do not want 
to check it.  

NOTE: Only generate and print one resource's Commercial Air Travel Request at a time. A 
separate form will print for each resource. 

NOTE: Only Special Instructions Remarks print on this report. The Expanded Special 
Remarks box can only be filled about 1/3 full for all of the information to print on the 
Commercial Air Travel Request Form. Preview the form to make sure all information 
appears. 

NOTE: The system does not automatically check the Itinerary Received From Dispatch 
checkbox. This is a manual operation. Use this box to track progress on air travel. 

i. Last Work Day - This report identifies those resources with last work days 
within a defined date range. Only those resources that meet the following 
requirements are included in the report, unless the Resources Selected in 
Grid checkbox is checked: 

• A Tentative Release Date or Demobilization Date is defined. 

• The calculated Last Work Day falls within the defined date 
range. 

• An Actual Release Date is not defined. 

• The Status is not D (Demobed). 

To print a Last Work Day Report: 

• In the Grouping box, select the grouping option to use in printing 
the report.   

• In the Date Range boxes, enter the range of dates to include in the 
report. 

• If you selected either the Section, Date or the Section, 
RequestCat, Date options in the Group box, select the sections 
to include in the report in the Show Sections box. 

• Under Sort, double click to select each sort to use in the report. 
The Sort moves from the left frame to the right frame. The sort 
order is based on the order in which you select the sort options. 

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox. 

• To preview or print the report, click the Preview or Print button. 
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j. Actual Demob - This report identifies those resources that have been 
released for demobilization. Only those resources that meet the following 
requirements are included in the report, unless the Resources Selected In 
Grid checkbox is checked:  

• The Resource contains an Actual Release Date and Time.  

NOTE: If the Actual Demob Report does not print for the resource, double check the Actual 
Release Date and Time. This information is critical for generating this report. 

• The Dispatch Notified of Actual Release checkbox is not 
checked. 

To print an Actual Demob Report: 

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox. 

• To preview or print the report, click the Preview or Print button. 

• When the prompt displays asking whether you want to 
automatically update the status of the resource(s) to d, click 
the Yes button to run the update. Click the No button if you do not 
want to run the update.  

• When the prompt displays asking whether to check the Dispatch 
Notified of Actual Release checkbox, click Yes to check it. Click 
No if you do not want to check it.  

NOTE: A new page is produced for each request category on the Actual Demob Report. 

NOTE: Make sure Finance has completed all payment work for the resource(s) before 
changing the Status to D or the record(s) will have to be undemobed to complete payment 
records. Demobed resource(s) should only appear in those reports for already demobed 
resources. 

NOTE: You can Demob multiple resources at one time (e.g. an entire management team 
demobing). One way to do this is click to check the Resources Selected in Grid checkbox. 
Then select all of the resources you want to demob in the grid. Click the Actual Demob 
button on the Demob window. When prompted to update the status to D, click the Yes 
button. This automatically changes the Status of the selected resources to D (Demobed) 
AFTER you also click Print to print the report OR click to check the Resources Selected in 
Grid checkbox. Then select all of the resources you want to demob in the grid and click the D 
button. These processes assist in database cleanup at the end of incidents. 

j. Ground Support - This is a form that people can use to request ground 
support transportation. A form only prints for those resources that meet the 
following requirements, unless the Resources Selected In Grid checkbox is 
checked:  
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• The Resource Status is NOT D (Demobed).  

• The Resource contains a Tentative Release Date .  

  
NOTE: If the Ground Support Report does not print for the resource, double check the 
Tentative Release Date. This information is critical for generating this report. Leave ICP 
Time is generated by the Tentative Release Time in the Resource(s) record(s).  

• The Return Travel Method for the Resource is A/R or Air.  

• The Is Ground Support transportation needed? checkbox 
contains a check.  

• The Tentative Release Date is within a specified date range 
(when using a date range). 

NOTE: The Form Date is generated by the Tentative Release Date(s) selected in the Date 
Range boxes. All flight information has to be hand entered and is based on the itineraries 
received from dispatch. 

To generate a Ground Support Report: 

• In the Date Range boxes, enter a range of dates to include in the 
report. 

• To include strike team/task force components in the report, click 
to check the Include strike team/task force components 
checkbox. 

• To preview or print the report, click the Preview or Print button. 

NOTE: A separate report prints for each date there are resources needing transportation. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.0 – IAP: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the purpose of the Incident 
Action Plan (IAP) module.  

2. Use the data in the I-Suite database to 
produce the Incident Action Plan.  

3. Produce various Incident Command 
System (ICS) forms.  

4. Use the “Master Frequency List” to 
define radio frequencies for the ICS 205. 

5. Identify Options on the IAP window.  
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I. INCIDENT ACTION PLAN 

A. Access the Incident Action Plan (IAP) module.  

NOTE: The IAP module shares data with other I-Suite modules.  

B. The primary purpose of IAP is to produce an Incident Action Plan for the incident.  

C. Use IAP to produce the following Incident Command System (ICS) forms:  

1. ICS 202 – Incident Objectives.  

2. ICS 203 – Organization Assignment List.  

3. ICS 204 – Division Assignment List.  

4. ICS 205 – Incident Radio Communications Plan.  

5. ICS 206 – Medical Plan.  

6. ICS 220 – Air Operations Summary.  

E. IAP uses the Master Frequency List to define radio frequencies in the ICS 205 – 
Incident Radio Communications Plan.  

F. Identify options on the IAP window:  

1. The IAP toolbar includes the following buttons:  

a. Create New Form - Click a form listed in the Tree View. Then click this 
button to create a new form that is the same type as the one that is 
highlighted. You can also click the Arrow next to this button to display a list 
from which you can select the form you want to create.  

b. Save - Saves the form. 

NOTE: The IAP module is the only module with the Save button in the module toolbar. 

c. Spell Check - Checks the form for spelling errors  

d. Copy Form - Displays a list of forms you can copy. 

e. Copy Plan - Displays a list of plans you can copy. 

f. Manage By Plan - Displays all forms grouped by an Incident Action Plan 
for a specific day and operational period. 

g. Manage By Form - Displays all forms grouped by form number. You can 
also use this button to only display a certain type of form. 

h. Mark Final/Mark Draft - When the form is marked Draft, this button 
changes it to Final. When the form is Final, this button changes it back to 
Draft. 

i. Bold - Bolds text selected in a form. 

j. Italic - Italicizes text selected in a form. 
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k. Underline - Underlines text selected in a form.  

2. The following IAP Menus display at the top of the window: 

a. File - Use the options in this menu to Create a New Form, Export a Form to 
PDF, Export a Plan to PDF, Preview a Form, Print a Form, Preview a Plan, 
and Print a Plan. 

b. Edit - Use the options in this menu to edit forms. The options that are 
available include: 

• Copy - Select this option to copy a form. 

• Cut - Select this option to cut text that is highlighted in a form. 

• Paste - Select this option to paste text that was cut or copied into a 
form. 

• Delete Form - Select this option to delete a form. 

• Format - Use the options in this sub-menu to change the font style or 
underline text. 

c. View - Use the options in this menu to view forms. The following options 
are available: 

• Form - Select this option to display all forms in the Tree View. 

• Individual Form - When you select this option, a list of forms 
displays. Select a form from the list to only display those types of 
forms in the Tree View. 

• Plan - Select this option to display all forms grouped by Incident 
Action Plan. 

d. Shifts - Select the Define Shifts option in this menu to define shifts. 

e. Tools - Use the options in this menu to: 

• Copy Form - Displays a list of forms you can copy. 

• Copy Plan - Displays a list of plans you can copy. 

• Spell Check - Checks the form for spelling errors. 

• Form 203 Template - Used to customize the ICS-203 Form. 

• Form 204 Template - Used to customize the ICS-204 Form. 

• Mark Final/Mark Draft - When the form is marked Draft, this 
changes to Final. When the form is Final, this changes back to Draft. 

• Master Frequency - Creates the Master Frequency List. 

f. Window - When you select this menu, a list of forms that are currently open 
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displays. Click a form to make that form window active. Select Close All 
Forms to close all of the Form windows. 

3. The Tree View displays on the left side of the window. You can change the 
information that displays in the Tree View by selecting one of the following options 
from the View drop-down menu:  

NOTE: The forms in the Tree View are limited, based on whether Manage All as One is 
selected. If Manage All as One is selected, all forms display in the list. If a single incident is 
selected, only forms for that incident display in the list. 

a. Form - Select this option to display all forms in the Tree View. 

b. Individual Form - Select this option to view a specific form (e.g. Only ICS 
203 forms) in the Tree View. 

c. Plan - Select this option to view plans in the Tree View. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.1 – IAP: Getting Started. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Define shifts.  

2. Use IAP Options.  

3. Set up and customize the ICS 203 
template.  

4. Set up and customize the ICS 204 
template.  

5. Create a Master Frequency List.  

6. Delete a frequency from the Master 
Frequency List.  
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I. SETTING UP IAP 

A. Define shifts.  

B. Define IAP Options.  

C. Set up and customize the ICS 203 template.  

D. Set up and customize the ICS 204 template.  

E. Create a Master Frequency List.  

F. Delete a frequency from the Master Frequency List.  

II. SHIFTS  

A. To add a shift: 

NOTE: Defining shifts is the first thing that must be done when creating an IAP. 

1. From the Modules drop-down menu, select IAP.  
 
OR  
 
Click the IAP button on the toolbar.  

2. From the Shifts drop-down menu, select Define Shifts.  

3. On the Incident Action Plan – Define Shifts window, complete the following.  

a. In the Shift box, type the name of the Shift. 
 
EXAMPLE: Name the shift DAY or NIGHT.  

b. In the Shift Start Time box, type the starting time of the shift in the format 
0000.  
 
EXAMPLE: Type 0600. 

c. In the Shift End Time box, type the ending time of the shift in the format 
0000.  

d. Under Shift Shade, click to select a shade to assign to the shift.  

NOTE: The background shade of the shift listed under the Shade column in the Shifts 
Entered grid, illustrates the shade defined for the shift.  

NOTE: The Shade assigned to a shift helps to identify the different shift forms (i.e. alleviates 
confusion between Day and Night shift forms).  

NOTE: When creating a form for a certain operational period, the Date/Time box is color-
coded with the Shade specified for that shift. 

4. To save the new shift, click the Save button.  
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5. When finished, click the Close button.  

NOTE: Before you save the shift record, you can click the Clear button to clear the Shift 
information that was defined. This removes any information from the Shift boxes. You can 
then enter the correct information. After you have saved the Shift record, the Clear button is 
no longer available. 

B. To edit a Shift: 

1. In the Shifts Entered grid, click the shift you want to edit. 

2. Make the appropriate changes to the Shifts information that displays under Edit 
Mode. 

3. Click the Save button to save your changes. 

C. To delete a shift: 

1. In the Shifts Entered grid, click the shift you want to delete. 

2. Click the Delete button in the Main toolbar at the top of the window. 

NOTE: If you add or edit Shifts at a later time, your changes are not visible until you click the 
Refresh button in the Main toolbar to refresh the data. 

III. IAP OPTIONS 

A. Define IAP Options.  

1. Open the IAP module.  

2. To identify the order in which to display the first and last names:  

NOTE: Identify the order in which to display the name data before creating forms in IAP. If 
you change the order after having saved some forms, the order is not changed for the already 
saved forms.  

a. From the Tools drop-down menu, select Options. Then click the IAP tab.  

b. Under Resource Drop Down Lists, click to select one of the following 
order options: 

• Last Name, First Name - Select this option to display the name in 
Last Name/First Name order. 

• First Name Last Name - Select this option to display the name in First 
Name/Last Name order 

c. To save your changes, click the Save button. Then click the OK button to 
close the Options window.  

3. To identify whether to show resources for All Incidents or a Selected Incident: 

a. From the Tools drop-down menu, select Options. Then click the IAP tab. 

b. Under Resources To Display From, click to select one of the following 
options: 
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• Selected Incident - Only shows resources for the incident selected in 
the Incident drop-down on the IAP window. 

• All Incidents - Shows resources for all incidents. 

c. To save your changes, click the Save button. Then click the OK button to 
close the Options window. 

4. To change the size of the buttons in the IAP toolbar:  

a. From the Tools drop-down menu, select Options. Then click the IAP tab.  

b. Under Toolbar, click to check the Small Icons checkbox. The size of the 
buttons in the IAP toolbar is reduced. 

c. To change back to large buttons, click to uncheck the Small Icons checkbox. 

d. To save your changes, click the Save button. Then click the OK button to 
close the Options window.  

5. To identify the forms to display in the Tree View based on the Archive date: 

a. From the Tools drop-down menu, select Options. Then click the IAP tab. 

b. Under Tree View Display, click to select one of the following options: 

• Show All - Shows all saved forms. 

• By Date - Shows all forms with a date that is newer than the one 
defined in the text box next to this option. 

NOTE: When you select the By Date option, you must enter a date into the text box that is 
next to the option. This is the date to which the application refers in order to identify the forms 
to include in the Tree View. 

• Number of days prior to the system date and any new forms - 
When you select this option, the application calculates the dates to 
display by subtracting the number of days defined from the Current 
System Date. The forms display from the calculated date forward. 

NOTE: When you select the Number of days prior to the system date and any new forms 
option, you must enter a number into the text box that is next to the option. This is the number 
to which the application refers in order to identify the forms to include in the Tree View. 

c. To save your changes, click the Save button. Then click the OK button to 
close the Options window. 

IV. ICS TEMPLATES 

A. Set up and customize the ICS 203 template. 

NOTE: Use this template to display additional kinds that are qualified to fill a position.  

1. Open the IAP module.  
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2. From the Tools drop-down menu, select Form 203 Template.  

3. If needed, you can change the names of the fields in the 203 form. To change the field 
name, highlight the text you want to change and type over it.   

4. To customize the KindCode filter for each section:  

a. From each of the available drop-down lists, select the appropriate additional 
KindCodes. 
 
OR  
 
Click in the appropriate box, and then type the additional valid KindCodes. 
Separate the entries with a semi-colon.  

NOTE: The Kindcodes you enter should be valid codes defined within the I-Suite database. 

b. To save your changes to the ICS 203 template, click the Save button in the 
IAP toolbar.  

B. Set up and customize the ICS 204 template.  

NOTE: Use this template to display additional kinds that are qualified to fill a position. 

1. Open the IAP module.  

2. From the Tools drop-down menu, select Form 204 Template.  

3. If needed, you can change the names of the fields in the 204 form. To change the field 
name, highlight the text you want to change and type over it. 

4. To customize the KindCode filters in the Operations Personnel section:  

a. From each of the available drop-down lists, select the appropriate additional 
KindCodes.  
 
OR  
 
Click in the appropriate box, and then type additional valid KindCodes. 
Separate your entries with a semi-colon.  

NOTE: The Kindcodes you enter should be valid codes defined within the I-Suite database. 

NOTE: Changes made to Operations Personnel are effective immediately. 

b. To save your additions to the ICS 204 template, click the Save button in the 
IAP toolbar.  

5. Under Resources Assigned this Period, click one of the following buttons to identify 
the data and order in which information displays in the Resource Designator box 
on the ICS 204 form:  

NOTE: You can choose to display one or all of the data items. You need to have a Resource 
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Name in order to save the template.  

a. Add Resource Name  

b. Add Kind Code  

c. Add Request Number 

d. Add Last Day to Work 

6. To save your changes to the ICS 204 template, click the Save button in the IAP 
toolbar.  

NOTE: Changes made to Resources Assigned this Period are applied when you create a new 
ICS 204 form. These changes will not affect already created or saved forms. 

V. MASTER FREQUENCY LIST 

A. Create a Master Frequency List (MFL).  

NOTE: The Communications Unit Leader uses the MFL to create a database of frequencies to 
use on a specific incident. 

1. Open the IAP module.  

2. From the Tools drop-down menu, select Master Frequency.  
 
OR  
 
Click the Master Frequency List in the Tree View on the left side of the window.  

NOTE: Add every frequency the Communications Unit Leader gives you that will be needed 
for the incident. This allows users to select the frequency from the drop-down list and avoid 
having to retype the frequency on each form. 

NOTE: Only those frequencies with Show checked will be included in the Frequency drop-
down list on the ICS 205 window. 

3. Click to check the Show checkbox for the new Frequency.  

4. From the System drop-down list, select the appropriate System.  

5. Complete the remaining boxes.  

a. Group  

b. Channel  

c. RFunction  

d. RX  

e. TX  

f. Tone  

g. Assignment  
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h. Remarks.  

6. Click the Save button to save the frequency. 

7. When finished, click the Propagate Changes button.  

8. On the Propagate Changes window, click Yes to propagate changes to all unlocked 
forms.  

NOTE: The Propagate Changes button updates all created, unlocked, saved forms that use 
the frequency you updated. Locked, unsaved forms, or a form being edited will not be 
updated.  

NOTE: To propagate changes to locked forms, you must first unlock each form to which you 
want frequency changes to be propagated. 

B. Delete a frequency from the Master Frequency List (MFL).  

NOTE: If you delete a frequency, you must manually re-enter that frequency to be able to see 
it in the Frequency drop-down list in the future. 

1. Open the IAP module.  

2. From the Tools drop-down menu, select Master Frequency.  
 
OR  
 
On the IAP window, click Master Frequency List in the Tree View on the left side 
of the window. 

3. On the Master Frequency List, click in the selector column just to the left of the 
Show column to select the Frequency you want to delete.  

4. Click the Delete button in the Main toolbar.  

NOTE: This process only deletes the selected frequency, not the entire MFL. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.2 – IAP: Common Features of IAP Forms. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify common features of most IAP 
forms.  

2. Spell Check a Form.  

3. Format Text on a Form.  

4. Resize Areas on a Form.  

5. Mark a Form Final vs. Draft.  

6. Unlock a Finalized Form.  

7. Close a Form. 
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I. COMMON FEATURES 

A. Identify common features of most IAP forms.  

B. Spell Check a Form.  

C. Format Text on a Form.  

D. Resize Areas on a Form.  

E. Mark a Form Final vs. Draft.  

F. Unlock a Finalized Form.  

G. Close a Form 

II. FORM FEATURES 

A. To create a form:  

1. Open the IAP module.  

  
a. In the Tree View on the left side of the window, double click the form you 

want to create.  
 
OR  
 
In the IAP toolbar, click the arrow next to the Create New Form button to 
display a drop-down list. Then click to select the form you want to create.  
 
OR  
 
From the File drop-down menu, select New Form, and then select the form 
you want to create.  
  

NOTE: When you create a form, the following features are common to all forms:  

• IAP automatically enters the Incident Name, Date, and Time on each form.  

• The current date and time display in the Date and Time Prepared boxes. 

• The current date and day display in the Operational Period box. 

• If you are preparing a form for a date other than the current date, you can change the 
entry in the Operational Period box. 

• You must save a form after editing it. IAP does not automatically save your forms. If you 
close a form without first saving it, IAP displays a prompt asking you to save the form. 

NOTE: For the most part, you can change almost every entry in a form and select entries from 
drop-down lists. 
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2. To create a new form or open an existing form from the Tree View:  

a. Double click the form name in the Tree View to create a new form.  

b. Click an existing form once to open that form. 

c. When the Tree View is sorted By Plan, right click the plan date. Then select 
the Open All Forms option from the menu that displays to open all of the 
forms in the plan. 

3. To show multiple page numbers on a form:  

a. Use the scroll bar to scroll to the bottom of the new form.  

b. In the Page ___ of ___ boxes, type the page numbers you want to use.  
 
EXAMPLE: Type Page 1 of 2 on the first page of the form. Then type Page 
2 of 2 on the second page of the form. 

c. After creating the form, click the Save button to save it. If you have multiple 
forms open, click the Save All button to save changes to all of the open 
forms. 

B. To spell check a form: 

a. In the Tree View, double click a form to open it.  

b. From the Tools drop-down menu, select Spell Check. 
 
OR  
 
Click the Spell Check button in the IAP toolbar.  

c. When finished, click the Save button to save any changes.  

C. To format text selected on a form:  

1. On the Tree View, click to open a form.  

2. Click to highlight the text you want to format.  

3. Click the appropriate text formatting button(s) in the IAP toolbar.  
 
OR  
 
From the Edit drop-down menu, select Format. From the sub-menu that displays, 
select Font. Use the options on the Font window to change any of the following. 
Click the OK button to apply the change:  

a. Font  

b. Font Style  

c. Font Size.  

NOTE: You can also open the Font window by highlighting the text you want to format. 
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Then right clicking the mouse and selecting the Font option from the menu that displays. 

NOTE: Change the font size to allow text to fit within a box on a form.  

D. To globally change the font size on a form: 

1. On the Tree View, click to open a form. 

2. From the Edit drop-down menu, select the Format option. Then click Font By Form 
in the sub-menu that displays. 
 
OR 
 
Right click the mouse anywhere in the form. Select Font By Form from the menu 
that displays. 

3. Under Size, click the size to apply to the text in the form.  

NOTE: Although the other font options display in the Font window, only the Size is changed 
for the entire form. If you want to change the Font or Font Style, follow the directions under 
C. To format text selected on a form. 

4. Click the OK button to change the font size in the form.  

E. To resize areas on a form: 

NOTE: Use the Up and Down Arrows that display on the right-hand side of larger sized text 
boxes to adjust the size of text boxes, as needed. 

1. To resize a text box, click the Up Arrow (↑) or the Down Arrow (↓) next to the text 
box you want to adjust.  

F. To mark a form Final vs. Draft: 

NOTE: When you create a form, it is automatically marked as Draft. This mark displays at 
the top and bottom of each page, until you Finalize the form. 

1. In the Tree View, click a form to open it. 

2. In the IAP toolbar, click the Mark Final button.  
 
OR  
 
From the Tools drop-down list, select Mark Final.  

NOTE: Once you mark a form as Final, it is locked. You must first unlock the form by 
changing it back to Draft, before you can edit it.  

G. Unlock a Finalized Form.  

1. In the Tree View, click a form to open it.  

2. In the IAP toolbar, click the Mark Draft button.  
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OR  
 
From the Tools drop-down menu, select Mark Draft.  

H. To Close a form, use one of the following methods: 

1. From the File drop-down menu, select the Close Form option. 

2. Right click an open form and select the Close option from the menu that displays. 

3. Click the Close button (X) that displays in the upper right corner of the window. 

4. From the Windows drop-down menu, select the Close All Forms option. 

5. Right click a plan listed in the Tree View. Select the Close All Forms option from the 
menu that displays. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.3 – IAP: Create an ICS 202 – Incident 

Objectives. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Create an ICS 202 – Incident Objectives.
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I. ICS 202 

A. Create an ICS 202 – Incident Objectives.  

II. CREATE ICS 202  

A. To create an ICS 202 – Incident Objectives: 

1. Double click ICS202 in the Tree View to open a new ICS 202 form.  

2. From the Operational Period drop-down list, select the appropriate Shift.  

3. Complete the following information:  

a. General Control Objectives for the incident (include alternatives)  

b. Weather Forecast for Period  

c. General Safety Message 

4. Under Attachments, click to select all that apply:  

a. Organization List – ICS 203  

b. Division Assignment Lists – ICS 204  

c. Communications Plan – ICS 205  

d. Medical Plan – ICS 206  

e. Air Operations Summary – ICS 220  

f. Incident Map  

g. Safety Message  

h. Traffic Plan 

5. To add an additional attachment, click to check the checkbox next to a blank line. 
Then type the name of the attachment next to that checkbox.  

6. In the Prepared by (Planning Section Chief) box, type the Planning Section Chief 
Name.  

7. In the Approved by (Incident Commander) box, type the Incident Commander 
Name.  

8. When finished, click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.4 – IAP: Create an ICS 203 – Organization 

Assignment List. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Create an ICS 203 – Organization 
Assignment List. 
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I. ICS 203  

A. Create an ICS 203 – Organization Assignment List.  

II. CREATE ICS 203 

A. To create an ICS 203 – Organization Assignment List: 

NOTE: The ICS 203 identifies which positions are filled and the people who filled them. 

NOTE: People who are qualified for each position KindCode are identified in the I-Suite 
Database. If a name does not display in the drop-down list, check the KindCode for that 
person to see what Kindcode was entered in their record, or you can manually type in the 
name. 

NOTE: Keep in mind that some position boxes display more than one position KindCode. 

1. Double click ICS203 in the Tree View to open a new ICS 203 form.  

2. For each position, select the Person for that position from the available drop-down 
lists.  

NOTE: You can enter more than one person in a position box.  

NOTE: Additional names may not display completely on the window and will not print 
correctly. To help additional names to display correctly, you can reduce the font size. 

NOTE: Most labels and headings can be customized, as needed.  

4. Under Agency Representative, type the Agency for each agency representative.  

5. In the Prepared by (Resource Unit Leader) box, type the Resource Unit Leader 
Name, and then click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.5 – IAP: Create an ICS 205 – Incident Radio 

Communications Plan. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Create an ICS 205 – Incident Radio 
Communications Plan. 
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I. ICS 205 

A. Create an ICS 205 – Incident Radio Communications Plan.  

NOTE: In order to use the Frequency-Rx  drop-down list on the ICS 204, you must complete 
an ICS 205 form for that shift. If you have not completed an ICS 205 form, a message 
displays to remind you to create the ICS 205 when you click the Frequency-Rx  drop-down 
list on the ICS 204 form. 

II. CREATE ICS 205  

A. To create an ICS 205 – Incident Radio Communications Plan: 

NOTE: The Communications Leader completes the ICS 205 – Incident Radio 
Communications Plan. 

NOTE: The ICS 205 uses frequencies defined in the Master Frequency List (MFL).  

1. Double click ICS205 in the Tree View to open a new ICS 205 form.  

2. From the Radio Type/Cache drop-down lists select each Frequency.  

NOTE: When you select a frequency, I-Suite automatically inserts the remaining data from 
the MFL into the form.  

NOTE: All frequencies in the ICS 204 Frequency – RX drop-down list are from the 
approved ICS 205 for that operational period. 

3. Click the Verify Frequencies button.  

NOTE: The Verify Frequencies button verifies the following frequency assignments:  

• All frequencies on the ICS 204 and ICS 205 are approved frequencies on the MFL. 

• All frequencies for that operational shift are assigned to at least one of the ICS 204s for 
that operational period.  

• Any frequency on an ICS 204 is also on the approved ICS 205 for that operational 
period. 

NOTE: If there are any discrepancies between the ICS 204, ICS 205 and the MFL, IAP 
displays a Notification message. 

4. Complete the rest of the form, as applicable.  

5. When finished, click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.6 – IAP: Create an ICS 204 – Division 

Assignment List. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Create an ICS 204 – Division 
Assignment List.  

2. Cut, Copy, Paste, Insert, Move, and 
Delete Rows on an ICS 204 Form.  
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I. ICS 204 

A. Create an ICS 204 – Division Assignment List.  

B. Cut, Copy, Paste, Insert, Move, and Delete Rows on an ICS 204 Form.  

II. CREATE ICS 204 

A. To create an ICS 204 – Division Assignment List: 

1. Double click ICS204 in the Tree View to open a new ICS 204 form.  

2. In the Branch box, type the Branch Name.  

3. In the Division/Group box, type the Division/Group name.  

4. From the Operational Period drop-down list, select the appropriate Shift. 

5. Under Operations Personnel, select the person for each Position from the available 
drop-down lists.  

6. Under Resources Assigned this Period, click to select one of the following options:  

a. All – to display all resources in the drop-down list.  

b. Crew – to limit the drop-down list to display only hand crews.  

c. Engine – to limit the drop-down list to display only engines.  

d. Equipment – to limit the drop-down list to display dozers, water tenders, 
tractor plows, and other heavy equipment.  

e. Line Overhead – to limit the drop-down list to display individual line 
overhead such as Strike Team Leaders and Field Observers.  

7. Under Strike Team / Task Force / Resource Designator, select the appropriate 
Resources from the available drop-down lists.  

NOTE: If you use the drop-down list to select the Resource, I-Suite automatically defines the 
leader and the number of persons from the database.  

8. Complete the following boxes for each resource, as appropriate:  

a. Leader  

b. Number of Persons  

c. Trans Y/N  

e. Drop Off PT./Time  

f. Pick Up PT./Time.  

NOTE: You can complete the Drop Off and Pick Up Locations and Times for the first 
resource and then click the Auto-Fill buttons to fill-in the same information for the remaining 
locations and times for all other resources. 
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NOTE: You can edit the Drop Off and Pick Up Locations and Times, as needed. 

9. Complete the following boxes, as appropriate:  

a. Control Operations  

b. Special Instructions.  

NOTE: The Division/Group Communications Summary section allows you to import 
frequencies from the ICS 205 – Radio Communications Plan. If the Frequency-Rx drop-
down list does not contain any frequencies, a warning message displays noting that an ICS 
205 was not yet created for that operational period. You can also manually enter frequencies.  

NOTE: To display frequencies added to the ICS 205 since the last time you started IAP, click 
the Refresh button. 

10. Under Division/Group Communications Summary, select the appropriate 
Frequency – RX from the available drop-down lists for each Function.  

NOTE: The Division/Group Communications Summary section is automatically filled with 
frequencies from the ICS 205 – Radio Communications Plan.  

OR  

Enter the data to complete the following boxes for each Function, as appropriate.  

a. Frequency - RX  

b. Frequency - TX  

c. Tone  

d. System  

e. Channel  

f. System  

g. Channel.  

11. In the Prepared By (Resource Unit Leader) box, type the Resource Unit Leader 
Name.  

12. In the Approved By (Planning Section Chief) box, type the Planning Section 
Chief Name, and then click the Save button.  

III. MOVING/COPYING/DELETING ROWS 

A. To Cut, Copy, Paste, Insert, Move, and Delete Rows on an ICS 204 Form:  

1. In the Tree View, click a 204 Form to open it.  

2. To Cut a row, click the Select/Unselect button that displays on the far left side of the 
row. From the menu that displays, select Cut Row.  

3. To Copy a row, highlight the information in the row you want to copy. Then right 
click the row. From the menu that displays, select Copy.  



  

I-Suite Version 13.01.00 IAP  6.6-29 

4. To Paste a cut or copied row, click the Select/Unselect button that displays on the far 
left side of the row. From the menu that displays, select Paste Row.  

5. To Insert a blank row, click the Select/Unselect button that displays on the far left 
side of the row. From the menu that displays, select Insert Row.  

6. To Move a row, click the Select/Unselect button that displays on the far left side of 
the row. From the menu that displays, select Move Row Up or Move Row Down to 
move the row up or down.  

7. To Delete a row, click the Select/Unselect button that displays on the far left side of 
the row. From the menu that displays, select Delete Row.  

8. When finished, click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.7 – IAP: Create an ICS 206 – Medical Plan. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Create an ICS 206 – Medical Plan. 
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I. ICS 206 

A. Create an ICS 206 – Medical Plan.  

II. CREATE ICS 206 

A. To create an ICS 206 – Medical Plan:  

NOTE: The ICS 206 – Medical Plan is a narrative, fill-in form. 

1. Double click ICS206 in the Tree View to open a new ICS 206 form.  

2. From the Operational Period drop-down list, select the appropriate Shift. 

3. Complete the following sections, as appropriate:  

a. Incident Medical Aid Station  

b. Ambulance Services  

c. Incident Ambulances.  

3. In the Paramedics column, click to check the Yes or No checkboxes to designate the 
available Paramedics for each type of medical service.  

4. Complete the Hospitals section. Then click to select the Yes or No checkboxes, to 
identify whether a Helipad or Burn Center are available.  

5. In the Medical Emergency Procedures box, type a description of the medical 
emergency procedures, as appropriate.  

6. In the Prepared By (Medical Unit Leader) box, type the Medical Unit Leader 
Name.  

7. In the Reviewed By (Safety Officer) box, type the Safety Office Name, and then 
click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.8 – IAP: Create an ICS 220 – Air Operations 

Summary. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Create an ICS 220 – Air Operations 
Summary. 
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I. ICS 220  

A. Create an ICS 220 – Air Operations Summary.  

II. CREATE ICS 220 

A. To create an ICS 220 – Air Operations Summary: 

NOTE: The ICS 220 – Air Operations Summary is mostly a narrative, two-page form. 

1. Double click ICS220 in the Tree View to open a new ICS 220 form. 

2. From the Operational Period drop-down list, select the appropriate Shift. 

3. Complete the following sections, as appropriate:  

NOTE: When the header information (i.e. Prepared By, Sunrise, Sunset, etc.) is completed for 
Page 1, the same information is automatically transferred to Page 2. 

a. Prepared by – (Enter the Air Operations Leader Name.)  

b. Sunrise  

c. Sunset  

d. REMARKS  

e. MEDEVAC AIRCRAFT  

f. TFR  

g. PERSONNEL  

h. FREQUENCY – (Use the AM RX/TX drop down box to select the 
frequency of your choice.)  

NOTE: Frequencies are automatically populated with frequencies from the ICS 205.  

i. FIXED WING  

j. HELICOPTERS.  

4. To advance to the next page of the form, click the Go to Page 2 button.  

5. Complete the TASK/ MISSION/ ASSIGNMENT section, as appropriate.  

6. When finished, click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.9 – IAP: View, Copy, and Delete Forms. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. View a Single Type of Form (e.g. all 
202’s).  

2. View All Forms Grouped by Form 
Number.  

3. View All Forms Grouped by Incident 
Action Plan.  

4. Copy a form.  

5. Copy a Plan 

6. Delete a form.  
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I. VIEW/COPY/DELETE FORMS 

A. View a Single Type of Form.  

B. View All Forms Grouped by Form Number.  

C. View All Forms Grouped by Incident Action Plan.  

D. Copy a form.  

E. Copy a plan. 

F. Delete a form.  

II. VIEW FORMS 

NOTE: The Tree View lists forms in numerical form order, by single type of form or for all 
operational periods (Plan). 

NOTE: There are three ways to display the Tree View.  

A. To view a Single Type of form: 

1. From the View drop-down menu, select Individual Form. Then click to select the 
form you want to view.  
 
OR  
 
In the IAP toolbar, click the arrow next to the Manage By Form button. Then 
select the form you want to view from the list that displays.  

B. To view All Forms Grouped by Form Number: 

1. From the View drop-down menu, select Form.  
 
OR  
 
In the IAP toolbar, click the Manage By Form button.  

NOTE: Forms do not display in the Tree View until saved.  

C. To view All Forms Grouped by Incident Action Plan: 

NOTE: The Tree View of the plans displays the forms that were created and saved for each 
operational period. 

1. From the View drop-down menu, select Plan.  
 
 OR  
 
On the IAP toolbar, click the Manage By Plan button.  

NOTE: You can open more than one form at a time. You can switch between open forms by 
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selecting the form from the Window drop-down menu. If the forms are minimized, you can 
also click an open form to select it. 

III. COPY FORMS 

A. Copy a Form. 

NOTE: To add a second page to a form, you can use the Copy Form option. This option 
copies the first page of the form to a second page. Edit the second page, as needed, keeping 
the same date and shift as the first page. Enter Page 2 Of 2 at the bottom of the second page. 

1. To copy any form:  

a. In the Tree View, click to highlight the form you want to copy.  

b. Click the Copy Form button to open the Copy Form window.  
 
OR 
 
From the Tools drop-down menu, select the Copy Form option to open the 
Copy Form window. 

c. The form you selected in the Tree View is highlighted under Select a Form 
to Copy From. If you want to copy another form, click to select the Form 
you want to copy.  

d. Under Select an Operational Period, select the Date and Shift to use for 
the Operational Period on the form that is copied.  

NOTE: The Operational Period defaults to the next day. You can change this date by either 
typing the date or selecting it from the drop-down calendar.  

d. Click the OK button to copy the form. 

IV. COPY PLANS 

A. Copy a Plan. 

NOTE: To copy an entire Incident Action Plan, use the Copy Plan option. After you copy 
the plan, edit the forms in the plan, as needed. 

1. To copy any plan: 

a. Click the Manage by Plan button to sort the Tree View by Plan. 

b. Click the Copy Plan button to open the Copy Plan window.  
 
OR  
 
Select the Tools Menu and the Copy Plan option to open the Copy Plan 
window. 

c. Under Select a Plan to Copy From, click the plan you want to copy. 

d. Under Select an Operational Period, select the Date and Shift to use for 
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the Operational Period on the plan that is copied. 

NOTE: The Operational Period defaults to the next day. You can change this date by either 
typing the date or selecting it from the drop-down calendar. The Operational Period that you 
define is copied onto each of the forms in the plan. 

e. Click the OK button to make a copy of the plan. 

f. From the Window drop-down menu, select a form to edit. 

NOTE: All of the forms in the plan you copied are listed under the Window drop-down 
menu. 

g. Make the appropriate changes to the form. 

h. Click the Save button to save your changes to the form. Notice that a new 
plan is created for today with the form listed underneath it in the Tree View.

NOTE: You need to save the form even if you do not make any changes to it. Only those 
forms that are saved will be included in the plan. 

i. Repeat steps f - h for each form in the plan. 

V. DELETE FORMS 

A. To delete a form: 

1. In the Tree View, click to select the form you want to delete.  

2. Click the Delete button in the Main toolbar.  

3. On the Deleting a Form window, click Yes to delete the selected form.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 6.10 – IAP: Work with Output. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Print an IAP Form.  

2. Export an IAP Form to a PDF file.  

3. Print an IAP Plan. 

4. Export an IAP Plan to a PDF file. 
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I. WORKING WITH OUTPUT 

NOTE: This Unit identifies how to create the following types of output from IAP: 

A. Print an IAP Form.  

B. Export an IAP Form to a PDF file.  

C. Print an IAP Plan 

D. Export an IAP Plan to a PDF file. 

NOTE: This Unit identifies some of the key tasks you must perform to create output from 
IAP. 

II. PRINTING FORMS 

A. Print IAP Forms: 

1. To Preview and Print a form.  

a. On the Tree View, click to select the form you want to print. 

b. In the toolbar, click the Print Preview button.  
 
OR  
 
From the File drop-down menu, select Print Preview.  

c. On the Print Preview window, click the Print button. When the Print 
window displays, click the Print button. 

2. To Print a form without Previewing it:  

a. In the Tree View, click to select the form you want to print. 

b. In the toolbar, click the Print button.  
 
OR  
 
From the File drop-down menu, select Print Current Form. 

c. When the Print window displays, click the Print button.  

III. EXPORTING FORMS 

A. To export an IAP Form to a PDF file: 

NOTE: You can export and save a form to a PDF file, which you can then post on a Web site.

1. In the Tree View, click to select the form you want to export. 

2. From the File drop-down menu, select Export.  

3. On the PDF Export window, browse to the folder where you want to save the PDF 
file.  
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4. In the File Name text box, type the name you want to assign to the PDF file. Then 
click the Save button.  

IV. PRINTING PLANS 

A. Print Incident Action Plans: 

1. To Preview and Print a Plan: 

a. Click the Manage by Plan button to sort the Tree View by Plan. 

b. Click the Plan you want to preview in the Tree View. 

c. From the File drop-down menu, select the Print Preview Plan option. 

d. On the Print Preview window, click the Print button. 

e. When the Print window displays, click the Print button. 

2. To Print a plan without Previewing it: 

a. Click the Manage by Plan button to sort the information in the Tree View 
by Plan. 

b. Click the Plan you want to print in the Tree View. 

c. From the File drop-down menu, select the Print Plan option. 

d. When the Print window displays, click the Print button. 

V. EXPORTING PLANS 

A. To Export an Incident Action Plan to a single PDF file: 

1. Click the Manage by Plan button to sort the Tree View by Plan. 

2. Click the Plan you want to export in the Tree View. 

3. From the File drop-down menu, select the Export Plan option. 

4. On the Plan Export Options window,select Export Entire Plan option. 

5. On the PDF Export window, browse to the folder where you want to save the 
PDF file.  

6. In the File Name text box, type the name you want to assign to the PDF file. Then 
click the Save button.  

B. To Export an Incident Action Plan to multiple PDF files (one file for each form in the 
plan):  

1. Click the Manage by Plan button to sort the Tree View by Plan.  
2. Click the Plan you want to export in the Tree View. 

3. From the File drop-down menu, select the Export Plan option.  

4. On Plan Export Options window, select Export Entire Plan to Separate Files 
option and click the OK button.  

5. On the PDF Export window, browse to the folder where you want to save the 
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PDF file.  

6. In the File Name text box, type the name you want to assign to the PDF file. Then 
click the Save button.  

NOTE: The system will automatically append the name of each form in the plan to the end of 
the filename entered by the user.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.0 – Time: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the Purpose of the Time module. 

2. Identify Options on the Time window.  
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I. TIME  

A. Review the Time module.  

NOTE: The Time module shares data with other I-Suite modules.  

1. The primary purpose of Time is to track time and create pay documents, including the 
Emergency FireFighter Time Report (OF-288) and the Emergency Equipment Use 
Invoice (OF-286). 

NOTE: Make sure you are careful when working with private information such as Social 
Security Numbers (SSN) and IRS Federal Employer Tax ID Numbers (EIN). This information 
must be kept confidential. 

II. TIME WINDOW 

A. Review the Time window: 

1. The Time toolbar is located to the right of the Filter toolbar. The buttons in this tool 
bar include: 

a. Post Time - Click the Post Time button to post time for a resource. 

b. Adjustments - Click the Adjustments button to make adjustments to the 
time for items such as Quarters and Lodging, Meals, Travel, etc. 

c. Treat enter as Tab - If you would like the Enter key to work as the Tab 
key when moving between options, click to check the Treat enter as Tab 
checkbox. 

d. Print Invoice - Click the Print Invoice button to print either an OF 288 or 
an OF 286, depending on the resource you have selected. 

2. The Resources grid displays beneath the toolbars in the center part of the window. 
This grid contains a list of all resources currently defined in the system. 

3. When you click the Post Time button, a Posting area displays at the bottom of the 
window. This area contains the following three tabs: 

a. Personnel Post - Use this tab to post time for personnel resources. 

b. Crew Post - Use this tab to post time for crew resources. 

c. Contractor Post - Use this tab to post time for a contracted resource. 

4. The Time drop-down menu at the top of the window contains the following Time 
options: 

a. Admin Office For Payment - Select this option to add Admin Offices to the 
I-Suite system. 

b. Contractor - Select this option to add contractors and agreements to the I-
Suite system. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.1 – Time: Options. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Select grid columns and set order.  

2. Set the Enter key as Tab for Posting.  
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I. OPTIONS  

A. Select grid columns and set order.  

B. Set the Enter key as Tab for Posting.  

II. RESOURCES GRID 

A. To identify the columns to display in the grid and the order in which to display them:  

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Time tab.  

3. Under Resource Grid Columns, click each of the columns you want to select. 

4. If you want to display the selected columns on the Time window, click the Show 
button. If you want to remove the selected columns from the Time window, click 
the Hide button. 

5. To adjust the order in which the columns display on the Time window, click a 
column. Then click the Move Up or Move Down button to move the column. 

6. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window.  

B. To set the Enter key as Tab for Posting Time: 

1. Click to check the Treat enter as Tab checkbox in the Time toolbar. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.2 – Time: Entering and Editing Personnel 

Information. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Identify the importance of data entry 
guidelines.  

2. Identify common data.  

3. Manage all incidents as one.  

4. Manage incidents separately.  

5. Enter and edit personnel data.  
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I. PERSONNEL INFORMATION 

A. Identify the importance of data entry guidelines.  

B. Identify common data.  

C. Manage all incidents as one.  

D. Manage incidents separately.  

E. Enter and edit personnel data.  

II. DATA ENTRY GUIDELINES 

A. Review and discuss the importance of data entry guidelines.  

1. In Resources, data is organized and presented based on the ICS 211 form.  

2. Before saving a resource you must complete the required fields. These required fields 
include:  

a. Request Number.  

b. Account Code.  

c. Last Name, First Name.  

d. Kind/Position.  

e. Status.  

f. Configuration.  

NOTE: Required fields are identified with an asterisk (*) to the left of the label. 

3. Before rostering people or adding additional qualifications, you must complete the 
required fields and save the resource.  

III. COMMON DATA 

A. To review common data: 

1. From the Modules drop-down list, select Time.  
 
OR  
 
Click the Time button in the Main toolbar.  

2. In the Resources grid, click to select the resource you want to view.  

3. Click the Edit button in the toolbar.  

NOTE: Entry items located above the tabs (i.e. just below the Manage Resource – Edit 
Mode label) are common to all I-Suite modules.  

NOTE: Data entry items for specific modules are located on their respective tabs (i.e. Plans, 
Time - Individual, and Cost Tabs).  
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NOTE: Resources is the primary data entry point for I-Suite data. The quality of the initial 
data is critical to successful integration of the data into other I-Suite modules. 

NOTE: Understanding the concept of Data Sharing is critical. Data is shared between all I-
Suite modules. Changes, additions, or deletions from any functional area affects the other I-
Suite modules. Successful integration requires cooperation and established Data Ownership 
Rules. These rules are established by each Incident Management Team and may change from 
team to team. 

IV. MANAGE INCIDENTS 

A. To manage all incidents as one: 

1. On the Menu bar, click to check the Manage All Incidents As One checkbox.  

2. When the Manage All Incidents as One message displays, click the OK button.  

NOTE: When managing all incidents as one, all resources display in the Resources grid. 

B. To manage incidents separately: 

1. On the Menu bar, click to uncheck the Manage All Incidents As One checkbox.  

2. From the Incident drop-down list, select the Incident you want to manage.  

NOTE: When managing incidents separately, only resources from the selected incident 
display in the Resources grid. 

V. PERSONNEL DATA 

A. To add or edit personnel data for Time:  

NOTE: Personnel data is initially defined in Resources. Before you can Post Time, you must 
edit the Resource records and add Time data. 

1. Open the Time module.  

2. In the Resources grid, click the personnel resource to which you want to add time 
data.  

3. Click the Edit button in the toolbar.  

4. Click the Time - Individual tab at the bottom of the window. 

5. From the Employment Type drop-down list, select one of the following employment 
types to assign to the personnel resource: 

a. AD 

b. FED 

c. OTHER 

6. If the Employment Type is AD, enter the resource's social security number in the 
Social Security Number and Verify SSN boxes.  

NOTE: To protect the identity of the Resource, the Social Security Number will display as 
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asterisks when you type it in the Social Security Number box. You must type it a second 
time in the Verify SSN box to ensure that the number is correct. If the two numbers do not 
match, the system will require you to enter them again. 

NOTE: Resources with an AD Employment Type must have a Social Security Number 
defined or an Original OF 288 will not print for them. 

8. Enter any applicable 288 Remarks.  

9. If AD is selected as the Employment Type, complete the following information:  

a. If this is the Initial Employment for the personnel resource, click to check 
the Initial Employment checkbox.  

b. If there will be Return Travel, click to check the Return Travel checkbox. 

c. From the Point of Hire drop-down list, select the appropriate point of hire.  

d. From the Area drop-down list, select the appropriate area.  

e. From the Class drop-down list, select the class to assign to the individual 
resource.  

9. If Other is selected as the Employment Type, enter the appropriate Current Rate.  

10. If FED is selected, this is the only required information needed. 

11. Under Personnel Mailing Address, complete the following information:  

NOTE: This information can be entered at a later time. 

a. Address 1  

b. Address 2  

c. City  

d. State  

e. Zip  

f. Phone  

g. Fax.  

NOTE: If a Fax number for FED or OTHER is entered at this time, it is available for the 
Personnel Time Report (Print/Fax). 

12. To save your changes, click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.3 – Time: Posting Personnel Time. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Post time for personnel.  

2. Use special rates.  

3. Repost a day of time.  

4. Edit a day of posted time.  

5. Delete a day of posted time.  

6. Change the KindCode and Rate (one-
time change).  

7. Change the KindCode and Rate 
(permanent change).  

8. Lock posted time to an established 
employment code.  

9. Post return travel time.  

10. Preview/print an OF 288 report.  
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I. PERSONNEL TIME 

A. Post time for personnel.  

B. Use special rates.  

C. Repost a day of time.  

D. Edit a day of posted time.  

E. Delete a day of posted time.  

F. Change the KindCode and Rate (one-time change).  

G. Change the KindCode and Rate (permanent change)  

H. Lock posted time to an established employment code.  

I. Post return travel time.  

J. Preview/print an Emergency FireFighter Time Report (OF 288) report.  

II. POST PERSONNEL TIME 

NOTE: The Date automatically changes when posting Time that extends beyond midnight. If 
you post Overlapping Hours, you must verify the overlap before proceeding. 

NOTE: For this first exercise, you will use Crew Time Reports (CTR’s) to post time. 

A. To use CTR's to post personnel time:  

1. Open the Time module.  

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the personnel resource to which you want to post time. 

4. On the Personnel Post tab, select the appropriate Account Code from the Account 
Code drop-down list.  

NOTE: The codes that display in the Accounting Codes drop-down list are based on whether 
Manage All as One is selected. If Manage All as One is selected, all accounting codes 
display in the list. If a single incident is selected, only accounting codes for that incident 
display in the list. 

5. In the Date box, type the Date in the format MMDDYYYY.  

6. If a special circumstance applies (e.g. Environmental Pay, Travel, Day Off, etc.), 
select the appropriate code from the Special drop-down list. 

NOTE: If you assign the GUAR, COP, or DAY OFF special codes to a resource with an 
Employment Type of FED or OTHER, the Start Time and Stop Time boxes are disabled. 
You do not need to define a Start or Stop time when these special codes are assigned. 

NOTE: If you assign the GUAR, COP, or DAY OFF special codes to a resources with an 
Employment Type of AD, the Start Time and Stop Time boxes are disabled and an Hours 
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box displays. Enter the number of hours for the AD resource in this box. The maximum 
number of hours you can enter is eight. 

7. In the Start Time box, either type the time or select it from the drop-down list to 
identify when the individual started working.  

8. In the Stop Time box, either type the time or select it from the drop-down list to 
identify when the individual stopped working.  

9. To commit the posting, click the Save button.  

10. To close the Personnel Post window, click the Close button.  

NOTE: If the time your are posting includes time from before midnight and time after 
midnight, a Posting Spans Midnight message displays. If you click the Yes button, the 
posting is split into two entries. If you click No, the posting is canceled. 

NOTE: Posted time is locked to an established employment code.  

  
B. Posting special rates. 

1. Select a code from the Special drop-down list when any of the following special 
circumstances apply: 

a. Hazards Fuels (Casual) 

b. Instructor (Casuals) 

c. Training (Casuals) 

d. Continuation of Pay 

e. Day Off 

f. Environmental Pay 100% 

g. Environmental Pay 15 % 

h. Environmental Pay 25 % 

i. Environmental Pay 4% 

j. Environmental Pay 8 % 

k. Guarantee 

l. Travel 

m. Hazard Pay 

III. REPOST HOURS 

A. To repost different hours for an individual whose time was already posted for the day:  

1. Open the Time module.  

2. Click the Post Time button in the Time toolbar.  
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3. In the Resources grid, click the resource for which you are reposting hours.  

4. On the Personnel Post tab, select the appropriate Account Code from the Account 
Code drop-down list.  

NOTE: If you select an Account Code that is not the default for that resource, the code 
remains selected until a different resource or different account code is selected. 

5. In the Date box, type the Date in the format MMDDYYYY.  

6. If a special circumstance applies (e.g. Environmental Pay, Travel, Day Off, etc.), 
select the appropriate code from the Special drop-down list. 

7. In the Start Time box, either type the time or select it from the drop-down list to 
identify when the individual started working.  

8. In the Stop Time box, either type the time or select it from the drop-down list to 
identify when the individual stopped working.  

9. Click the Save button to post the time. 

10. When the Overlapping Hours window displays, click the Yes button to overwrite 
the previously posted hours with the ones that you just defined.  

11. To close the Personnel Post window, click the Close button.  

IV. EDIT POSTED TIME 

A. To edit a day of posted time.  

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the resource with the posted time you want to edit.  

4. In the Personnel Post Detail grid, click the posted time you want to edit. You can edit 
the entries in the following boxes: 

a. Start 

b. Stop 

c. Class 

d. KindCode 

e. Special 

f. AccountingCode 

NOTE: If the special code GUAR, COP, or DAY OFF were assigned to the posting, you 
cannot edit the entry. To make changes to one of these postings, you must delete the entry and 
then create a new posting. 

5. After you have edited the entries, click the Close button to close the Personnel Post 
window.  

NOTE: For edited entries to save, you must click outside of the grid. When the pencil image 
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in the selector column changes from a pencil to an arrow, the changes were saved. 

B. To delete a day of posted time: 

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the resource with the posted time you want to delete.  

4. In the Personnel Post Detail grid, click anywhere in the row that you want to delete. 
Then click the Delete button in the Main toolbar.  

5. When the Delete Posting window displays, click the Yes button to remove the posted 
time. 

C. To change the KindCode or Rate (one-time change only).  

1. Open the Time module.  

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the resource you want to edit.  

4. In the Personnel Post Detail grid, locate the row containing the KindCode or Rate 
you want to change.  

5. To change the KindCode, select the new code from the KindCode drop-down list.  

6. To change the AD Class and Rate, enter the class code in the AD Class box in the 
grid.  

7. To change the Other Rate, click in the Current Rate box. Then enter the appropriate 
Rate. 

8. To close the Personnel Post window, click the Close button.  

NOTE: The KindCode or Rate for all future personnel postings can be changed in 
Resources. 

 
V. RETURN TRAVEL TIME 

A. To post return travel time with 0 (zero) hours:  

1. Open the Time module 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the resource to which you are posting return travel time.  

4. Click to check the Post Return Travel Start Time Only checkbox.  

NOTE: The TVL code is automatically selected in the Special box when the Post Return 
Travel Start Time Only checkbox is checked. 

5. In the Date box, type the Date in the format MMDDYYYY.  

6. In the Start Time box, either type the time or select it from the drop-down list to 
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identify the time when the individual started the return travel.  

NOTE: No Stop Time is defined. If you do enter a Stop Time, the Time module removes it 
when you save the posting entry. 

7. To commit the posting, click the Save button.  

NOTE: Notice that the number of hours in the grid is 0 (zero) for the posting. 

8. To close the Personnel Post window, click the Close button.  

B. To post Return Travel Time with hours defined: 

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar. 

3. In the Resources grid, click the resource to which you are posting return travel time. 

4. In the Date box, type the date in the format MMDDYYYY. 

5. Select the TVL option from the Special drop-down list. 

NOTE: Make sure the Post Return Travel Start Time Only checkbox is NOT checked. 

6. In the Start Time box, either type the time or select it from the drop-down list to 
identify the time when the individual started the return travel. 

7. In the Stop Time box, either type the time or select it from the drop-down list to 
identify the time when the individual stopped the return travel. 

8. To commit the posting, click the Save button. 

NOTE: Notice that the number of hours displays in the grid for the posting. This number 
based on the Start and Stop Times that were defined. 

9. To close the Personnel Post window, click the Close button. 

VI. PRINT INVOICE 

A. To preview or print an Emergency FireFighter Time Report (OF 288) report: 

1. Open the Time module. 

2. In the Resources grid, click the resource for which you are creating the report.  

3. Click the Print Invoice button.  

4. On the OF 288 window, identify the following information:  

a. From the Last Date Included on Invoice drop-down list, select the 
appropriate date.  

b. To create the final OF 288 for a resource leaving the incident, click to check 
the Final Invoice checkbox.  

c. Click to select one of the following Print Options:  

• Preview/Print DRAFT Invoice - Generates a Draft Invoice. Review 
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this invoice, before printing an Original copy. The word Draft prints on 
this invoice. 

• Preview/Print ORIGINAL Invoice - Generates an Original Invoice 
and locks all postings included in the invoice. When a posting is 
locked, you cannot make any changes to it. 

NOTE: If a resource has a supply item that is not consumable issued to them and an Original 
Invoice is printed, a notification message displays indicating that the resource has supplies 
issued to them. Click the OK button to continue printing the invoice. Click the Cancel button 
to abort the print process. 

• Preview/Print DUPLICATE ORIGINAL Invoice(s) - Generates a 
copy of an Original Invoice. A list of available invoices from which 
you can select displays when you click this option. 

NOTE: Have the employee write their Social Security Number in the 2. Social Security 
Number field on the form when they sign the OF-288 for casuals. This number does not print 
on the form. 

d. When generating a Draft invoice, click to select one of the following 
Report Options: 

• OF-288 with Itemized Deductions 

• OF-288 Only 

• Itemized Deductions Only 

NOTE: When you are printing an Original Invoice or a Duplicate Original Invoice, only 
the OF-288 with Itemized Deductions option is available. 

e. If this is the final invoice for the Resource, click to check the Final Invoice 
box. 

f. To preview and then print the report, click the Preview button. Then click 
the Print Report button on the Preview window.  

g. To print the report without previewing it, click the Print button.  

h. To delete the last invoice for the selected resource, click the Delete Last 
Invoice for Selected Resource button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.4 – Time: Entering and Editing Crews. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Define a crew as it pertains to Time.  

2. Define the two levels within a crew 

3. View or print a Crew Roster report.  

4. Edit crew information.  

5. Edit members on a crew.  

6. Add crew members to an existing crew.  

7. Create a crew.  
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I. CREW INFORMATION 

A. Identify a crew as it pertains to Time.  

B. Identify the two levels within a crew: the actual crew and crew members or operators.  

C. View or print a Crew Roster report.  

D. Edit crew information.  

E. Edit members on a crew.  

F. Add crew members to an existing crew.  

G. Create a crew.  

II. IDENTIFY CREW 

A. Identify a crew as it pertains to Time.  

NOTE: A Crew is more than one Resource sharing the same Request Number. Crews are 
built by attaching or rostering members to a Kind of Resource. 

1. What is a crew?  

a. Handcrew.  

b. Engine members paid on an OF 288.  

c. Driver attached to a vehicle.  

d. Faller attached to a chainsaw and or vehicle.  

e. Helitack Crew.  

2. A crew is defined as more than one resource sharing the same request number.  

3. The same rules apply for crews as for personnel:  

a. Add crew and member data in Resources.  

b. Edit crew and member data and enter additional crew and member data in 
Time.  

B. The two levels within a crew are:  

1. The Actual Crew.  

2. Crew Members or Operators.  

C. To view or print a Crew Roster report: 

1. Click the Reports button in the toolbar. Then click to select the Time tab.  
 
OR  
 
From the Reports drop-down menu, select Time Reports.  

2. On the Time Reports window, click to select Crew Roster.  
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3. Under Report Settings, complete the following as appropriate:  

a. From the Request Number drop-down list, select the appropriate Request 
Number.  
 
OR  
 
From the Crew Name drop-down list, select the appropriate Crew.  

b. To preview then print the report, click the Preview button. Then click the 
Print Report button on the Preview window.  

c. To print the report without previewing it, click the Print button.  

d. When the Print window displays, click the Print button to send the report to 
the printer. 

III. EDIT CREWS 

NOTE: This next exercise simulates a typical environment, where an existing crew is defined 
in Resources. 

NOTE: There are two levels of crew information with which you will work: 

• At the Crew Level, you can Add or Edit Crew information.  

• At the Member/Operator Level, you can Add or Edit individual crew member or 
operator information. 

A. To edit crew information: 

1. Open the Time module.  

2. In the Resources grid, click the crew resource you want to edit.  

3. Click the Edit button in the toolbar.  

4. On the Manage Resource – Edit Mode window, review the common data. Then edit 
the crew data, as needed.  

5. To save your changes, click the Save button.  

B. To edit crew members rostered in resources:  

1. Open the Time module.  

2. In the Resources grid, click the plus sign (+) that displays to the left of a Crew. This 
displays a list of members rostered to the crew.  

3. Click to select the Crew Member you want to edit.  

4. Click the Edit button in the toolbar.  

5. On the Roster Resource – Edit Mode window, review the common data. Then edit 
the personnel data, as needed.  

a. To designate the resource as the crew leader, click to check the Leader 
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checkbox.  

6. On the Time tab, edit personnel data, as needed. (Refer to “Entering and Editing 
Personnel Information” for specific instructions).  

7. To save your changes, click the Save button.  

8. To edit data for other members on the crew, click the Previous or Next button to 
display the previous or next crew member. Then follow the instructions in this 
section to edit the data, as needed.  

IV. CREATE CREWS 

NOTE: In some cases, a Crew Leader will show up on the Crew, but you must add the 
remaining Crew Members. 

A. To add crew members to an existing crew.  

1. In the Resource grid, click to select the Crew to which you are adding the crew 
members.  

2.  Click the Edit button in the toolbar.  

3. On the Manage Resource – Edit Mode window, click the Roster button.  

4. On the Roster Resource – Add Mode window, enter the following personnel data:  

a. Request Number  

b. Last Name  

c. First Name  

d. Kind/Position  

NOTE: All crew members must have a kind code for their position. Do NOT use HC1 or 
HC2. This will effect the cost module. If a kind code is not defined, the cost will carry over as 
a hand crew for each member. If you are unsure of the crew member's position, just select 
FFT2. 

e. If the resource is a trainee, click to check to the Trainee checkbox. 

f. Status  

g. Unit ID 

h. Agency (Optional) 

i. To designate the resource as the crew leader, click to check the Leader 
checkbox.  

5. On the Plans tab, enter any applicable data including: 

a. Check-in Date 

b. Check-in Time 

c. Demob City 
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d. Demob State 

e. Jetport 

f. Travel Method 

g. Other Quals 

6. On the Time tab, select one of the following employment types from the 
Employment Type drop-down list: 

a. AD 

b. FED 

c. OTHER 

NOTE: Use the Members to Fed button to change the Employment Type for all crew 
members without an employment type to Fed. Use the Members to Other button to change 
the Employment Type to Other. Click the Arrow next to the button to switch between 
Members to Fed and Members to Other. 

7. If the Employment Type is AD, enter the resource's social security number in the 
Social Security Number and Verify SSN boxes. 

NOTE: To protect the identity of the Resource, the Social Security Number will display as 
asterisks when you type it in the Social Security Number box. You must type it a second 
time in the Verify SSN box to ensure that the number is correct. If the two numbers do not 
match, the system will require you to enter them again. 

NOTE: Resources with an AD Employment Type must have a Social Security Number 
defined or an Original OF 288 will not print for them.  

8. Enter any 288 Remarks.  

9. If AD is selected as the Employment Type, complete the following information under 
Payment Information:  

a. Click to check the Initial Employment checkbox, if appropriate.  

b. Click to check the Return Travel checkbox, if appropriate.  

c. From the Point of Hire drop-down list, select the appropriate point of hire.  

d. From the Area drop-down list, select the appropriate area.  

e. From the Class drop-down list, select the appropriate class.  

10. If Other is selected as the Employment Type, enter the appropriate Current Rate. 

11. Under Personnel Mailing Address, enter the following personnel data:  

a. Address 1  

b. Address 2  

c. City  
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d. State  

e. Zip  

f. Phone  

g. Fax.  

h. To add the same address to all crew members without an address defined, 
select a crew member that has an address defined and click the Propagate 
Address button. The address is added to all of the crew members who do 
not have an address defined. 

NOTE: To clear an address in a crew member record, select the crew member and click the 
Clear Address button. 

12. To save your changes, click the Save button.  

13. To add additional crew members, repeat the steps in this section.  

NOTE: In this section, you will create a new Crew. 

B. To create a crew: 

1. Open the Time module.  

2. Click the Add button on the toolbar.  

3. On the Manage Resource – Add Mode window, enter the following crew data:  

a. Request Number  

b. Account Code  

c. Resource Name  

d. Kind/Position  

e. Status  

f. Unit ID  

g. Agency  

h. Configuration  

i. Release Date  

j. Release Time.  

4. To save your changes, click the Save button.  

5. Add crew members, as appropriate.  

NOTE: For More information, Refer to the previous section, “To Add Crew Members To An 
Existing Crew.” 



  

  
I-Suite Version 13.01.00 Time  7.5-25 

  

STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.5 – Time: Posting Crew and Operator Time. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Use the Select All, Select None, and 
Invert Selection buttons.  

2. Post crew time using crew time reports 
(CTR’s).  

3. Repost a day of time.  

4. Delete posted time.  

5. Copy and paste posted time.  

6. Post return travel time.  

7. Preview/print an OF 288 report.  
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I. CREW TIME 

A. Use the Select All, Select None, and Invert Selection buttons.  

B. Post crew time using crew time reports (CTR’s).  

C. Repost a day of time.  

D. Delete posted time.  

E. Copy and paste posted time.  

F. Post return travel time.  

G. Preview/print an Emergency FireFighter Time Report (OF 288) report.  

II. SELECT CREW MEMBERS 

A. To use the Select All, Select None, and Invert Selection buttons: 

1. Open the Time module 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the appropriate crew resource.  

4. Under Crew Members on the Crew Post tab, click the Select All button.  

NOTE: Notice how all Crew Members are now selected.  

5. Under Crew Members, click the Select None button.  

NOTE: Notice how no Crew Members are now selected.  

6. Under Crew Members, select several Crew Members.  

a. To select multiple crew members, hold down the Ctrl key while clicking 
each member you want to select.  
 
OR  
 
While holding down the Shift key, click the top and then the bottom crew 
member. 

7. Click the Invert Selection button.  

NOTE: Notice that all Crew Members not selected are now selected and those that were 
selected are not selected.  

NOTE: To display the social security number for AD employees, click the Show SSN button. 
To hide social security numbers for AD employees, click the Hide SSN button. 

8. To close the Crew Post window, click the Close button.  

III. POST CREW TIME 

NOTE: In this section, you will use the Crew Time Report (CTR) to Post Time to a Crew and 
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to Individual Crew Members.  

NOTE: You can only post time to crew members with a Checked In Status. 

A. To post crew time using Crew Time Reports (CTR’s):  

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the appropriate crew resource.  

4. On the Crew Post tab, select the appropriate Account Code from the Account Code 
drop-down list.  

NOTE: If you select an Account Code that is not the default for that resource, the code 
remains selected until a different resource or different account code is selected. 

5. Under Crew Members, click to select the crew members for which you are posting 
time. 

6. In the Date box, type the appropriate Date in the format MMDDYYYY.  

7. If a special circumstance applies (e.g. Environmental Pay, Travel, Day Off, etc.), 
select the appropriate code from the Special drop-down list. 

NOTE: If you assign the GUAR, COP, or DAY OFF special codes to a resource with an 
Employment Type of FED or OTHER, the Start Time and Stop Time boxes are disabled. 
You do not need to define a Start or Stop time when these special codes are assigned. 

NOTE: If you assign the GUAR, COP, or DAY OFF special codes to a resources with an 
Employment Type of AD, the Start Time and Stop Time boxes are disabled and an Hours 
box displays. Enter the number of hours for the AD resource in this box. The maximum 
number of hours you can enter is eight. 

8. In the Start Time box, either type the time or select it from the drop-down list to 
identify the time when the individual started working.  

9. In the Stop Time box, either type the time or select it from the drop-down list to 
identify the time when the individual stopped working.  

10. To commit the posting, click the Save button.  

IV. EDIT CREW TIME 

NOTE: In this section, you will Repost different hours for a Crew Member whose time was 
already posted for the day.  

A. To repost time for a crew member:  

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the appropriate crew resource.  
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4. On the Crew Post tab, select the appropriate Account Code from the Account Code 
drop-down list.  

5. Under Crew Members, click to select the Crew Member(s) for which you are 
reposting time.  

NOTE: Make sure you select the correct Crew Member(s). 

NOTE: Locate the day and time you want to repost.  

6. In the Date box, type the date for which you want to repost hours.  

7. If a special circumstance applies (e.g. Environmental Pay, Travel, Day Off, etc.), 
select the appropriate code from the Special drop-down list. 

8. In the Start Time box, either type the time or select it from the drop-down list to 
identify when the individual started working.  

9. In the Stop Time box, either type the time or select it from the drop-down box to 
identify when the individual stopped working.  

10. To commit the posting, click the Save button.  

11. When the Overlapping Hours window displays, click the Yes button to overwrite 
the previous post with the current one.  

12. To close the Crew Post window, click the Close button.  

B. To delete posted time: 

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources  grid, click the appropriate crew resource.  

4. Under Crew Members, click to select the crew member(s) from whom you want to 
delete a time posting.  

5. Under Crew Member/Operator Post Detail, click in the row that contains the time 
you want to delete. Then click the Delete button.  

6. When the Time: Delete Posting for Crew Member(s) window displays, click the Yes
button. 

7. To close the Crew Post window, click the Close button.  

C. To copy and paste posted time:  

NOTE: You can Copy and Paste posted time by right clicking the mouse button in the row 
you want to copy or paste. 

NOTE: You cannot Copy and Paste time postings that have a Special Code of GUAR, COP 
or Day Off. 

1. Under Crew Member/Operator Post Detail, click the selector button on the far left 
of a row to select it.  
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2. Right-click the mouse in the selected row. Then click  the Copy Selected Postings 
option in the menu that displays.  

3. Under Crew Members, click to select the crew member to which you want to paste 
the copied post entry.  

4. Right-click the mouse in the selected row. Then click the Paste Copied Posting to 
Selected Member(s) in the menu that displays.  

5. On the Crew Post Results window, click the OK button.  

V. RETURN TRAVEL TIME 

A. To post return travel time with 0 (zero) hours:  

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the appropriate crew resource.  

4. Under Crew Members on the Crew Post tab, click to select the appropriate crew 
member(s).  

5. Click to check the Post Return Travel Start Time Only checkbox.  

NOTE: The TVL code is automatically selected in the Special box when the Post Return 
Travel Start Time Only checkbox is checked. 

6. In the Date box, type the Date in the format MMDDYYYY.  

7. In the Start Time box, either type the time or select it from the drop-down list to 
identify when the individual started working.  

NOTE: No Stop Time is defined. If you do enter a Stop Time, the Time module removes it 
when you save the posting entry. 

8. To commit the posting, click the Save button.  

9. On the Crew Post Results window, click the OK button.  

10. To close the Crew Post window, click the Close button.  

NOTE: Notice that the number of hours in the grid is 0 (zero) for the posting. 

B. To post Return Travel Time with hours defined: 

1. Open the Time module. 

2. Click the Post Time button in the Time toolbar. 

3. In the Resources grid, click the appropriate Crew Resource.  

4. In the Date box, type the date in the format MMDDYYYY. 

5. Select the TVL option from the Special drop-down list. 

NOTE: Make sure the Post Return Travel Start Time Only checkbox is NOT checked. 
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6. In the Start Time box, either type the time or select it from the drop-down list to 
identify the time when the individual started the return travel. 

7. In the Stop Time box, either type the time or select it from the drop-down list to 
identify the time when the individual stopped the return travel. 

8. To commit the posting, click the Save button. 

NOTE: Notice that the number of hours displays in the grid for the posting. This number 
based on the Start and Stop Times that were defined. 

9. To close the Crew Post window, click the Close button. 

VI. PRINT INVOICE 

A. To preview or print an Emergency FireFighter Time Report (OF 288) report:  

1. Open the Time module. 

2. In the Resources grid, click the appropriate crew resource.  

3. Click the Print Invoice button in the Time toolbar.  

4. On the OF 288 window, identify the following information:  

a. In the Last Date Included on Invoice box, enter the appropriate date. You 
can either type the date or select it from the drop-down calendar.  

b. To create the final OF 288 for a resource leaving the incident, click to check 
the Final Invoice checkbox.  

• Click to select one of the following Print Options:  

o Preview/Print DRAFT Invoice - Generates a Draft Invoice. 
Review this invoice, before printing an Original copy. The word 
Draft prints on this invoice. 

o Preview/Print ORIGINAL Invoice - Generates an Original 
Invoice and locks all postings included in the invoice. When a 
posting is locked, you cannot make any changes to it. 

NOTE: If a resource has a supply item that is not consumable issued to them and an 
Original Invoice is printed, a notification message displays indicating that the resource 
has supplies issued to them. Click the OK button to continue printing the invoice. Click 
the Cancel button to abort the print process. 

o Preview/Print DUPLICATE ORIGINAL Invoice(s) - When a 
parent crew is selected, a copy of the last Original Invoice that 
was printed for all crew member resources is reprinted. When a 
crew member is selected, a list of available invoices that you can 
reprint for the crew member displays.  

a. When generating a Draft invoice, click to select one of the following 
Report Options: 
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• OF-288 with Itemized Deductions 

• OF-288 Only 

• Itemized Deductions Only 

NOTE: When you are printing an Original Invoice or a Duplicate Original Invoice, only 
the OF-288 with Itemized Deductions option is available. 

e. If this is the final invoice for the Resource, click to check the Final Invoice 
box. 

f. To preview and then print the report, click the Preview button. Then click 
the Print Report button.  

g. To print the report without previewing it, click the Print button.  

h. When the Print window displays, click the Print button to send the report to 
the printer. 

NOTE: Have the employee write their Social Security Number in the 2. Social Security 
Number field on the form when they sign the OF-288 for casuals. This number does not print 
on the form. 

h.  To delete the last invoice for the selected resource, click the Delete Last 
Invoice for Selected Resource button.  

NOTE: A separate OF 288 is generated for each Crew Member. You can preview or print 
each OF 288, as needed.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.6 – Time: Entering and Editing Contracted 

Resources. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Identify the relationship between 
contractors, agreements, and resources.  

2. Add/edit common data.  

3. Add/edit contractors, agreements, and 
administrative offices for payment.  

4. Add/edit resource specifications.  

5. Add/edit rates.  

6. Add/edit operator(s) for a contracted 
resource.  
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I. CONTRACTOR INFORMATION  

A. Identify the relationship between contractors, agreements, and resources.  

B.  Add/edit common data.  

C. Add/edit contractors, agreements, and administrative offices for payment.  

D. Add/edit resource specifications.  

E. Add/edit rates.  

F. Add/edit operator(s) for a contracted resource.  

II. CONTRACTORS, AGREEMENTS, & RESOURCES 

A. Identify the relationship between contractors, agreements, and resources.  

NOTE: The following are important terms to understand when working with Contractors: 

• Contractor – A business entity with available Resources. 

• Agreement – An OF-294 that is attached to the contractor. A single Contractor may have 
many agreements or one agreement with several pieces of equipment on it. 

• Specifications – Conditions that the Resource (Contractor) must meet to fulfill the 
agreement. 

NOTE: It is not mandatory to have a Contract and an Agreement established prior to posting 
Time, but it may be necessary before processing an invoice. 

III. COMMON DATA 

A. To edit common data: 

1. Open the Time module.  

2. On the Main grid, click to select the Contract Resource of your choice.  

3. Click the Edit button in the Main toolbar.  

4. On the Manage Resource – Edit Mode window, enter the appropriate common data. 

IV. CONTRACTORS, AGREEMENTS & ADMIN OFFICES 

A. To add or edit contractors, agreements, and administrative offices for payment:  

NOTE: Use the provided handouts to complete this exercise.  

NOTE: You must first verify whether the contractor is defined in I-Suite before creating a 
Contract record. If the contractor is not defined, you will need to click the Add Contractor 
button to add a new contractor.  

NOTE: You only need to enter a contractor name once.  

1. On the Time – Contracted tab, select the appropriate contractor from the Contractor 
Name drop-down list. If the contractor name is not listed, use the following steps to 
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add the contractor: 

a. Click the Add Contractor button.  

b. On the Add – Contractor window, enter the following information:  

• Name  

• TIN (Tax Identification Number)  

• DUNS (D&B DUNS Number)  

• Address  

• City  

• State  

• Zip  

• Phone.  

c. To save the new contractor, click the Save button.  

NOTE: If the agreement is not defined in I-Suite, you will need to click the Add Agreement 
button to add a new agreement. 

d. To close the Contracts window, click the Close Contracts button. 

2. From the Agreement Number drop-down list, select the appropriate Agreement 
Number. If the agreement number is not listed, use the following steps to add the 
agreement: 

a. Click the Add Agreement button.  

b. On the Add - Agreement window, enter the following information:  

• Agreement Number  

• Beginning Date (MMDDYYYY)  

•  Ending Date (MMDDYYYY)  

• Point of Hire (location at the time of hire)  

• Administrative Office For Payment.  
 
If the appropriate office is not listed in the Administrative Office For 
Payment drop-down list, click the Add New Administrative Office 
for Payment button. Then enter the appropriate information for the 
office in the boxes that display. Click the Save button to save the office 
information. 

NOTE: You only need to enter an Administrative Office For Payment once. 
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c. To save the new agreement, click the Save button.  

3. Click the Close button until you return to the Manage Resource - Edit Mode 
window. 

B. To define resource information for the contractor:  

1. On the Time – Contracted tab, enter the following resource data:  

a. In the Unique Name or VIN box, type a unique name for the resource or a 
VIN if the resource is a vehicle.  

b. In the Description 1 box, type an appropriate description (make, model, etc., 
if any).  

c. In the Description 2 box, type an appropriate description (make, model, etc., 
if any).  

d. In the 286 Remarks box, type any remarks you want to print on the OF-286 
Invoice.  

e. If the contracted resource has a government provided operator, click to check 
the Gov’t Operator checkbox.  

f. If the government is providing supplies to the contracted resources, click to 
check the Gov’t Supplies checkbox.  

g. In the Date Hired box, type the Date Hired in the format MMDDYYYY.  

h. In the Time Hired box, type the Time Hired.  

i. If the resource was withdrawn, click to check the Withdrawn checkbox.  

C. To define rates: 

1. On the Time – Contracted tab, complete the following information in the rates 
section:  

a. From the Rate Type drop-down list, select the appropriate Rate Type.  

b. From the UOM drop-down list, select the appropriate Unit of Measure.  

c. In the Rate $ box, type the appropriate Rate for the selected Rate Type and 
Unit of Measure.  

d. In the Guarantee $ box, type the appropriate Guarantee amount, if any.  

e. In the Description box, type an appropriate Description, if any.  

f. To save the rate, click the Save Rate button.  

g. Repeat these same steps to add additional rates, as needed.  

2. After entering all Time – Contracted information, click the Save button.  

3. On the Warning – Check for Correct Agreement/Contractor window, click the 
Yes button.  

NOTE: Make sure you always look at this message, before clicking the Yes button. It is easy 



  

I-Suite Version 13.01.00 Time  7.6-36 

on a busy incident to make a mistake here. 

V. OPERATORS 

A. To add operators to a contracted resource: 

NOTE: Not all Contracted Members/Operators require Time data. 

1. Open the Time module.  

2. In the Resources grid, click the appropriate contracted resource.  

3. Click the Edit button in the toolbar.  

4. On the Manage Resource – Edit Mode window, click the Roster button.  

5. On the Roster Resource – Add Mode window, enter the appropriate information.  

NOTE: If you are using the IAP module, you need to check the box for a Leader when 
rostering. 

NOTE: The Member/Operator may have been added during the initial check-in process. 

NOTE: Rostering a Member/Operator is the same as adding and editing Crews.  

NOTE: Use the information listed on the handouts to add additional Contracted resources.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.7 – Time: Posting Contract Resource Time. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify primary and special rate options. 

2. Post for each unit of measure.  

3. Identify when to use the ½ rate and the 
guarantee functions.  

4. Post contracted resource time.  

5. Repost a day of time.  

6. Delete a row of time.  

7. Preview/print an OF 286 report.  
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I. POST CONTRACTOR TIME 

A. Identify primary and special rate options.  

B. Post for each unit of measure.  

C. Identify when to use the ½ rate and the guarantee functions.  

D. Post contracted resource time.  

E. Repost a day of time.  

F. Delete posted time.  

G. Preview/print an Emergency Equipment – Use Invoice and/or Itemized Deductions (OF-
286) report  

II. POSTING OPTIONS 

A. Identify primary and special rate options. 

B. Understand posting for each unit of measure.  

1. To post a Daily Rate for Contracted Resources, complete the Start Date and End 
Date boxes.  

NOTE: You can post for one date or for a range of up to five dates. 

2. To post an Hourly Rate for Contracted Resources , complete the Date, and the Start 
and Stop Time boxes. 

NOTE: To ensure a guarantee is posted for equipment that is still under hire but is not 
currently being used on any given day, enter a minimum of 15 minutes of work time and one 
mile of mileage. 

3. To post Mileage for Contracted Resources, complete the Date and Miles boxes.  

4. To post Each for Contracted Resources, complete the Date and Each boxes. 

C. Identify when to use the ½ Rate and the Guarantee functions.  

1. The ½ Rate can apply to the Primary, Special, or Both Rates when posting. The ½ 
Rate will reduce the Guarantee Amount on Daily by half. 

2. To post for Equipment that is still under hire, but not currently being used on any 
given day, enter a Minimum for the Specific Unit Of Measure to trigger the 
Guarantee.  

3. The Guarantee Amount only displays on the OF 286. It does not display on the 
Incident Post-Posting Equipment window. 

III. POST CONTRACTED RESOURCES TIME 

A. To post contracted resource time:  

NOTE: For this exercise, you will use Shift Tickets to Post Time to Contracted Resources. 
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1. Open the Time module. 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the appropriate contracted resource.  

4. From the Primary drop-down list, select the appropriate primary rate for the resource.

5. If applicable, select the appropriate rate from the Special drop-down list. 

6. From the Account Code drop-down list, select the appropriate account code. 

7. Under Post Options, click to select the appropriate option.  

NOTE: Post options display based on the Primary and Special UOM’s selected.  

8. If one-half rate applies, click to check the ½ Rate checkbox.  

9. Enter the appropriate posting information for that Rate Type and Unit of Measure.  

10. Complete the other fields based on the settings defined under Posting Options. 

11. To commit the posting, click the Save button.  

IV. EDIT TIME 

A. To repost different hours for a contracted resource that already had time posted for the 
day:  

NOTE: When you repost Contracted Resource Time, you can add to the original posting or 
overwrite the existing entry. 

NOTE: For this example, you will overwrite the existing entry. 

1. Open the Time module.  

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the appropriate contracted resource.  

4. From the Primary drop-down list, select the appropriate rate for the resource.  

5. If applicable, select a rate from the Special drop-down list.  

6. From the Account Code drop-down list, select the appropriate account code. 

7. Under Post Options, click to select the appropriate option. 

8. If one-half rate applies, click to check the ½ Rate checkbox. 

9. Enter the appropriate posting information for that Rate Type and Unit of Measure. 

10. Complete the other fields based on the settings defined under Posting Options. 

11. To commit the posting, click the Save button.  

12. On the Already Posted window, click the Overwrite button.  

B. To delete a row of posted time:  

NOTE: For this exercise, you will delete Posted Time using the same Contracted Resource.  
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1. Open the Time module 

2. Click the Post Time button in the Time toolbar.  

3. In the Resources grid, click the appropriate contracted resource.  

4. Under Equipment Post Detail, click anywhere in the row you want to delete. Then 
click the Delete button.  

5. On the Time: Delete Posting for Contractor window, click the Yes button.  

6. To close the Contractor Post window, click the Close button.  

V. PRINT INVOICE 

A. To preview or print an Emergency Equipment – Use Invoice and/or Itemized Deductions 
(OF-286) report: 

1. Open the Time module. 

2. In the Resources grid, click the appropriate contracted resource.  

3. Click the Print Invoice button in the Time toolbar.  

4. On the OF-286 window, identify the following information:  

a. Click one of the following options under Select By: 

• Request Number - Enter the request number in the Request Number 
box. 

• Name - Enter the name in the Resource Name box. 

b. From the Last Date Include on Invoice drop-down list, select the 
appropriate Date.  

c. If the resource is being demobed, enter the appropriate release date and time 
in the Actual Release Date and Time boxes.  

d. To save the Actual Release Date/Time, click the Save Release Date/Time 
button.  

e. Under Print Options, click to select one of the following:  

• Preview/Print DRAFT Invoice - Generates a Draft Invoice. Review 
this invoice, before printing an Original copy. The word Draft prints on 
this invoice. 

• Preview/Print ORIGINAL Invoice - Generates an Original Invoice 
and locks all postings included in the invoice. When a posting is 
locked, you cannot make any changes to it. 

NOTE: If a resource has a supply item that is not consumable issued to them and an Original 
Invoice is printed, a notification message displays indicating that the resource has supplies 
issued to them. Click the OK button to continue printing the invoice. Click the Cancel button 
to abort the print process. 
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• Preview/Print DUPLICATE ORIGINAL Invoice - Generates a copy 
of an Original Invoice. A list of available invoices from which you can 
select displays when you click this option. 

NOTE: Once an Original Invoice is created, that Date Range for the Resource is Locked. 
You cannot edit the information when it is Locked. 

f. When generating a Draft Invoice, click to select one of the following 
Report Options:  

• OF 286 with Itemized Deductions  

• OF 286 Only  

• Itemized Deductions Only.  

NOTE: When you are printing an Original Invoice or a Duplicate Original Invoice, only 
the OF-286 with Itemized Deductions option is available. 

g. If this is the final invoice for the Resource, click to check the Final Invoice 
box.  

h. To preview and then print the report, click the Preview button. Then click 
the Print Report button on the Preview window. 

i. To print the report without previewing it, click the Print button. 

j. To delete the last invoice for the selected resource, click the Delete Last 
Invoice for Selected Resource button.  

NOTE: You can only make changes by deleting the Original invoice if the invoice was not 
submitted for payment. Once an original invoice is included in the Export, you will not be able 
to delete it. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.8 – Time: Working with Adjustments. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Post an adjustment.  

2. Edit an adjustment.  

3. Delete an adjustment.  
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I. ADJUSTMENTS 

A. Post an adjustment.  

B. Edit an adjustment.  

C. Delete an adjustment.  

NOTE: Working with Adjustments is very straightforward. Once you select a resource, enter 
the date, description of the item for which the adjustment is being made (e.g. Quarters and 
Lodging, Meals, Travel, etc.), and amount. 

NOTE: You can review the details of Adjustments on the OF 288 and OF 286. 

II. POST ADJUSTMENT 

NOTE: For the next exercises, you will use the Commissary/Fuel Issue to Post Adjustments 
to Resources. 

A. To post an adjustment: 

1. Open the Time module.  

2. Click the Adjustments button in the Time toolbar.  

3. In the Resources grid, click the resource for which you are creating the adjustment.  

4. From the Activity Date drop-down list, select the appropriate Activity Date.  

5. If the resource has an AD employment type, the Categories box displays on the Add 
Adjustments window. From the Categories drop-down list, select the category to 
which the adjustment applies.  

6. In the Commodity box, enter a description of the commodity (e.g. socks, boots, 
toiletries, etc.).  

NOTE: If you identify a Category, you do not have to define a Commodity. 

7. In the Amount box, type the purchase amount for the commodities. Use the format 
99.99.  

8. To save the adjustment, click the Save button.  

III. EDIT ADJUSTMENT 

A. To edit an adjustment: 

NOTE: Once an Original Invoice prints, you cannot edit the Adjustment. 

1. Open the Time module.  

2. Click the Adjustments button in the Time toolbar.  

3. In the Resources grid, click the appropriate resource.  

4. On the Adjustments window, click to select the row you want to edit. Then click the 
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Edit button.  

5. Edit the adjustment information, as needed.  

6. To save your changes, click the Save button.  

B. To delete an adjustment.  

NOTE: Once an Original Invoice prints, you cannot delete the adjustment. 

1. Open the Time module.  

2. Click the Adjustments button in the Time toolbar.  

3. In the Resources grid, click the appropriate resource.  

4. On the Adjustments window, click to select the row you want to delete. Then click 
the Delete button.  

5. To save your changes, click the Save button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.9 – Time: Time Reports. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Run and print standard Time reports.  

2. Print/Fax a Personnel Time Report.  
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I. TIME REPORTS 

A. Print standard Time reports.  

B. Print/Fax a Personnel Time Report.  

II. STANDARD REPORTS 

A. To print standard Time reports: 

NOTE: I-Suite has a number of features that allow you to print Standard Reports.  

1. Click the Reports button in the toolbar. Then click the Time button on the Reports 
window.  
 
OR  
 
From the Reports drop-down menu, select Time Reports.  

2. Click to select one of the following reports:  

a. Work/Rest Ratio - This report identifies the ratio between work and rest for 
a resource at the incident.  

NOTE: When calculating hours on shift, the system excludes time postings with a Special 
Code of GUAR, COP and Day Off from the Work/Rest Ratio report. 

To generate a Work/Rest Ration report, complete the following Report Settings: 

• Under Sort by, click to select the sort to use for the report.  

• Select one of the following options: 

o Select a Specific or Partial Request Number - Then select the 
number from the Request Number drop-down list. 

o Select a Specific Person - Then select the name from the Person 
drop-down list. 

o Select all Personnel - No other options are defined. 

• Enter the appropriate Start Date and End Date. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

b. Summary of Hours for Personnel - This report contains a summary of the 
hours worked for All Personnel or a Specific Individual.  

To generate a Summary of Hours for Personnel report, complete the following 
Report Settings: 

• Click the Select a Specific Person option. Then select the person from 
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the Select Person drop-down list. 
 
OR 
 
Click the Select All Personnel option. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

c. Payment Summary of Equipment Usage - This report identifies the total 
amount that was paid for the use of a specific equipment resource.  

To generate a Payment Summary of Equipment Usage report, complete the 
following Report Settings: 

• From the Contractor drop-down list, select the appropriate 
Contractor. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

d. Shifts in Excess of Standard Hours - This report identifies the work shifts 
that went over the standard hours. 

To generate a Shifts in Excess of Standard Hours report, complete the following 
Report Settings: 

• Under Sort by, click to select the sort to use in the report.  

• Select one of the following options: 

o Select Specific or Partial Request Number - Then select the 
number from the Request Number drop-down list. 

o Select a Specific Person - Then select the name from the Person 
drop-down list. 

o Select All Personnel - No other options are defined. 

• Enter the appropriate Start Date and End Date. 

• In the Standard Hours box, enter the standard hours to use in 
calculating the excess hours (e.g. if you enter 8, the report will include 
employees with hours in excess of 8). 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

e. OF 288 - This report is the standard timekeeping record and payment 
document for federal and casual (AD) personnel involved in the fire fighting 
incident.  

NOTE: An OF 288 includes all incidents and all accounting codes for the selected Request 
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Number, Crew Name, Person, or All Personnel. 

NOTE: The OF 288 and OF 286 only include Time for the selected incident. To include Time 
for all incidents, switch to Manage All Incidents As One. 

To generate an Emergency FireFighter Time Report (OF 288) report, click the 
OF-288 option. Then complete the appropriate Report Settings.(For additional 
instructions, refer to “Preview/print an Emergency FireFighter Time Report (OF 
288) report” in the “Posting Personnel Time” section). 

f. OF 286 and/or Itemized Deductions - This report is the standard invoice 
for emergency equipment used at an incident.  

To generate an Emergency Equipment Invoice and/or Itemized Deductions (OF 
286) report, click the OF-286 and/or Itemized Deductions option. Then 
complete the appropriate Report Settings. (For additional instructions, refer to 
“Preview/print an Emergency Equipment – Use Invoice and/or Itemized 
Deductions (OF 286) report” in the “Posting Contract Resource Time” section).

g. Contractor Debits - This report identifies debit amounts for a selected 
contractor.  

To generate a Contractor Debits report, complete the following Report Settings:

• From the Contractor drop-down list, select the appropriate 
Contractor. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

h. Commissary Authorization - This is the standard form that firefighters 
must have to receive their pay or purchase any items from the Commissary. 
This form includes the person's name, social security number, and 
employment information.  

To generate an Emergency FireFighter Commissary Authorization report, 
complete the following Report Settings: 

• Select one of the following options: 

o Select a Specific Request Number - Then select the number from 
the Request Number drop-down list. 

o Select a Specific Crew - Then select the crew from the Crew 
Name drop-down list. 

o Select a Specific Person - Then select the name from the Person 
drop-down list. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 
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i. Equipment Management - This report identifies the equipment being used 
at the incident.  

To generate an Equipment Management report:  

• Click to select Equipment Management.  

• To print the report, click the Print button. To preview the report, 
click the Preview button. 

j. Crew Roster - The Crew Roster contains a list of all members assigned to 
the crew selected on the Select Report window.  

To generate a Crew Roster report, complete the following Report Settings: 

• From the Request Number drop-down list, select the appropriate 
Request Number.  
 
OR 
 
From the Crew Name drop-down list, select the appropriate Crew. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

k. Commissary Charges by Date - This report identifies resources that have 
made charges to the Commissary.  

To generate a Commissary Charges by Date report:  

• Click to select Commissary Charges by Date.  

• To print the report, click the Print button. To preview the report, 
click the Preview button.  

l. Personnel Time Report (Print / Fax) - This report identifies posted time 
for FED or OTHER personnel. Only those personnel that meet the following 
requirements are included in the report:  

• Time Posted  

• Assigned fax number  

• Employment code of FED or OTHER  

• An employment status that is NOT D (Demobilized)  

To generate a Personnel Time Report, complete the following Report Settings: 

NOTE: For the people you want to include on the report, select a range of dates (Start Date 
and End Date) that includes the days for which Time was posted. 
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• From the Start Date drop-down list, select the appropriate Start Date.

• From the End Date drop-down list, select the appropriate End Date. 

NOTE: When you select the date range, resources that meet the defined criteria display in the 
Select Admin Offices box on the left side of the window. If there are no entries in the box, 
then one or more of the criteria items was not met for the selected range of dates. 

• In the Time Unit Leader’s Name box, enter the Time Unit Leader’s 
Name. 

• In the Time Unit Leader’s Phone # box, enter the Time Unit 
Leader’s Phone #.  

• If the fax numbers are long distance, click to check the Assume calls 
are long distance option. 

• If a number must be dialed before placing a phone call (e.g., you have 
to dial 9 to get an outside line), click to check the Dial outside line 
checkbox. Then enter the number you must dial for the outside line. 

NOTE: The agencies and payment offices that display in the box on the left side of the 
window can be expanded by clicking the Plus Sign (+) or collapsed by clicking the Minus 
Sign (-) next to the corresponding item. 

• Under Select Admin Office(s) for Payment, click to check the 
checkbox next to each office you want to include in the report. 

NOTE: When you select an agency, all offices from that agency are selected in the tree. You 
can select individual offices within an agency. However, you cannot select individual people 
in the tree. Selecting an individual person selects all people assigned to the same Fax number 
and includes them on the report. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

NOTE: A new page is generated for each Fax number included on the report. 

• To fax a Personnel Time Report directly from I-Suite, click the Fax 
button.  

NOTE: Requirements for faxing a Personnel Time Report are:  

• A Fax Modem that is properly installed and correctly configured. 

• A Fax Printer Device properly set-up in the Printers folder. 

To fax a Personnel Time Report directly from I-Suite, click the Fax Report 
button. 
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NOTE: A message displays instructing you to set your Fax Printer as the Default Printer. 
DO NOT click OK until the Fax Printer is set as the Default Printer.  

Follow the on-screen prompts for faxing the report.  

• After the Personnel Time Report has been faxed a dialogue will be 
displayed to print the Personnel Fax Report Summary. 

m. Missing Days of Postings - The Missing Days of Postings report identifies 
those resources with missing posted time. 

To generate a Missing Days of Posting Report, complete the following Report 
Settings: 

• Select one of the following options: 

o Request Number - Then select the number from the Request 
Number drop-down list 

o Name - Then select the name from the Name drop-down list. 

o All - Then click either Non- Contract Only (OF-288) or 
Contract Only (OF-286). 

• Select one of the following Sort By options: 

o Request # 

o Name 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 

n. List last posting Date by Resource - This report lists the last posting date 
by resource name.  

To generate a Last Posting Date by Resource List, complete the following 
Report Settings: 

• Select one of the following options to identify the resources to include 
in the report: 

o All Resources 

o OF286 Resources 

o OF288 Resources 

• Click the Sort to use in the report. Then click the > button to add the 
sort to the Sort By box. Repeat this step for each sort you want to 
include. 

• To print the report, click the Print button. To preview the report, click 
the Preview button. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 7.10 – Time: Advanced Contracting (Optional). 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Add complex contract information.  

2. Post time for contracted resources with 
complex contracts.  
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I. ADVANCED CONTRACTOR 

A. Identify existing contractors 

B. Add complex contract information.  

C. Attach agreement to contractor 

D. Link a contractor and agreement to a resource and rate. 

E. Identify key points for working with rate types and UOM 

F. Post time for contracted resources with complex contracts.  

II. COMPLEX CONTRACTS 

NOTE: This section identifies how to work with complex contracts for resources, such as 
contract crews and engines, portable toilets, and resources with multiple rates based on 
duration. 

NOTE: Review contracts and shift tickets to add contractor data and to post time to 
contracted resources. 

A. To identify existing contractors: 

1. Open the Time module. 

2. From the Time drop-down menu, select Contractors. 

3. To view all contractors with agreements, click the Contractors with Agreements 
option. When you select this option, the grid at the bottom of the window displays a 
list of all contractors with agreements. 

4. To view all contractors with resources, click the Contractors with Resources option. 
When you select this option, the grid at the bottom of the window displays a list of 
all contractors with resources. 

B. To add a new contractor:  

1. Open the Time module.  

2. From the Time drop-down menu, select Contractors. 

3. Click the Add button in the Main toolbar at the top of the window. 

4. Complete the following information: 

a. Name (Required) 

b. TIN (Required) 

c. DUNS 

d. Address 

e. City 

f. State 
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g. Zip 

h. Phone 

5. Click the Save button to save the record. Then click the Close button to close the Add 
Contractor area at the bottom of the window. 

C. To create an agreement and attach it to a contractor: 

1. On the Contractor window, click the appropriate contractor in the grid.  

2. Click the Add Agreement button. 

3. Complete the following information: 

a. Agreement Number 

b. Begin Date 

c. Expiration Date 

d. Point of Hire 

e. Administrative Office for Payment 

4. Click the Save button. To close the Add Agreement area at the bottom of the 
window, click the Close button. 

5. Click the Close Contracts button to close the Contractor window. 

D. To link a contractor and agreement to resources and rates: 

1. In the Resources grid, click the appropriate resource. 

2. On the Time-Contracted tab, select the appropriate contractor from the Contractor 
Name drop-down list. 

3. From the Agreement Number drop-down list, select the appropriate agreement 
number. 

4. Complete the following fields on the Time-Contracted tab: 

a. Unique Name 

b. Description 1 & 2 

c. 288 Remarks 

d. Hired Date & Time 

e. If appropriate, click to check the Gov't Operator and Gov't Supplies 
checkboxes. 

f. If appropriate, click to check with the Withdrawn checkbox. 

g. From the Rate Type drop-down list, select the appropriate rate type. 

h. From the UOM drop-down list, select the appropriate unit of measure. 

i. In the Rate$ field, type the appropriate rate amount. 

j. Click the Save Rate button to save the rate 
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5. Click the Save button on the Time - Contracted tab. 

NOTE: Make sure you add all primary rates and special rates for mileage. 

E. Key points for working with rate types and Units of Measure (UOM): 

1. All contracted resources must have a primary rate designation. 

2. A contracted resource may or may not have one to five special rate designations. 

3. Units of Measure include Daily, Each, Hourly, and Mileage. 

4. Make sure you match the correct rate type with the correct UOM. 

F. Post time for contracted resources with complex contracts.  

1. Open the Time module.  

2. Click the Post Time button to open the Posting area at the bottom of the window.  

3. In the Resources grid, click the contracted resource. 

4. On the Contractor Post tab, select the appropriate account code from the Account 
Code drop-down list. 

5. Under Post Options, click to select the appropriate Rate Type. 

6. If one-half rate applies, click to check the 1/2 Rate checkbox. 

7. Post the appropriate information for that Rate Type and Unit of Measure. 

8. Click the Save button to commit the posting. 

9. Click the Close button to close the posting area at the bottom of the window. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.0 – Cost: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the purpose of the Cost module. 

2. Explain Data Ownership and the 
importance of Standard Operating 
Procedures.  

3. Identify the basic features of the Cost 
screen.  
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I. COST 

A. Identify the purpose of the Cost module.  

1. Use the Cost module to track individual resources. The system creates a line for every 
resource for every day. The Cost user can then analyze, manipulate, and create 
outputs of this information in a variety of report formats. 

NOTE: Also use the Cost module to report costs for management decision making purposes. 
Reporting recipients include the Incident Team, the Team Management, the Host Agency, and 
the USFS Financial System.  

B. Review the concept of Data Ownership and why Standard Operating Procedures are 
important.  

1. Data ownership provides authority to various I-Suite users which allows them to 
change and manage specific data elements. This authority is established as a 
safeguard to ensure data integrity for all I-Suite users.  

2. Standard Operating Procedures imply that users in each section of I-Suite 
communicate effectively with other users, which helps to identify those individuals 
who have "authority" for certain data elements (e.g. Resources typically has 
authority to change the resource status; a Time Recorder typically has authority to 
change or update a pay rate or an accounting code).  

C. Identify the basic features of the Cost screen. 

1. The Cost toolbar is located to the right of the Filter toolbar. The buttons in this tool 
bar include: 

a. Show Costs - Click this button to display the Manage Cost grid at the 
bottom of the window. This grid contains a list of Daily Costs for a selected 
resource.  

b. Archive Resources - Click this button to archive certain resources in the 
Resources grid. Any resources that are archived will not be included in any 
Cost Processes that are run. 

c. Sum - When this option is checked, the total cost displays for the selected 
resource, as well as any rollup costs. The Total amount displays in the box 
to the right of the Sum option. The Rollup amount displays in the box to the 
right of the Flow Down option. 

NOTE: The rollup costs include the cost of the parent and any subordinates. 

c. Flow Down - When this option is checked, the flow-down feature for the 
Manage Cost grid occurs. Flow-down allows you to change the Quantity, 
Unit Cost, Units, Rate Type or Division in the Manage Cost grid. When 
that information changes, the application changes (flows-down) the 
information in all of the Daily records below it that are not locked.  

d. Rate Area - To use a rate area other than the Default Standard rate area, 
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select it from the Rate Area drop-down list.  

e. Resources Selected in Grid - When this option is checked, only those 
resources selected in the Resources grid are included in any Cost Processes 
that are run. 

f. Cost Processes - Select a process from this drop-down list and click the Run 
button to run that process. 

g. Run - Click this button after you have selected a Cost Process to run that 
process. 

2. The Cost drop-down menu at the top of the window contains the following Cost 
options: 

a. Acres Burned - Select this option to define acres burned information. 

b. Cost Analysis Benchmark Setup - Select this option to setup the data to use 
in the Cost Analysis Report you can print on the Cost Report window.  

c. Divisions - Select this option to define a division for Cost Apportionment 
purposes. 

d. Graphs - Select this option to create standard or custom Cost Graphs. 

e. Accruals - Select this option to create an Accrual Extract. 

f. Projections - Select this option to create Cost Projections. 

g. Rates - Select this option to define Rate Areas and Rates. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.1 – Cost: Options. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Select grid columns and set the column 
order.  

2. Change the system date.  
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I. COST OPTIONS 

A. Select grid columns and set the column order.  

B. Change the system date.  

II. RESOURCES GRID 

A. To identify the columns to display in the grid and the order in which to display them:  

1. From the Tools drop-down menu, select Options.  

2. On the Options window, click the Cost tab.  

3. Under Resource Grid Columns, click the column you want to display or remove. 
Then click the Show or Hide button to identify whether to show or hide the selected 
column.  

4. To move a column in the grid, click the column under Resource Grid Columns. Then 
click the Move Up or Move Down button to adjust the order in which the column 
displays. 

5. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window.  

NOTE: Grid columns can be sorted by clicking a column heading. 

III. SYSTEM DATE 

A. To change the system date: 

NOTE: Make sure the date and time are properly set for any PC running Cost. Set the System 
Date to allow for four to five days of data (At least five days after the Incident Start Date). If 
this unit is taught as part of the full course, you do not need to change the date and time again. 
It should have been set prior to any data entry. 

1. On the Windows Quick Launch toolbar, right-click Date/Time. In the menu that 
displays, click Adjust Date/Time. The Date and Time Properties window opens.  

2. Under Date, click to select the appropriate Date.  

3. Under Time, enter the appropriate time.  

4. To save your changes, click Apply and then OK.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.2 – Cost: Cost Processes. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Run Cost Processes.  

2. Create Cost Only. 

3. Update with Actuals Only. 

4. Create Cost & Update with Actuals.  

5. Create Cost, Update Actuals & Re-
estimate 

6. Re-estimate 

7. Lock or Unlock a Daily Cost Entry. 

8. Exclude Resources from Cost Processes 
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I. COST PROCESSES 

A. Run Cost Processes 

B. Create Cost Only 

C. Update With Actuals Only 

D. Create Cost & Update With Actuals 

E. Create Cost, Update Actuals, & Re-estimate 

F. Re-estimate  

G. Lock or Unlock Daily Cost Entries 

H. Exclude Resources from Cost Processes 

II. REVIEW PROCESSES 

NOTE: The following are key concepts to understanding the Cost Processes:  

• Each action is a separate process.  

• Each process draws from distinct data in the Database.  

• The processes do not overlap.  

A. Review the Cost processes that you can perform.  

1. Create Cost, Update With Actuals & Re-estimate - Creates estimated Daily Cost 
data from the Rates lookup table. Updates the data with any Actual Costs. Then re-
estimates the cost for any existing Daily Cost records. 

2. Create Cost & Update With Actuals – Creates estimated Daily Cost data from the 
Rates lookup table and updates the data with any Actual Costs. 

3. Create Cost Only – Creates estimated Daily Cost data from the Rates lookup table.  

4. Re-estimate - Re-estimates the cost in Estimated or Actual cost records with a zero 
(0.00) cost amount. For each of these records, the application recalculates the Rate 
Type Code, Unit, Quantity, and Unit Cost. It then compares the recalculated values 
with the previous values. If there is a difference, the record is updated with the new 
values and the Cost Update Level is set to Estimate.  

5. Update With Actuals Only - Updates Daily Cost with Actual Cost data. 

6. Cost Lock/Unlock – Locks (or unlocks) all cost records from the selected date 
forward.  

III. CREATE/UPDATE DAILY COSTS 

NOTE: Creating and Updating the Daily Costs is the first step that a Cost User must perform 
and should be completed before entering any data.  

A. To Create Cost Create Costs, Update with Actuals, or Re-Estimate Costs:  
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1. Open the Cost module.  

2. From the Cost Processes drop-down list, select one of the following:  

a. Create Cost, Update Actuals, and Re-estimate 

b. Create Cost & Update with Actuals 

c. Create Cost Only 

d. Re-estimate 

e. Update With Actuals Only  

3. Click the Run button.  

NOTE: If you want to run a Create, Update, or Re-estimate process for only certain 
resources in the grid, click to check the Select Resources in Grid checkbox. Then click each 
of the resources in the grid that you want to include in the process. When you select a Cost 
Process and the Run button, the process is only run for those resources selected in the grid.  

NOTE: If the Select Resources in Grid checkbox is NOT checked, the process is run for all 
resources that are Checked In with Generate Daily Costs selected on the Cost tab in 
Resources. 

B. To Lock or Unlock Cost:  

NOTE: This feature locks or unlocks all of the entries in the database for the defined dates. 
To preserve hand-keyed items for individual resources, use the Lock feature on the Daily 
Records screen.  

1. Open the Cost module.  

2. From the Cost Processes drop-down list, select Cost Lock/Unlock. Then click the 
Run button.  

3. On the Daily Cost Lock/Unlock window, enter the appropriate Start Date and End 
Date. You can either type the dates or select them from the drop-down calendar. 

4. Click the Lock or Unlock button, as appropriate.  

5. To close the Daily Cost Lock/Unlock window, click the Close button.  

6. When the message window displays, click the OK button to close the window.  

IV. Exclude Resources from Cost Processes 

NOTE: The Archive feature in I-Suite allows you to exclude Resources from any of the Cost 
Processes that you run. 

A. Archive Resources Selected in the Grid 

1. Open the Cost module. 

2. Select the resources in the Resource grid that you want to exclude from the Cost 
Processes. 
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3. Click the Archive button. 

4. Click to check the Set archive flag for all resources currently selected in the grid 
option. 

5. Click the Set Archive button. 

NOTE: To ensure that the Resources were archived, add the Archived column to your 
Resource grid. A checkmark displays in this column for each of the resources that were 
archived. 

NOTE: If a resource was archived that you want to include in the Cost Processes, click the 
Unset Archive button instead of the Set Archive button. 

  

B. Archive Resources with Release Date  

NOTE: This process will archive all resources with Actual Release Dates prior to the current 
date. To ensure that this process works correctly, you must enter Actual Release Dates that 
are prior to the current date for all resources you want to archive. 

1. Open the Cost module. 

2. Click the Archive button. 

3. Click to check the Set archive flag for all resources with a release date prior to 
today option. 

4. Click the Set Archive button. 

  
C. Archive Resources with Estimated Date of Arrival 

NOTE: This process will archive all resources with Estimated Dates of Arrival that are prior 
to the current date. To ensure that this process works correctly, you must enter Estimated 
Dates of Arrival that are prior to the current date for all resources you want to archive. 

1. Open the Cost module. 

2. Click the Archive button. 

3. Click to check the Set archive flag for all resources with an estimated date of 
arrival prior to today option. 

4. Click the Set Archive button. 

REVIEW UNIT OBJECTIVES 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.3 – Cost: Rates. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. View the default rates used to calculate 
costs for specific resources.  

2. Create a new rate area.  

3. Add rates to a rate area other than the 
“Default Standard” rate area.  
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I. COST RATES 

NOTE: Standard rates for resources such as crews, engines, overhead, fallers, pickups, and 
fuel tenders are included in the Cost module. The main function of the Rates option is to 
determine a default rate for a Kind of resource. You can define numerous types of rates for a 
number of different Kinds of resources.  

A. View the default rates used to calculate costs for specific resources.  

B. Create a new rate area.  

C. Add rates to a rate area other than the “Default Standard” rate area.  

II. DEFAULT RATES 

A. To view the default rates used to calculate costs for specific resources:  

1. From the Modules drop-down menu, select Cost.  
 
OR  
 
On the Tool bar, click the Cost button.  

2. From the Cost drop-down menu, select Rates.  

3. On the Rate Area / Rates window, click the Rates tab. 

4. From the Rate Areas drop-down list, select the appropriate Rate Area. Then click 
one of the following to identify the Kind codes to display under Kind:  

a. All Kinds  

b. With Values Only.  

5. Under Kinds, click to select the Kind with the rates you want to review. 

6. Under Rates, review the rates defined for the selected Kind.  

7. To close the Rate Area / Rates window, click the Close button.  

III. RATE AREA 

A. To create a new rate area: 

1. Open the Cost module.  

2. From the Cost drop-down menu, select Rates.  

3. On the Rate Area / Rates window, click the Rate Area tab. Then click the Add 
button.  

4. In the Area Name box, enter the name to assign to the Rate Area. 

5. If you want the rate area to be viewable on the main Cost window, click to check the 
Viewable checkbox. When the rate area is available on the Cost window, it can be 
used in the Create Cost process.  
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6. To save the new rate area, click the Save button.  

7. To close the Rate Area / Rates window, click the Close button.  

IV. RATES 

NOTE: Only add Rates to Kind Codes that require a rate different from the Default Standard
Rate. The application will use the rate from the Default Standard Rate Area for Kind Codes 
without a defined rate.  

A. To add rates to a rate area other than the Default Standard rate area: 

1. Open the Cost module.  

2. From the Cost drop-down menu, select Rates.  

3. On the Rate Area / Rates window, click the Rates tab. 

4. From the Rate Areas drop down list, select the Rate Area to which you want to add 
rates. Then click one of the following to identify the Kind codes to display under 
Kind:  

a. All Kinds  

b. With Values Only.  

5. Under Kinds, click to select the Kind for which you want to define rates.  

6. In the Rates grid, type the rates you want to assign to the kind code in the appropriate 
boxes.  

7. Click the Save button to save the rates to the selected rate area.  

8. When the Data Saved window displays, click the OK button to close the window.  

9. Click the Close button to close the Rate Area/Rates window. 

NOTE: To use a Rate Area other than the Default Standard Rate Area, select the 
appropriate Rate Area from the Rate Area drop-down list on the Cost window.  

REVIEW UNIT OBJECTIVES 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.4 – Cost: Resources. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Add resource data from the Cost module. 

2. Edit resource data from the Cost module. 

3. Identify common data.  

4. Identify Cost data.  
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I. COST RESOURCE 

A. Add resource data from Cost.  

B. Edit resource data from Cost.  

C. Explain common data.  

D. Explain Cost data.  

II. RESOURCE DATA 

A. Add resource data from the Cost module.  

1. Open the Cost module.  

2. Click the Add button in the toolbar.  

3. In the Manage Resource – Add Mode area, enter the following required information:

a. Request Number 

b. Account Number 

c. Resource Name/Last Name First Name 

d. Kind/Position 

e. Status 

f. Configuration 

4. Click the Save button to save the information.  

B. To edit resource data from the Cost module: 

1. Open the Cost module.  

2. In the Resources grid, click the appropriate resource. 

3. Click the Edit button in the toolbar.  

4. In the Manage Resource – Edit Mode area, edit the appropriate information. Click 
the Save button to save your changes.  

C. Review common data.  

1. Open the Cost module.  

2. In the Resources grid, click the appropriate resource. 

3. Click the Edit button in the toolbar.  

NOTE: Entry items located above the tabs (i.e. just below the Manage Resource-Edit Mode 
label) are common to all I-Suite modules.  

NOTE: Data entry items for specific modules are located on their respective tabs (i.e. on the 
Plans, Cost, and Time tabs.)  

NOTE: Resources is the primary data entry point for I-Suite data. The quality of the initial 
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data is critical to the successful integration of the data into other I-Suite modules.  

a. Make sure each member is identified with the correct Kind Code (i.e. FFT1, 
CRWB, etc.). 

NOTE: It is critical that Kind Codes are correct for Subordinate Resources (e.g. If the Kind 
Code HC1 is used for 20 members of a Type 1 crew, the Cost module will calculate 20 HC1 
estates at $8,200 for each member into a rollup cost of $164,000.) 

b. Leave the Agency Code blank for Subordinates of Contract Resources 
that do not incur a separate cost (e.g. Contract Dozer Operators). 

NOTE: Understanding the concept of Data Sharing is critical. Data is shared between all I-
Suite modules. Changes, additions, or deletions from any functional area affects the other I-
Suite modules. Successful integration requires cooperation and established Data Ownership 
Rules.  

Example: Cost should only delete those resources entered by the Cost unit. 

III. COST DATA 

A. To add Cost data: 

1. Open the Cost module.  

2. In the Resources grid, click the resource to which you want to add Cost data. 

NOTE: Cost data can be added to rostered resources, as well as non-rostered resources.  

3. Click the Edit button to open the Manage Resource - Edit Mode area at the bottom 
of the window. 

4. Click the Cost tab, then enter the following information: 

a. Select an agency from the Payment Agency drop-down list.  

NOTE: The Payment Agency is the agency responsible for payment of the resource. Data 
entered in this field is also used to determine the accrual code. 

NOTE: When adding Cost data to a rostered resource, you cannot select the Payment Agency. 
This defaults to the agency selected for the parent resource. 

NOTE: Make sure you always select a Payment Agency in Cost Apportionment situations. 

b. In the Assign Date box, enter an assign date.The Assign Date is the date 
when the resource begins receiving payment and is the same as the Hire 
Date for Contract Resources in the Time module. You can either type the 
date or select it from the drop-down calendar. 

c. Select the appropriate Accrual Code from the drop-down list. This code 
may automatically be selected based on the Request Number, Agency, 
Kind Code, Incident State, Contracting Agency, and Employment Type 
(AD or Other) that is defined. 
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NOTE: The system default for the accrual code should be used in most cases. Only make a 
manual correction if you know the default is incorrect. For example, if you want the accrual 
code to be excluded from cost accruals, select EXCL (Exclude). 

d. To prevent the Cost Accrual Code from being changed for a resource, click 
to check the Lock Accrual Code checkbox. 

e. In the Cost Remarks box, you can enter any remarks related to the cost 
information. 

f. Click to check the Generate Daily Costs checkbox if you want costs 
generated for a resource.  

NOTE: The Daily record is only created if the Generate Daily Costs checkbox is checked for 
the Checked-In parent resource. If the Generate Daily Costs checkbox is not checked for the 
Parent Crew Record, the Create Daily Record function is turned OFF for ALL of the Crew 
Members. To turn Create Daily ON, check the Generate Daily Costs checkbox.  
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STUDENT MANUAL 
  
COURSE: I Suite 

  
UNIT: 8.5 – Cost: Daily Records. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Utilize the Manage Cost grid.  

2. Define three different cost levels.  

3. Use the Flow Down and Lock/Unlock 
processes.  

4. Enter a Release Date and identify the 
impact.  

5. Enter Daily data for resources.  
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I. DAILY COST RECORDS 

A. Utilize the Manage Cost grid.  

B. Review Cost Level data.  

C. Use the Flow Down and Lock/Unlock processes.  

D. Enter a release date for a resource.  

E. Enter Daily data resources.  

NOTE: You must run the Create Cost process before you can enter costs. 

II. MANAGE COST GRID 

NOTE: Displaying the Manage Cost grid gives you a direct visual link to the relationship 
between Resource records and Daily records.  

A. To display the Manage Cost grid: 

1. Open the Cost module.  

2. Click the Show Cost button in the Cost toolbar. 

3. In the Resources grid, click a resource.  

NOTE: Every Resource record listed in the Resources grid has associated records that 
include the Costs of that Resource for every day the Resource is assigned to the incident. 
These records display in the Manage Cost grid, which displays at the bottom of the window 
when you click the Show Cost button.  

NOTE: Cost provides a number of ways in which to add, update, and display the Detail Cost 
Data in the Daily Records associated with each Resource. 

NOTE: The Daily Record is only created if the Generate Daily Costs checkbox is checked 
for the Checked-In parent resource. 

NOTE: The Cost module uses either the Check-In Date or the Assign Date, whichever is 
earlier, to generate costs. 

NOTE: The Cost module uses the Actual Release's Estimated Date of Arrival defined in 
Demob to identify when to stop generating Daily Cost records for a resource. If the Estimated 
Date of Arrival is not defined for a resource, the application uses the Actual Release Date. 

B. Review Cost Level data.  

1. The CL (Cost Level) column identifies the source of cost data. There are three types 
of cost level data:  

a. E (Estimate).  

b. A (Actual). 
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c. U (User-updated or flow down from Actual).  

NOTE: When the cost data in a Daily Cost record is updated by Actual data from Time, any 
Daily Cost records created after the updated date contain a U Cost Level. This indicates that 
the amount in the Daily Cost record was not estimated, but flowed down from the Actual cost 
data record. 

2. E (Estimate). Cost level data is estimated from the rates lookup table. 

a. Select a resource that has no actual time posted. 

b. Click the Show Cost button to display the Manage Cost grid. 

c. Notice that the posted time in the Manage Cost grid displays as Estimate 
(E) under the CL column. 

3. A (Actual). Cost level data is from Time records. You must specify a resource for 
posting time.  

a. In Time, post time for the selected resource.  

b. In Cost, select the Update with Actuals option from the Cost Processes 
drop-down list. Then click the Run button. 

c. Click the Show Cost button to display the Manage Cost grid. 

d. Click the resource for which you just posted Time in the Resources grid. 
Notice that the posted time in the Manage Cost grid displays as Actual 
Time (A) under the CL column.  

4. U (User-updated or flow down from Actual). Cost level data is determined by the Cost 
unit.  

a. Click the Show Cost button to open the Manage Cost grid. 

b. In the Resources grid, click the resource you want to update. 

c. In the Manage Cost grid, click the Daily Cost record you want to update. 

d. Make the appropriate changes to the Unit or Unit Cost. 

e. Click the Save button. 

f. Notice that the entry under the CL column has changed to User Updated 
(U). 

C. To use the Flow Down and Lock Record options:  

1. Open the Cost module  

2. In the Resources grid, click a resource.  

3. Click to check the Flow Down checkbox in the Cost toolbar at the top of the window. 

4. If the Manage Cost grid is not open, click the Show Cost button to open it. 

5. Modify the Unit Cost. Then click the Save button.  

NOTE: The Flow Down changes the Unit Cost for all entries from the selected date forward. 
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6. To lock an entry in the Manage Cost grid, click the entry to select it. Then click the 
Locked option that displays in the area just above the Manage Cost grid. 

7. Modify the Unit Cost. Then click the Save button. 

NOTE: The Flow Down changes the Unit Costfor all entries from the selected date forward, 
except for the Locked records.  

NOTE: The Lock feature is a valuable feature for Cost to preserve hand-keyed data entries. 

NOTE: Use the Flow Down option with caution. 

D. To enter a release date for a resource: 

NOTE: Designating an Actual Release Date stops Cost from generating Daily Cost records 
for a given resource. A Demobed Resource continues to generate costs until an Actual 
Release Date is entered. 

1. In the Resources grid, select the resource to which you want to assign a release date. 
Then click the Edit button.  

2. In the Manage Resource area, type the Actual Release Date in the Actual Release 
Date text box.  

3. Click the Save button. 

NOTE: Determine the last date of Actual Time for that resource, and then enter that last date 
as the Actual Release Date.  

NOTE: Coordinate with the TIME unit to determine the actual release dates. 

NOTE: Open the Manage Cost grid in the Cost module. Notice that Daily Records for the 
edited resource no longer display beyond the Release Date.  

E. To edit Daily Cost data for a Resource: 

1. In the Resources grid, click a resource. 

2. Click the Show Cost button.  

3. In the Manage Cost grid, click the entry you want to edit. 

4. In the area above the Manage Cost grid, enter the appropriate Daily Cost information 
for the selected resource.  

5. To save your entries, click the Save button.  

F. To delete a Daily Cost record for a Resource: 

1. Select one or more cost records in the Manage Cost grid. 

2. Click the Delete button. 

3. A confirmation message will display. 

4. Click Yes to continue.  
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NOTE: Deleted Daily Cost records will re-generate with estimates or actual costs, when the 
cost process is run. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.6 – Cost: Cost Reports. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Run and print standard Cost reports.  

2. Run and print other standard Cost 
reports.  

3. Export Cost reports data.  
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I. COST REPORTS 

A. Run and print standard Cost reports.  

B. Run and print other standard Cost reports.  

C. Export Cost reports data.  

II. PRINT STANDARD REPORTS 

A. To print a standard Cost report: 

NOTE: You can print a number of pre-designed Cost reports for management decision 
making purposes. You can select a general format, determine the Sort and Filter criteria, and 
then Preview, Print or Export the data.  

1. Open the Cost module.  

2. Click the Reports button in the Cost toolbar to open the Cost Reports window.  
 
OR  
 
From the Reports drop-down menu, select Cost Reports.  

3. Under Report Categories, click Sort Categories. In the area beneath Report 
Categories, click to select one of the following reports:  

a. Accounting  

b. Agency  

c. Payment Agency  

d. Division  

e. Home Unit  

f. Incident  

g. Accrual  

h. Section  

NOTE: For this exercise, select the Incident Sort Category. 

4. Click to check the Selected Date Range checkbox.  

NOTE: If you do not check the Selected Date Range checkbox. The report defaults to the 
entire date range.  

5. In the Date Range boxes, enter the appropriate beginning and ending dates. You can 
either type the dates or select them from the drop-down calendars. 

6. Under Reports, click to select the Report you want to print:  

NOTE: The information in the report is based on the category you selected under Report 
Categories. This also includes the Underutilized report category that displays when you 
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select Other Categories. 

a. Weekly Summary - This report contains a summary of the costs for each 
day of the defined week. The cost information is broken down by Kind 
Group and Direct/Indirect. A Daily Total is included at the bottom of 
each date column.  

b. Weekly Detail - This report contains detailed cost information for each day 
of the defined week. The cost information is broken down by Kind Code 
and Direct/Indirect. A Daily Total is included at the bottom of each date 
column.  

c. Weekly Detail O/H Personnel - This report contains detailed overhead 
personnel cost information for each day of the defined week. The cost 
information is broken down by Personnel Resource, Kind Code, and 
Direct/Indirect. A Daily Total is included at the bottom of each date 
column.  

d. Daily Summary - This report contains a summary of the costs for the 
current system date. The information is broken down by Crews, Line 
Personnel, and Camp Personnel.  

e. Cumulative Cost Detail - This report identifies the Daily Cost for each day 
the incident has been open. The information is broken down by 
Resource/Kind Codes.  

f. Cumulative Cost Detail O/H Personnel - This report identifies the Daily 
Cost for each day the incident has been open. The information is broken 
down by the Kind Code and then the Personnel Resource.  

g. Category Total - This report identifies cost totals based on the Category.  

NOTE: The name of the Category Total report changes, based on the Report you are 
printing. For example, for an Incident report, this would be Incident Category Total.  

h. People Weekly Summary - This report contains a summary of the people 
working on the incident for each day of the defined week. The information 
is broken down by Kind Code and Direct/Indirect. A Daily Total is 
included at the bottom of each date column.  

i. People Daily Summary - This report contains a summary of the people 
working on the incident for the current system date. The information is 
broken down by Crews, Line Personnel, and Camp Personnel.  

7. To roll up costs to the primary resource, click to check the Rollup Costs to Primary 
Resource checkbox under Additional Filters.  

8. Under Additional Filters, click to select one of following additional filters, as 
appropriate:  

a. Resources where Kind is blank  

b. Resources where Kind has entry  
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c. Include all (Kinds)  

d. Selective Kinds  

9. To preview the report, click the Preview button.  

10. To print the report, click the Print button.  

11. When finished, click the Close button to close the window.  

III. OTHER COST REPORTS 

A. To generate Other Cost reports: 

1. Under Report Categories, click Other Categories. 

2. In the area under Report Categories, click one of the following reports: 

a. Analysis: 

• Resource - This report can identify the average cost by Kind that 
exceeds the standard cost. It can also identify the individual costs by 
resource that exceeds the maximum rate.  

• Accountability - This report identifies the percentage of resource types 
(i.e. Aircraft, Crew, Equipment, Support, Direct) defined for the 
incident and compares the Current Values with the Standard Values. 
The Difference and Standard Deviation are listed for each resource 
type.  

• Exception - This report identifies resources that meet the selected filter 
requirements. You can select any of the following filters for this report:

o Resource Status is D but No Release Date is Entered. 

o Resources with no actual Time posted 

o Resource Daily Cost exceeds a defined amount.  

NOTE: You can define the amount for this filter in the box that displays to the right of this 
filter option.  

o Resource with Actual Time Posted, but has a defined number of 
days with Unposted time.  

NOTE: You can define the number of days for this filter in the box that displays to the right 
of this filter option. 

b. Acres NVC: 

• Resource Loss (Summary) - This report contains a high level view of 
the acres that were lost and the Net Value Change (NVC) resources 
that were affected. The information in this report is based on values 
defined on the Acres Burned NVC/FIL window. 

• Resource Loss (Mid - Level) - This report contains a mid-level view 
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of the acres that were lost and the NVC resources that were affected. 
The information in this report is broken down by NVC Subtotals for 
each date. The information in this report is based on values defined on 
the Acres Burned NVC/FIL window.  

• Resource Loss (Detail) - This report contains detailed information 
about the acres that were lost and the NVC resources that were 
affected. In addition to the information included in the Resource Loss 
(Mid-Level) report, this report includes information about the Fuel 
Intensity Level (FIL). The information in this report is based on the 
values defined on the Acres Burned NVC/FIL window. 

• Acres Burned - This report contains the information that was defined 
on the Acres Burned window.  

c. Aircraft: 

• Cumulative Air Costs Report. This report identifies the air costs 
based on those resources that were assigned Air kind codes (i.e. 
AT).  

d. Cost Share: 

• Cost Share Summary - This report identifies the Daily Cost for the 
Shift on the listed dates. It also identifies the Federal, State, and 
Other percentage of the cost obligations for the Shift on the listed 
dates. 

• Cost Share by Shift and Kind - This report identifies the Daily Cost 
for the Shift and Kind on the listed dates. It also identifies the 
Federal, State, and Other percentage of the cost obligations for the 
Shift and Kind on the listed dates. 

• Cost Share Detail - This report contains detailed Cost 
Apportionment information for listed Shifts and Resources. This 
information includes Daily Cost, Federal Cost, State Cost, and Other 
Cost. 

• Cost Share Resource Worksheet - This report contains Cost 
Apportionment information for listed Resources. This information 
includes Daily Cost, Federal Cost, State Cost, and Other Cost.  

e. Resource/Kind:  

• Resource Kind by Cost - This report identifies cost information based 
on kind and resource codes.  

• Resource Kind by Cost O/H Personnel - This report identifies cost 
information based on overhead personnel resources.  

f. Underutilized - This report lists any resources that were checked as 
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underutilized in the Daily Records screen. 

IV. EXPORT REPORTS 

NOTE: In Cost, you can export data to Word, Excel, PDF, or TXT. For this exercise, you 
will export a report to Excel. 

A. To export a report to Excel:  

1. Preview the report of your choice.  

2. Click the Export Report button.  

3. From the Format drop-down list, select the MS Excel option. Then click the OK 
button. An Excel Format Options window displays. 

4. Under Column width, identify the width of the columns to use. You can either select 
the Column width based on objects in the Report or define a Constant column 
width (in points). 

5. To include the page header and page footer, click to check the Page Header and 
Footer checkbox.  

6. To create page breaks for each page, click to check the Create page breaks for each 
page checkbox. 

7. To convert data values to strings, click to check the Convert data values to strings 
checkbox.  

8. You can include All pages in the report or define a page range in the From and To 
boxes  

9. Click the OK button to export the report. A Select Export File window displays.  

10. From the Save in drop-down list, select the directory where you want to save the 
Excel file. 

11. In the File name box, enter the name you want to assign to the Excel file. 

12. Click the Save button to export the file.  

13. Open the report in Excel from the location where the file was saved.  

NOTE: Once you save a file in Excel, you can use Excel to create charts and graphs, as 
needed.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.7 – Cost: Graphs. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Generate pre-designed graphs.  

2. Customize a pre-designed graph.  
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I. COST GRAPHS 

A. Generate pre-designed graphs.  

B. Customize a pre-designed graph.  

NOTE: Graphing Incident data provides a powerful visual feature to supplement reports for 
management decision making purposes.  

II. GRAPH CONTROL WINDOW  

A. Use the Graph Control window to change the appearance of a graph.  

NOTE: The style of graph selected determines the options that are available on the Graph 
Control window. For example, the options under the Error Bar tab apply to a 2D bar chart but 
not a 3D pie chart. For additional information on specific features, use the Help function. 

III. PRE-DESIGNED GRAPHS 

NOTE: Cost allows you to produce a number of pre-designed graphs for management 
decision making purposes. You can select a general format and then modify the graphical 
display for presentation. Cost Graphing offers several standard graphs.  

A. To generate pre-designed graphs: 

1. Open the Cost module.  

2. From the Cost drop-down menu, select Graphs to open the Cost Graphs window. 

3. Under Graph Types, click to select one of the following graph types:  

a. Aircraft Cost Per Gallon Delivered  

b. Aircraft Flight Cost  

c. Aircraft Gallons Per Hour  

d. Aircraft Total Gallons Dropped  

e. Aircraft Utilization  

f. Cost By Date  

g. Division Cost By Date  

h. Total Cost  

NOTE: For this exercise, use the Total Cost graph. 

4. Review the graph, and then click the Close button.  

NOTE: The Cost By Date Graph displays an Area Chart of Total Incident Costs By Date.  

B. To generate a Cost By Date graph: 

1. Open the Cost module.  
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2. From the Cost drop-down menu, select Graphs to open the Cost Graphs window. 

3. Under Graph Types, click to select Cost by Date.  

4. From the Date(s) drop down lists, select the Dates to include in the graph.  

5. From the Incident drop down list, select the Incident to include in the graph.  

6. Click the Fonts button in the graph toolbar to open the Graph Control window. 
Modify the Typeface and Size of the Graph Title.  

7. To save your changes, click the Apply Now button, and then click the OK button.  

8. Click the Options button at the bottom of the window to open the Graph Options 
window. Under Graph Titles, enter a second graph title in the Bottom Line 1 box. 
This title displays beneath the graph. 

9. To save your changes, click the Apply button.  

10. Review the graph, and then click the Close button.  

NOTE: For this exercise, use the Aircraft Utilization Graph.  

C. To generate the Aircraft Utilization graph: 

1. Open the Cost module.  

2. From the Cost drop-down menu, select Graphs to open the Cost Graphs window.  

3. Under Graph Types, click to select Aircraft Utilization.  

4. From the Date(s) drop down lists, select the Dates to include in the graph.  

5. From the Aircraft(s) drop down list, select All Aircraft.  

6. Review the graph, and then click the Close button.  

IV. CUSTOMIZE GRAPHS 

NOTE: You can build on the standard graphs by altering the display.  

A. To customize a pre-designed graph: 

1. Open the Cost module.  

2. From the Cost drop-down menu, select Graphs to open the Cost Graphs window.  

3. Under Graph Types, click to select Total Cost.  

4. Follow the directions on the Cost Graphs handout from your student binder.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.8 – Cost: Accruals. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify US Forest Service accruals.  

2. Identify reportable US Forest Service 
accrual categories.  

3. Explain the logic/criteria for each 
reportable accrual category.  

4. Identify the Accrual Fiscal Year. 

5. Add/edit an Accrual Code (Accounting 
Code).  

6. Assign an Accrual Override Code to 
incident resources.  

7. Create an accrual extract.  

8. Run/preview an accrual report.  

9. Finalize and print an accrual report for 
submission to the host agency or forest. 

10. Export an accrual report in PDF format. 

11. Explain when AD Draw Down occurs. 
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I. COST ACCRUALS 

A. Identify US Forest Service accruals.  

B. Identify reportable US Forest Service accrual categories.  

C. Explain the logic/criteria for each reportable accrual category.  

D. Identify the Accrual Fiscal Year. 

E. Add/edit an Accrual Code (Accounting Code).  

F. Assign an Accrual Override Code to incident resources.  

G. Create an accrual extract.  

H. Run/preview an accrual report.  

I. Finalize and print an accrual report for submission to the host agency or forest.  

J. Export an accrual report in PDF format.  

K. Explain when AD Drawn Down occurs. 

II. ACCRUAL CATEGORIES 

THE INSTRUCTOR SHOULD OBTAIN A COPY OF THE CURRENT INCIDENT ACCRUAL MATRIX TO 
PROVIDE STUDENTS WITH UP-TO-DATE INFORMATION. 

A. Review US Forest Service accruals.  

1. The US Forest Service requires all incidents utilizing Forest Service resources to 
report their accruals on a daily basis. The assignment of an accrual category for 
resources is automated – processed when a new resource is entered into an I-Suite 
database. However, a Cost user will be responsible for verifying and managing the 
assignment of accrual categories.  

NOTE: Providing a Daily Accrual Summary Report to a Host Forest or the National Forest 
Service Payment Center Is A Requirement. 

B. Identify reportable US Forest Service accrual categories.  

1. Sixty separate accrual categories are available to Cost users, but only the following 
fifty-nine accrual categories are reportable:  

a. AD: Casual hires  

b. AMD: Aviation Management Directorate aircraft  

c. CONT: All non-air contracts 

d. INTL: International 

e. NOAA: National Weather Service personnel 

f. States: All fifty states, plus District of Columbia, Guam, Puerto Rico and the 
Virgin Islands. 
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C. Discuss the logic/criteria for each reportable accrual category.  

1. Extract data is captured into the following fifty-nine categories by accounting code: 

a. AD: Casual hires  

b. AMD: Aviation Management Directorate aircraft  

c. CONT: All non-air contracts 

d. INTL: International 

e. NOAA: National Weather Service personnel 

f. States: All fifty states, plus District of Columbia, Guam, Puerto Rico and the 
Virgin Islands. 

NOTE: The Incident Jurisdiction defined for an Incident in Data Admin facilitates cost 
accrual category decisions. 

NOTE: Accrual categories refer to a specific RC line number in the FS financial system. This 
line number displays on the Accrual Summary report. 

2. The EXCL (Exclude) accrual category is not included in the extract. 

D. Identify the Accrual Fiscal Year: 

1. The two digit Fiscal Year is appended to the accounting code for accruals in the 
Accrual Summary Report, Detail Report and Financial Export. 

NOTE: Accrual Reports will not include totals by Fiscal Year. They only include totals by the 
accrual accounting code with the Fiscal Year appended to the accounting code. 

NOTE: If the user manually typed the Fiscal Year at the end of the accounting code, the 
Fiscal Year will be shown twice. (e.g., if PBM32408 was typed into I-Suite, it will display as 
PBM3240708 for the 2008 Fiscal Year and PBM32400709 for the 2009 Fiscal Year.) 

a. The new Fiscal Year starts on October 1 each year. 

b. Accruals start at $0.00 at the start of the new Fiscal Year. 

c. Incidents being managed in only one Fiscal Year will include financial data 
for just that Fiscal Year. 

d. Incidents that span more than one Fiscal Year will have two accrual 
accounting codes, one for each Fiscal Year. The accounting code with the 
new Fiscal Year appended will only be created when there are costs 
associated with that accounting code in the new Fiscal Year. 

e. The OF-288 and OF-286 invoices will not show the appended Fiscal Year 
with the accounting code. 

f. Changes that were made to financial data in the previous Fiscal Year do not 
effect the new Fiscal Year accrual data. Those changes are included in the 
previous Fiscal Year's accrual data. 
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III. ACCRUAL ACCOUNTING CODES 

A. To add or edit an Accounting Code for Accruals: 

1. Open Data Admin. Make sure the Incident Data tab is selected. 

2. Under Feature, click to select Accounting Codes.  

3. To add an Accounting Code, click the Add button.  

4. From the Incident Name drop down list, select the appropriate Incident Name.  

5. From the Agency drop-down list, select the appropriate agency. 

NOTE: You must select an Agency before entering an accounting code. The Accounting 
Code box is disabled until you selected an Agency. 

6. In the Accounting Code box, enter the new Accounting Code.  

7. If you selected the FS Agency, a Region / Unit drop-down list is available. Select the 
appropriate region or unit code from this drop-down.  

8. To save your changes, click the Save button.  

9. When finished, click the Close button.  

B. To assign an Accrual Override Code to incident resources.  

1. Open Data Admin. Make sure the Incident Data tab is selected.  

2. Under Feature, click to select Accounting Codes.  

3. In the Accounting Codes grid, click to select the Accounting Code to which you 
want to assign an accrual override code.  

4. From the Accrual Override Code drop-down list, select the Accrual Override Code 
you want to assign to the accounting code.  

5. To save your changes, click the Save button.  

6. When finished, click the Close button.  

IV. ACCRUAL EXTRACT 

NOTE: Once Resources have been assigned an Accrual Code, you can run an extract to 
capture Accrual Amounts assigned to each Category.  

A. To create an accrual extract.  

1. Open the Cost module.  

2. From the Cost drop-down menu, select Accrual.  

3. On the Accrual Extract window, click the Extract button.  

NOTE: You must print the report to fax to the Host Agency. For this exercise, you will not be 
able to actually print an Accrual Report.  

B. To run and preview an accrual report: 
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1. Open the Cost module.  

2. From the Cost drop-down menu, select Accrual to open the Accrual Extract 
window.  

3. Under Accrual Extract, click to select the current accrual extract.  

4. Under Reports, click to select one of the following:  

a. Summary  

b. Detail  

c. Detail All  

5. To preview your selected report, click the Preview button.  

6. Review the Accrual Report in the Preview window. Then click the Close button.  

NOTE: The Detail Report is a valuable tool that can be used to validate the accuracy of the 
Accrual Report. You should review this report prior to finalizing the Daily Accruals. 

C. To finalize and print an accrual report for submission to the host agency or forest: 

1. Open the Cost module.  

2. From the Cost drop-down menu, select Accrual to open the Accrual Extract 
window.  

3. Under Accrual Extract, click to select the current accrual extract.  

4. Click the Finalize button, and then click the OK button.  

NOTE: A sequential number is posted to each accrual after it is Finalized (e.g. 0001).  

5. Under Reports, click to select the appropriate report, and then click the Print button. 

NOTE: Instead of faxing, reports can be exported in a PDF format and then e-mailed or 
posted to a Website.  

D. To export a report in PDF format.  

1. Open the Cost module.  

2. From the Cost drop-down menu, select Accrual to open the Accrual Extract window. 

3. Under Accrual Extract, click to select the current accrual extract.  

4. Under Reports, click to select a report. Then click the Preview button.  

5. On the Accrual window in Crystal Reports, click the Export button to open the 
Export window.  

6. From the Format drop down list select Acrobat Format (PDF).  

7.  From the Destination drop down list select the appropriate file destination. Then 
click the OK button. An Export Options window displays. 

8. To include all pages of the report in the export process, click the All option.To include 
a range of pages in the export, click the Page Range option. Then define the page 
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range in the From and To boxes. 

9. Click the OK button to export the report. A Choose Export File window displays. 

10. From the Save in drop-down list, select the directory where you want to save the 
PDF file. 

11. Enter the File name to assign to the PDF file.  

12. Click the Save button to export the file.  

V. AD DRAW DOWN 

A. For an AD Drawn Down to occur, the following must happen: 

1. The person must have an accrual code of AD. (Usually an employment type of AD 
and an agency of FS.) 

2. An Original OF-288 must be printed. 

3. After the OF-288 is printed, accruals must be extracted and finalized. 

4. After accruals are extracted and finalized, a Financial Export file must be created. 

5. After the Financial Export File is created, accruals must be extracted and finalized 
again. The AD Draw Down is included on these Accrual Reports. 

6. After accruals have been extracted and finalized for the second time, another Financial 
Export File must be created. The AD Drawn Down will be included in this export 
file. 

NOTE: Accruals can only be finalized once per day and the financial export can only be 
created once per day. 

NOTE: AD Drawn Downs use the total invoiced amount prior to deductions shown in Block 
22 on the Commissary Record for the OF-288 Invoice. 

NOTE: The AD Draw Down is based on the last accounting code posted for each day. 
Example: 
 
- Day one $100 posted on P1234 (AD Draw Down is on P1234 for $100) 
 
- Day two $100 posted on P5678 (AD Draw Down is on P5678 for $100) 
 
-Day three in the morning has $75 posted on P5678 and in the afternoon has $25 posted on 
P1234 (AD Draw Down is on P1234 for $100). 

a. The AD Draw Down will occur in the prior Fiscal Year when all of the 
postings and the AD Draw Down steps previously defined occur in the prior 
Fiscal Year. 

b. The AD Draw Down will occur in the new Fiscal Year when all of the 
postings and the AD Draw Down steps previously defined occur in the new 
Fiscal Year. 
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c. The AD Draw Down will occur in the new Fiscal Year when the Original 
OF-288 invoice spans both Fiscal Years. When this occurs, the entire 
invoiced amount will be drawn down in the new Fiscal Year. 

NOTE: If the AD Draw Down occurs in the new Fiscal Year because the Original OF-288 
Invoice spans both Fiscal Years, it may result in a negative accrual amount. 

d. The AD Draw Down will occur in the new Fiscal Year when all postings 
were made in the prior Fiscal Year, but not all of the AD Draw Down steps 
previously defined were completed in the prior Fiscal Year. 

NOTE: The AD Draw Down will only occur when another Original OF-288 invoice is printed 
for that resource in the new Fiscal Year and all of the AD Draw Down steps were completed 
in the new Fiscal Year. This may result in a negative accrual amount. 
 
If another Original OF-288 invoice is not printed in the new Fiscal Year, the AD Draw Down 
may never occur in this situation. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.9 – Cost: Projections. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Define Cost projections.  

2. Create a projection.  

3. Edit a projection.  

4. Update a projection.  

5. Generate a projection graph.  

6. Generate a projection report.  
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I. COST PROJECTIONS 

A. Define Cost projections.  

B. Create a projection.  

C. Edit a projection.  

D. Update a projection.  

E. Generate a projection graph.  

F. Generate a projection report.  

II. PROJECTIONS 

NOTE: A Cost user may be asked by the Finance Section Chief, or other command staff, for a 
projection. 

A. Review Cost projections.  

NOTE: Cost Projections are used to predict the estimated future cost of an incident and are 
necessary for a variety of management decisions. For example, you can use projections when 
updating the WFSA or determining the cost of a specific strategy. 

1. Cost offers users a Projection module to select and manipulate data for generating 
customized projections. As a starting point for each projection, Cost uses the current 
day’s count of equipment and direct personnel resources. Added to this is the 
support calculation as follows:  

Current Day Total Support Costs 
Current Day Total Direct Personnel 

 

  
X 

Future Day  
Direct 
Personnel 

  
2. You can use the Update function in the projection module in two ways. 

a. To increase or decrease the number of days for a projection. 

b. To apply current day’s costs to a previous day’s specifications. 

 
NOTE: Projections use the current day’s count of Resources Plus the calculated support cost. 
Take this into consideration when presenting a projection for decision making purposes.  

B. To create a projection: 

1. Open the Cost module.  

2. To ensure that your data is current, run the Create Daily process.  

3. From the Cost drop-down menu, select Projections.  

4. When the Projections window displays, the system automatically inserts the next 
day’s date into the Start Date box. In most cases, you will want the projection to 
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begin the following day. If needed, you can change this entry.  

5. From the Incident drop-down list, select the appropriate Incident.  

6. In the Days box, type the number of days.  

7. In the Projection Name box, type an appropriate Projection Name.  

8. To save the Projection, click the Save button.  

NOTE: Projections are never ‘hard and fast.’ They can be modified to reflect a wide variety 
of scenarios.  

C. To edit a projection.  

1. Open the Cost module.  

2. From the Cost drop-down menu, select Projections to open the Projections window. 

3. Under Incident, click to select the appropriate Projection.  

4. Under Summary of Projection Kinds, click to select the appropriate Kind.  

5. Under Projection Detail for Selected Kind, click to check the Flow Down checkbox. 

6. Edit the Projection Detail. 

NOTE: Changes can only be made to the Average Cost and Quantity information. 

7. To save your changes to the Projection, click the Save button.  

NOTE: Projections may need to be updated for a couple of different reasons:  

• To change the number of days in a projection  

• To adjust a previously created projection for the current day.  

D. To update a projection.  

1. Open the Cost module.  

2. From the Cost drop-down, select Projections to open the Projections window.  

3. Under Incident, click to select the appropriate Projection.  

4. Click the Update Projection w/ Current Day’s Costs button. 

5. In the Change Projection Days box, type 8. Then click the Run Update button.  

III. GRAPHS & REPORTS 

NOTE: Cost users may want to generate a Projection Graph for presentation along with 
reports.  

A. To generate a projection graph.  

1. Open the Cost module.  

2. From the Cost drop-down menu, select Projections to open the Projections window. 

3. Under Incident, click to select the appropriate Projection.  
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4. Under Graphs, click to select Cost by Date.  

5. Click the Graph button to display the selected graph.  

6. Run the Total Projection Cost graph.  

NOTE: Users may need to generate a Projection Report for management decision making 
purposes.  

B. To generate a projection report.  

1. Open the Cost module.  

2. From the Cost drop-down menu, select Projections to open the Projections window. 

3. Under Incident, click to select the appropriate Projection.  

4. Under Reports, click to select one of following reports:  

a. Projection  

b. Weekly Projection  

c. Total Costs.  

5. To display your selected report, click the Preview button.  

6. To print your selected report, click the Print button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 8.10 – Cost: Cost Apportionment. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Define cost apportionment.  

2. Create and manage a division.  

3. Assign resources to a division.  

4. Generate cost share reports.  
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I. COST APPORTIONMENT 

A. Define cost apportionment.  

B. Create and manage a division.  

C. Assign resources to a division.  

D. Generate cost share reports.  

II. COST SHARE REPORTING 

A. Review cost apportionment.  

NOTE: Cost Apportionment is the process used to determine each agency's share of the 
Incident Costs. 

1. Cost provides features to facilitate reporting cost figures for cost share agreements. 
This feature involves three distinct steps.  

a. Creating cost divisions.  

b. Assigning resources to a division.  

c. Generating the cost sharing reports. To accurately report cost shares, you 
must create a separate division for each day of incident cost reporting.  

NOTE: Cost does not provide a separate Cost Share module or menu. Rather, it utilizes the 
more generic features to accomplish Cost Share Reporting.  

III. COST DIVISIONS 

NOTE: The divisions in the Cost module are not necessarily the same as the operational 
divisions on an incident. 

NOTE: The first step in Cost Share Reporting is to create new entries in the Divisions table. 

A. To create and manage a division:  

1. Open the Cost module.  

2. From the Cost drop-down menu, select Divisions to open the Cost - Divisions 
window.  

3. From the Incident drop down list, select an Incident.  

4. Under Add Mode, complete the following:  

a. Division - A 

b. Shift - D 

c. Date - Use the start date of the incident. 

d. Fed% - 50% 

e. State% - 50% 
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f. Other% - 0% 

5. To save your changes, click the Save button.  

6. Repeat the previous steps to create two more divisions using different start dates and 
percentages.  

7. When finished, click the Close button.  

NOTE: The system will automatically create a daily entry for every division up to the current 
date. 

IV. ASSIGN RESOURCE TO DIVISION 

NOTE: The second step is to set Division Assignments - By Resource, By Day.  

A. To assign resources to a division: 

1.  Open the Cost module.  

2. Click the Show Cost button in the Cost toolbar.  

3. In the Resources grid, select a resource.  

4. In the Manage Cost grid, select the division specified in the handout (A) from the 
Division drop-down list.  

NOTE: When you select a division for a Crew resource, a prompt displays asking whether 
you want to apply the division to all sub-resources for that date. Click the Yes button to apply 
the division to the sub-resources. Click the No button if you do not want to apply the division 
to the sub-resources. 

5. To save your changes, click the Save button.  

6. Select different resources and complete the previous steps. Assign resources to 
different divisions on various dates. 

NOTE: Divisions only display in the drop-down list if there was an entry created for that day.

V. COST SHARE REPORTS 

NOTE: The third step is to generate the Cost Share Reports. 

A. To generate cost share reports: 

1. Open the Cost module.  

2. Click the Reports button to open the Cost Reports window.  
 
OR  
 
From the Reports drop-down menu, select Cost Reports.  

3. Under Report Categories, click to select Other Categories. Then click to select Cost 
Share in the bottom box. 
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4. From the Incident drop-down list, select the Incident.  

5. Under Cost Share Reports, click to select By Shift and Kind. Then click the 
Preview button.  

6. Preview other Cost Share reports of your choice.  

7. When finished, click the Close button.  

NOTE: The Cost Share report provides a summary of all the divisions and averages the daily 
percentages to determine the total percentages for Federal, State, and Other. The Division report 
provides information for a specific division. 
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Unit 9 
I-Suite Custom Reports 
9.0 – Custom Reports: Overview. 

1.  Identify the purpose of Custom Reports. 
2.  Identify the basic features of the Custom Reports screen. 

9.1 – Custom Reports: Report Designer. 
1.  Design Custom Reports using Report Designer. 
2.  Preview and Print from Report Designer. 

9.2 – Custom Reports: Advanced Designer. 
1.  Design Custom Reports using Advanced Designer. 
2.  Preview and Print from Advanced Designer. 
3.  Define components of a valid SQL statement. 

9.3 – Custom Reports: Manage Saved Reports 
1.  Preview/Print saved custom reports. 
2.  Edit saved custom reports. 
3.  Copy saved custom reports. 
4.  Delete saved custom reports. 
5.  Export saved custom reports. 
6.  Import saved custom reports. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 9.0 – Custom Reports: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the purpose of Custom Reports. 

2. Identify the basic features of the Custom 
Reports screen.  
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I. CUSTOM REPORTS 

A. Identify the purpose of Custom Reports.  

1. The purpose of Custom Reports is to use I-Suite data to create reports that are not 
available in the Standard Reports. 

NOTE: All custom reports can be viewed and printed by other I-Suite users with the same 
rights.  

NOTE: Only the original report creator can make changes to a report they created. Only the 
original report creator or an administrator can delete saved reports. 

II. BASIC FEATURES 

A. Identify the basic features of the Custom Reports window.  

1. Report Designer - Create a custom report by selecting fields from a Data View and 
adding them to the report.  

2. Advanced Designer - Create a custom report by constructing a valid SQL statement.  

NOTE: With both designers you can save your Custom Reports. 

NOTE: The data views that are available in both designers are based on the Rights associated 
with your User ID.  

3. Manage Saved Reports - Print, preview, edit, delete, export and import saved 
Custom Reports. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 9.1 – Custom Reports: Report Designer. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Design Custom Reports using Report 
Designer.  

2. Preview and Print from Report Designer. 
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I. REPORT DESIGNER 

A. Design Custom Reports using Report Designer.  

B. Preview and print from Report Designer.  

II. DESIGN CUSTOM REPORTS 

A. To design Custom Reports using Report Designer: 

1. From the Reports drop-down menu, select Custom Reports. On the Custom Reports 
window, click the Report Designer tab. 

2. From the Data Views drop down list, select the Report Views you want to use. 

NOTE: If a report was created for the selected Report View, a message displays asking 
whether you want to clear the designer and create a new report. Click Yes to create a new 
report. Click No if you want to edit the current report, not create a new one.  

3. Click one or more fields under Field Names to highlight them. Then click the >> 
button to move the fields to  Selected Report Fields. The fields you select print on 
the custom report. Repeat this step until all of the fields you want to include in the 
report are listed under Selected Report Fields.  

4. If you need to rearrange the order in which the fields print on the report, highlight the 
field you want to move under Selected Report Fields. Then click the Up or Down 
button to move the field.  

5. To change the column heading on the report, enter the name in the Display Caption 
field.  

6. To change the width of a column in the report, enter the new width in the Width field.

7. To change the sort order for a column to either Ascending or Descending, select 
either ASC or DESC from the Sort drop-down list. 

8. To add an aggregate to a column, select the appropriate option from the Aggregate 
drop-down list. 

9. Under Report Layout, enter a Report Title for the custom report.  

NOTE: The Report Title is used to store and retrieve the report. It must be unique. If there is 
a custom report that contains the same name, a message displays indicating that a report was 
already created with that title when you save the report. You must then enter a different title 
for the report before saving it.  

10. If you want the report to print in a Landscape format, click to check the Landscape
checkbox. If you want the report to print in a Portrait format, remove the check 
from the Landscape checkbox. 

11. Click one of the following to identify the line spacing to use in the report:  

a. Single  
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b. 1.5 Lines  

c. Double.  

12. When finished, click the Save button to save your Custom Report.  

NOTE: Saved Custom Reports are listed under Manage Saved Reports from where they can 
be Printed, Edited, Deleted, Copied, Exported, or Imported, as needed.  

B. Preview and print the report in Report Designer.  

1. To preview and print your report, click the Preview button, and then click the Print 
Report button on the Preview screen.  

2. To print your report without previewing, click the Print button on the Custom 
Reports screen.  

NOTE: You can Preview and Print your report before or after you save it. You do not have 
to save your report.  

NOTE: If you intend to save your report, it is a good practice to save it before you preview it.
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 9.2 – Custom Reports: Advanced Designer. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Design Custom Reports using Advanced 
Designer.  

2. Preview and Print from Advanced 
Designer.  

3. Define components of a valid SQL 
statement.  
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I. ADVANCED DESIGNER 

A. Design Custom Reports using Advanced Designer.  

B. Preview and Print from Advanced Designer.  

C. Define components of a valid SQL statement.  

II. DESIGN CUSTOM REPORTS 

A. Design Custom Reports using Advanced Designer.  

1. Open Custom Reports. Then click the Advanced Designer tab. 

2. Under Report Layout, enter a Report Title for your report.  

NOTE: The Report Title is used to store and retrieve the report. It must be unique. If there is 
a custom report that contains the same name, a message displays indicating that a report was 
already created with that title when you save the report. You must then enter a different title 
for the report before saving it. 

1. If you want the report to print in a Landscape format, click to check the Landscape 
checkbox. If you want the report to print in a Portrait format, remove the check 
from the Landscape checkbox.  

2. Click one of the following under Report Layout to identify the line spacing to use in 
the report:  

a. Single  

b. 1.5 Lines  

c. Double.  

5. Under Report Views, double-click a listed table to display a list of fields for that 
table. Double click a field to added it to the SQL Statement.  

6. Under SQL Statement, construct a valid SQL statement. Then click the Check button 
to check the validity of the statement and move the SQL Statement to Selected 
Report Fields.  

NOTE: If a SQL statement is invalid, a message displays in the Error Messages box. Correct 
the error in the SQL statement and then click the Check button again.  

NOTE: The Error Messages box under Advanced Designer can also be used to validate 
Report Designer reports. 

6. If you want to define a width for the field, rather than having the application 
automatically assign a width, enter the width into the Width field under Selected 
Report Fields. 

7. When finished, click the Save button to save your Custom Report.  

NOTE: Saved Custom Reports are listed under Manage Saved Reports from where they can 
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be Printed, Edited, Deleted, or Exported, as needed.  

B. Preview and print from Advanced Designer.  

1. To preview and print your report, click the Preview button, and then click the Print 
Report button on the Preview screen.  

2. To print your report without previewing, click the Print button on the Custom 
Reports screen.  

NOTE: You can Preview and Print your report before or after you save it. You do not have 
to save your report. 

C. Review components of a valid SQL statement.  

1. Data retrieval operations (queries) search the database, retrieve information that you 
have requested in the most efficient way possible, and display it. The following is a 
list of some of the Keywords used in SQL statements:  

a. SELECT clause – identifies the data.  

b. FROM clause – identifies the table.  

c. WHERE clause – limits the data that the SELECT statement returns.  

d. GROUP BY – organizes data into sets e. COUNT(*) – gives a summary 
value per set (e.g.: 209 Resource List).  

2. The following is a list of some best practices to follow when constructing SQL 
statements:  

a. KEYWORDS – in uppercase.  

b. All other words – in lowercase.  

c. Clauses – each clause on a separate line.  

d. Complex WHERE clause – can be separated onto multiple lines.  

e.  Minimum requirement – a valid SQL statement must have at least a 
SELECT and a FROM clause.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 9.3 – Custom Reports: Manage Saved Reports 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Preview/Print saved custom reports.  

2. Edit saved custom reports.  

3. Copy saved custom reports. 

4. Delete saved custom reports.  

5. Export saved custom reports.  

6. Import saved custom reports.  
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I. MANAGE SAVED REPORTS  

A. Preview/Print saved custom reports.  

B. Edit saved custom reports.  

C. Copy saved custom reports. 

D. Delete saved custom reports.  

E. Export saved custom reports.  

F. Import saved custom reports.  

II. PREVIEW/PRINT CUSTOM REPORTS  

A. To preview or print saved custom reports: 

1. Open Custom Reports. Then click the Manage Saved Reports tab. 

2. Under Filters, click to check or uncheck the following checkboxes to identify the 
reports to include in the Saved Reports grid: 

• My Reports - When this checkbox is checked, the Saved Reports grid 
includes all of the custom reports that you created. 

• User Reports - When this checkbox is checked, the Saved Reports 
grid includes all of the custom reports created by users with the same 
rights as you. 

3. Under Saved Reports, click to select the report you want to preview or print.  

4. Click the Preview button to preview the report. Click the Print button to print the 
report.  

III. EDIT CUSTOM REPORTS 

NOTE: Only the user who originally created the report can make changes to it. 

A. To edit saved custom reports.  

1. Open Custom Reports. Then click the Manage Saved Reports tab. 

2. Under Filters, click to check My Reports. Uncheck User Reports. 

NOTE: By unchecking User Reports, only those reports you can edit will display in the 
Saved Reports grid. 

3. Under Saved Reports, click to select the report you want to edit. Then click the Edit 
button.  

4. Edit the report, as needed. Then click the Save button.  

IV. COPY CUSTOM REPORTS 

NOTE: Users that did not create the original custom report can still copy it to create a new 
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report. 

A. To copy a saved custom report: 

1. Open Custom Reports. Then click the Manage Saved Reports tab. 

2. Under Filters, click to check or uncheck the following checkboxes to identify the 
reports to include in the Saved Reports grid: 

• My Reports - When this checkbox is checked, the Saved Reports grid 
includes all of the custom reports that you created. 

• User Reports - When this checkbox is checked, the Saved Reports 
grid includes all of the custom reports created by users with the same 
rights as you. 

3. Under Saved Reports, click to select the report you want to copy. 

4. Click the Copy button. 

5. If the report was created in the Report Designer, that tab automatically opens. If the 
report was created in the Advanced Report Designer, that tab automatically opens.

6. Make the appropriate changes to the copied report. 

7. In the Report Title box, enter a unique title for the report. 

8. Click the Save button to save the report. 

V. DELETE CUSTOM REPORTS 

NOTE: Only the user who originally created the report or an administrator can delete it. 

A. To delete saved custom reports: 

1. Open Custom Reports. Then click the Manage Saved Reports tab. 

2. Under Filters, click to check My reports. Uncheck User Reports. 

NOTE: By unchecking User Reports, only those reports you can delete will display in the 
Saved Reports grid. 

3. Under Saved Reports, click the report you want to delete. Then click the Delete 
button.  

4. When the delete confirmation message displays, click Yes to confirm deletion of the 
custom report.  

VI. EXPORT/IMPORT CUSTOM REPORTS 

A. To export saved custom reports: 

1. Open Custom Reports. Then click the Manage Saved Reports tab. 

2. Under Filters, click to check or uncheck the following checkboxes to identify the 
reports to include in the Saved Reports grid: 

• My Reports - When this checkbox is checked, the Saved Reports grid 
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includes all of the custom reports that you created. 

• User Reports - When this checkbox is checked, the Saved Reports 
grid includes all of the custom reports created by users with the same 
rights as you. 

3. Under Saved Reports, click the report you want to export. Then click the Export 
button.  

4. On the I-Suite Custom Reports Export window, browse to the folder where you 
want to save the exported report. Then click the Save button.  

B. To import saved custom reports.  

1. Open Custom Reports. Then click the Manage Saved Reports tab. 

2. Under Saved Reports, click the Import button.  

3. On the I-Suite Custom Reports Import window, browse to the location of the saved 
custom report. Click to select the report you want to import. Then click the Open 
button.  
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Unit 10 
I-Suite Supply 
10.0 - Supply Overview 

1.  Identify the purpose of the Supply module. 
2.  Identify the basic features of the Supply screen. 

10.1 - Supply Options 
1.  Select the incident to which the Supply option apply. 
2.  Define the Supply Address. 
3.  Turn Inventory Tracking ON or OFF. 

10.2 - Supply Issue 
1.  Identify Supply Items to issue to a Resource or Location. 
2.  Perform an Advanced Search for a Supply Item. 
3.  Remove or Change the Quantity for a Supply Item. 

10.3 - Supply Issue Returns 
10.4 - Transfer Supply Items 

1.  Transfer selected items from one Resource or Location to another. 
2.  Perform an Advanced Search. 
3.  Remove Transfer Items from Items Transferred List before transferring. 

10.5 - Release Supply Items 
1.  Filter supply items in the Items for Release grid. 
2.  Permanently release supply items to an outside location. 
3.  Perform an Advanced Search. 
4.  Remove or change the Quantity for an item in the Items Released grid. 

10.6 - Add/Edit Supply Items 
10.7 - Add/Edit Locations 

1.  Add Within Incident Locations. 
2.  Edit Within Incident Locations. 
3.  Add Outside Incident Locations. 
4.  Edit Outside Incident Locations. 

10.8 - View Supply History 
1.  View a History of Supply Transactions. 

10.9 - Supply Inventory 
1.  Turn Inventory Tracking ON. 
2.  Manually change inventory counts. 
3.  Perform an Advanced Search of supply items. 
4.  Change a supply item quantity. 

10.10 - Receive Supplies 
1.  Receive Supply Items. 
2.  Filter Supply Items. 
3.  Perform an Advanced Search in the Item to Receive grid. 
4.  Remove or change the quantity for an Item Being Received. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.0 - Supply Overview 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Identify the purpose of the 
Supply module. 

2. Identify the basic features of 
the Supply screen. 
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I. SUPPLY 

A. Identify the purpose of the Supply Module: 

1. The primary purpose of the Supply module is to track supply items that are issued to 
resources and returned to Supply. 

2. The Supply module can also be used to track the Supply Inventory. 

NOTE: Inventory Tracking is optional. When using the Supply module to track the Supply 
Inventory, it is a good idea to receive supply items in order to ensure accurate counts.  

B. Identify the basic features of the Supply window: 

1. The Supply drop-down menu at the top of the window includes the following Supply 
options:  

a. Release (Permanent) - Permanently releases supply items to another 
location, such as a cache or another incident.  

b. Add/Edit Location - Adds or edits a location.  

c. Add/Edit Supply Items - Adds or edits a Supply item.  

d. Transfer (At Incident) - Transfers a Supply item from one resource to 
another.  

e. Inventory - Allows the user to manually change inventory counts.  

2. The Supply toolbar is located to the right of the Filter toolbar. The buttons in this 
toolbar include: 

a. Issue - Issue supply items.  

b. Issue Returns - Return supplies issued to a resource or location.  

c. Receive - Receive supply items. 

d. View History - View a history of supply items that were issued.  

e. Add/Edit Location - Add or edit locations that are either internal or external 
to the incident.  

f. Add Supply Item - Add items to the Supply list.  

3. Each window in the Supply module contains two to three grid areas. The following 
grids may display on the screen, depending on the Supply area that is open: 

a. Resources Grid 

b. Locations Grid 

c. Supply Items Grid 

d. Items for Transfer Grid 

e. Items Issued Grid 
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f. Items Received Grid 

g. Items Released Grid 

h. Items Transferred Grid 

4. Additional Supply buttons display on the right side of the window. The buttons that 
display are based on the area that is open within the Supply module. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.1 - Supply Options 

  
OBJECTIVES Upon completion of this unit, the 

trainee will be able to: 
  

  1. Select the incident to which 
the Supply option apply. 

2. Define the Supply Address. 

3. Turn Inventory Tracking ON 
or OFF. 
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I. SUPPLY OPTIONS 

A. Define Incident for Supply 

B. Define Supply Address 

C. Turn Track Inventory On or Off 

II. SUPPLY INCIDENT 

A. To define the Supply Incident: 

1. From the Tools drop-down menu, select Options to open the Options window. 

2. Click the Supply tab. 

3. From the Incident drop-down list, select the incident to which the supply options 
apply. 

4. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window. 

III. SUPPLY ADDRESS 

A. To define the Supply Address: 

1. From the Tools drop-down menu, select Options to open the Options window. 

2. Click the Supply tab. 

3. Under Supply Address, enter the supply address, including Address 1, Address 2, 
City, State, and Zip Code.  

4. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window.  

IV. TRACK INVENTORY 

A. To turn Track Inventory ON or OFF: 

1. From the Tools drop-down menu, select Options to open the Options window. 

2. Click the Supply Tab. 

3. If you want to track the supply inventory, click to check the Track Inventory 
checkbox.  
 
If Track Inventory is ON and you want to turn it OFF, click to uncheck the Track 
Inventory checkbox. 

4. When finished, click the Save button to save your changes. Then click the OK button 
to close the Options window. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.2 - Supply Issue 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Identify Supply Items to issue 
to a Resource or Location. 

2. Perform an Advanced Search 
for a Supply Item. 

3. Remove or Change the 
Quantity for a Supply Item. 
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I. ISSUE SUPPLIES 

A. Issue Supply Items to a Resource or Location. 

B. Perform an Advanced Search for a Supply Item. 

C. Remove or Change the Quantity for a Supply Item. 

II. ISSUE SUPPLY ITEMS 

A. To use the Select Item button to select Supplies to issue to a Resource or Location: 

1. From the Modules drop-down menu select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. To issue a Supply Item to a resource, click the Resource in the Resources grid. 
 
OR 
 
To issue a Supply Item to a resource and a location, click a Resource in the 
Resources grid. Then select the location from the Location drop-down list.  
 
OR 
 
To issue a Supply Item to a location, click the UnSelect Resource button. Then 
select the location from the Location drop-down list. 

NOTE: If your team is part of the Supply Pilot, you can scan a resource's incident card to 
select that resource when issuing supplies. 

3. In the Items for Issue grid, click the Supply Item you want to issue to the Resource 
or Location. 

4. Click the Select Item button. 

5. When the Issue Item(s) window displays, enter the quantity of the items being issued 
in the Quantity to Issue box.  

6. Click the Save button. The item displays in the Items Issued grid at the bottom of the 
window. 

7. To add another supply item to the Items Issued grid, repeat steps 3 - 6. 

NOTE: You can only issue items to one Resource or Location at a time. 

NOTE: If your team is part of the Supply Pilot, you can scan either the bar code for the item 
in the Smart Book or the NFES Bar Code on the item. When you scan the bar code, the 
system automatically displays the item in the Items Issued grid on the screen. If there are 
multiple quantities you are issuing, scan the bar code multiple times to increase the quantity 
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amount. 

8. When all items to be issued to the resource or location are in the Items Issued grid, 
click the Save Item(s) button to issue the items.  

NOTE: If one or more of the items had a Property Number defined, a Waybill for the item 
displays in a Preview window. Click the Print Report button to print the Waybill. If the 
Waybill does not display, click the Preview/Print Waybill button.  

B. To use the Quick Issue button to issue Supply Items: 

1. From the Modules drop-down menu select the Supply option 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Select the Resource or Location to Issue To. 

3. Click the Quick Issue button to open the Quick Issue Item(s) window. 

4. In the NFES # to Issue box, enter the appropriate NFES number.  

5. If you are issuing more than one supply item with the same NFES number, click to 
check the Do not clear NFES # checkbox. This leaves the NFES number in the 
NFES# box after you click the Save button.  

6. If applicable, select a property number for the item from the Property Number drop-
down list.   

7. Enter the Quantity to Issue.  

NOTE: If you selected a Property Number, the Quantity to Issue can only be 1. 

8. Enter any comments about the item being issued in the Remarks box.  

9. Click the Save button to save the items to the Item Issued grid.  

NOTE: The Quick Issue Item(s) window remains open after you save the new item count. 
This enables you to quickly issue another item. 

10. To enter additional items, repeat the steps 4 - 9. 

11. After all of the items have been added to the Item Issued grid, click the Cancel 
button, to close the Quick Issue Item(s) window.  

12. To finish issuing, click the Save Item(s) button next to the Items Issued grid.  

III. ADVANCED SEARCH 

A. To perform an Advanced Search in the Supply Items grid: 

1. In the Advanced Search box on the right side of the window, enter the term for which 
you want to search.  

2. Click the Search Name/Desc button. The grid now only contains those items with the 
search term in either the name or the description. For example, if you entered AXE 
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as your search term, only those items with AXE in the name or description would 
display in the grid.  

3. To clear the filter and display all items in the grid, click the Clear Advanced Search 
button.  

IV. REMOVE/CHANGE ISSUE 

A. To remove or change the quantity of an item on the Items Issued grid:  

1. In the Items Issued grid, click to select the item you want to remove or change.  

2. Then click the Remove/Change Issue button. A Remove Item(s) window displays.  

3. In the Correct quantity to Issue box, enter the quantity of the item to issue.  

NOTE: To remove the item from the Item Issued grid, enter 0 (zero) in the Correct quantity 
to Issue box.  

4. Click the Save button to change the quantity or remove the item.  

NOTE: To remove all items from the Items Issued grid, click the Clear Issue button.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.3 - Supply Issue Returns 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Filter Supply Items that are 
Listed 

2. Perform an Advanced Search 

3. Return Supply Items 
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I. ISSUE RETURNS 

A. Filter listed Supply Items. 

B. Perform an Advanced Search 

C. Return Supply Items 

II. FILTER SUPPLY ITEMS 

A. To identify the Supply Items to display in the Items Issued grid: 

1. To display items issued to a location only, click the List Items For All Locations 
Without A Resource button. 

2. To display items issued to a specific resource, click a resource in the Resources grid 
at the top of the window. 

NOTE: If your team is part of the Supply Pilot, you can scan a resource's incident card to 
select that resource when returning supplies. 

3. To display items issued to a specific location, select the location from the Location 
drop-down list. 

4. To display items currently issued to a resource, location, or both, click the All Items 
Issued button.  

NOTE: The All Items Issued button displays all items currently issued. 

4. To display all supply items regardless of whether they were issued, click the Return 
by Item button.  

NOTE: Use the Return by Item feature to return items that may not have been issued using 
I-Suite. 

III. ADVANCED SEARCH 

A. To perform an Advanced Search in the Items Issued grid: 

1. Select a location from the Location drop-down list. 

NOTE: The Advanced Search option searches for a supply item issued to the location 
selected in the Location box, regardless of the other filters selected. A location must be 
selected to perform an Advanced Search in Issue Returns. If the item you want to find was 
not issued to a location, select the Blank location option. 

2. In the Advanced Search box on the right side of the window, enter the term for which 
you want to search.  

3. Click the Search Name/Desc button. The grid now only contains those items with the 
search term in either the name or the description. For example, if you entered AXE 
as your search term, only those items with AXE in the name or description would 
display in the grid.  
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4. To clear the filter and display all items in the grid, click the Clear Advanced Search 
button.  

IV. RETURN SUPPLY ITEMS 

NOTE: You can print an Items Issued Report from the Return Item window. This report 
can help you quickly identify the items you need to return. 

A. To use the Return Items button to return a Supply Item: 

1. Click the item being returned in the Items Issued grid. 

2. Click the Return Items button to open the Return Item window. 

3. In the first box, enter the total quantity , then select READY FOR ISSUE or NOT 
READY FOR ISSUE from the drop-down list.  

4. In the second box, enter the total quantity, then select READY FOR ISSUE or NOT 
READY FOR ISSUE from the drop-down list.  

5. Click the Save button to return the item.  

NOTE: If your team is part of the Supply Pilot, you can scan either the bar code in the Smart 
Book or the NFES bar code on the item to initiate the return process for that item. When you 
scan the bar code, the Return Item window opens with that item selected. Follow instructions 
3 - 5 to complete the return. 

B. To use the Return By Property # button to return a Supply Item: 

1. Click the Return by Property # button. 

2. From the Property Number drop-down list, select the Property Number for the item 
being returned. 

3. If the item being returned it ready for issue, click the Ready For Issue option. If the 
item is not ready for issue, click the Not Ready For Issue option.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.4 - Transfer Supply Items 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Transfer selected items from 
one Resource or Location to 
another. 

2. Perform an Advanced Search. 

3. Remove Transfer Items from 
Items Transferred List before 
transferring. 
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I. TRANSFER SUPPLY ITEMS 

A. Transfer Supplies 

B. Advanced Search 

C. Remove Transfer Items 

II. TRANSFER SUPPLIES 

A. To transfer supplies from one resource or location to another: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. From the Supply drop-down menu, select the Transfer (At Incident) option. 

3. To transfer a supply item to a resource, click the resource in the Issue To grid.  
 
OR 
 
To transfer the supply item to a resource and a location, click the resource in the 
Issue To grid and select the location from the Location drop-down list.  
 
OR 
 
To transfer the supply item to a location, click the UnSelect Resource button. Then 
select the location from the Location drop-down list. 

4. In the Items for Transfer grid, click the item that is being transferred.  

NOTE: Only items that are Trackable and Issued to a resource are listed in the Item Name 
grid. Trackable items are those supply items with a Property Number defined. Property 
Numbers can be defined when the supply item is Added, Received or Issued. 

5. Click the Select Item button to open the Transfer Item window.  

6. In the Remarks area, type any remarks concerning the transfer.  

NOTE: You can only enter Remarks on the Transfer Item window. The name of the item 
and the quantity being transferred are automatically defined, based on the information 
specified when it was initially issued. 

7. Click the Save button to save the transfer item to the Item Transferred grid.  

8. If there are multiple items being transferred to the selected person, repeat steps 4 - 7 
for each item.  

9. Click the Transfer Item(s) button to transfer the item(s) listed in the Items 
Transferred grid to the selected resource or location. 



  

I-Suite Version 13.01.00 Supply  10.4-17 

10. When the Waybill displays in the Preview window, click the Print Report button 
to print the Waybill.  

11. When the Print window displays, click the Print button to print the Waybill.  

III. ADVANCED SEARCH 

A. To perform an Advanced Search for a Supply Item in the Items for Transfer grid: 

1. In the Advanced Search box on the right side of the Supply Transfer window, enter 
the term for which you want to search.  

2. Click the Search Name/Desc button. The grid now only contains those items with the 
search term in either the name or the description. For example, if you entered AXE 
as your search term, only those items with AXE in the name or description would 
display in the grid.  

3. To clear the filter and display all items in the grid, click the Clear Advanced Search 
button.  

IV. REMOVE TRANSFER ITEMS 

A. To remove an item from the Items Transferred grid:  

1. Click the item you want to remove in the Items Transferred grid.  

2. Click the Remove Item button to open the Transfer Item window.  

3. Enter any applicable remarks in the Remarks box, and click the Save button. The 
item is removed from the Items Transferred grid.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.5 - Release Supply Items 

  
OBJECTIVES Upon completion of this unit, the 

trainee will be able to: 
  

  1. Filter supply items in the 
Items for Release grid. 

2. Permanently release supply 
items to an outside location. 

3. Perform an Advanced Search. 

4. Remove or change the 
Quantity for an item in the 
Items Released grid. 



  

I-Suite Version 13.01.00 Supply  10.5-19 

  
I. RELEASE SUPPLY ITEMS 

A. Filter Supplies listed in Items for Release grid. 

B. Permanently release supply items. 

C. Advanced Search. 

D. Remove/Change Release Items. 

II. FILTER SUPPLY ITEMS 

A. Use the filter buttons at the top of the window to filter the Items for Release grid based 
on the following: 

1. To list all supply items, click the All button. 

2. To list only those supply items without an NFES number, click the Non NFES button.

3. To list only those supply items with an NFES number, click the Only NFES button. 

4. To list only accountable supply items, click the Account button. 

B. Use the options listed under Show Items to filter the Items for Release grid based on the 
following: 

1. To list all supply items, regardless of the incident selected, click the All option under 
Show Items. 

2. To list only those supply items for the incident, click the Only at Incident option 
under Show Items. 

III. PERMANENTLY RELEASE SUPPLIES 

A. To use the Select Item button to permanently release supply items to an outside location:

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. From the Supply drop-down menu, select the Release (Permanent) option. 

3. In the Location grid at the top of the window, click to select the Location to which 
items will be released.  

4. In the Items for Release grid, click to select the Supply Item to release.  

5. Click the Select Item button to open the Release Items window.  

6. In the Enter Quantity box, type the total quantity to release.  

7. In the Remarks box, type any applicable remarks.  

8. Click the Save button to save the release information.  

9. Repeat steps 4 - 8 for each item being released to the selected location. 
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NOTE: If your team is part of the Supply Pilot, you can scan either the bar code in the Smart 
Book for the item you are releasing or the NFES bar code on the item. When you scan the bar 
code, the system automatically displays the item in the Items Released grid. 

8. In the ETD box, enter the Estimated Time of Departure, if applicable. 

9. In the ETA box, enter the Estimated Time of Arrival, if applicable.  

10. Click the Save Items button to release those items listed in the Items Released grid 
to the selected location. The Waybill opens in the Preview window. If it does not, 
click the Preview/Print WayBill button. 

11. When the Print window opens, select the printer where you want to send the 
Waybill. Then click the Print button. 

B. To use the Quick Releasebutton to permanently release supply items to an outside 
location:  

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. From the Supply drop-down menu, select the Release (Permanent) option. 

3. In the Location grid, click the location to which you are releasing the items.  

4. Click the Quick Release button to open the Quick Release Item(s) window.  

5. In the NFES # to Release box, enter the appropriate NFES number.  

6. If you are issuing more than one supply item with the same NFES number, click to 
check the Do not clear NFES # checkbox. This leaves the NFES number in the 
NFES# box after you click the Save button.  

7. If applicable, select a property number for the item from the Property Number drop-
down list.   

8. Enter the Quantity to Release.  

9. Enter any comments about the item being issued in the Remarks box.  

10. Click the Save button to save the items to the Items Released grid.  

NOTE: The Quick Release Item(s) window remains open after you save the new item count. 
This enables you to quickly add another release item. 

11. To enter additional items, repeat the steps 5 - 10.  

12. After all of the items have been added to the Item Issued grid, click the Cancel 
button, to close the Quick Release Item(s) window.  

13. In the boxes above the Items Released grid, enter the ETD (Estimated Time of 
Departure) and the ETA (Estimated Time of Arrival).  

14. To finish the release process, click the Save Item(s) button next to the Items 
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Released grid.  

IV. ADVANCED SEARCH 

A. To perform an Advanced Search in the Items for Release grid: 

1. In the Advanced Search box on the right side of the window, enter the term for which 
you want to search.  

2. Click the Search Name/Desc button. The grid now only contains those items with the 
search term in either the name or the description. For example, if you entered AXE 
as your search term, only those items with AXE in the name or description would 
display in the grid.  

3. To clear the filter and display all items in the grid, click the Clear Advanced Search 
button.  

V. REMOVE/CHANGE RELEASE ITEMS 

A. To remove or change the quantity of an item listed in the Items Released grid: 

1. In the Items Released grid, click to select the incorrect item.  

2. Click the Remove/Change Release button to open the Release Item(s) window.  

3. In the Enter quantity to Release box, enter the quantity of the item to release.  

NOTE: To remove the item from the Items Released grid, enter 0 (zero) in the Enter 
quantity to Release box. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.6 - Add/Edit Supply Items 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Add Supply Items 

2. Edit Supply Items 
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I. ADD/EDIT SUPPLIES 

A. Add Supplies 

B. Edit Supplies 

II. ADD SUPPLIES 

A. To add Supply Items: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the Add Supply Item button in the Supply toolbar. 

3. On the Supply - Add Supply Item window, click the Add button.  

4. In the Name box, type the name of the supply item. This information is required.  

5. In the Description box, type a description of the supply item. This information is 
required.  

6. In the NFES # box, type the National Fire Equipment System (NFES) number for 
the item. 

7. From the Category drop-down list, identify whether the item is Consumable, 
Durable or Trackable. 

8. If applicable, type the property number assigned to the item in the Property # box.  

9. From the From Location drop-down list, select the location where the item 
originated.  

10. From the Supply Catalog Access drop-down list, select the departments who 
should have access to the item. The options include Supply Only, 
Communications Only, or All.  

11. In the Cost box, type the cost of the item.  

12. If the item is a rental, click to check the Rental Item checkbox.  

13. In the Qty On Hand box, type the total number of the item currently available at the 
incident.  

14. In the ReOrder Qty box, type the quantity at which the item should be re-ordered.  

15. From the Qty Per Container drop-down list, select the total quantity included in 
each container for the item.  

16. From theUnit of Issue drop-down list, select the unit at which the item is issued.  

17. If the item is a hazardous material, select the hazard type from the Hazardous drop-
down list.  
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18. Type the item's measurements in the Weight-US (lbs), Weight-Metric (kgs), or 
Cubes (ft^3) box.  

19. In the Remarks box, type any applicable remarks for the item.  

20. To save the Supply Item, click the Save button.  

21. When you have finished adding all of the appropriate items, click the Close button 
to close the Supply - Add Supply Item window.  

III. EDIT SUPPLIES 

A. To edit supply items: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the Add Supply Item button in the Supply toolbar. 

3. Click one of the following buttons to filter the Supply Item grid at the top of the 
window:  

a. All - Displays all supply items.  

b. Non NFES - Displays supply items without an NFES number.  

c. Only NFES - Displays only supply items with an NFES number.  

4. In the Supply Item grid at the top of the window, click to select the supply item you 
want to edit. The information for the item displays in the Edit Supply Item area at 
the bottom of the window. 

NOTE: If your team is part of the Supply Pilot, you can scan either the bar code in the Smart 
Book for the item you are editing or the NFES Bar Code on the item. When you scan the bar 
code, the system automatically displays that supply item in the Edit Supply Item area at the 
bottom of the window.  

5. If the Supply Item is one from the Supply Catalog, the only information you can 
change is the Supply Catalog Access.  
 
If the Supply Item is one that is not from the Supply Catalog, you can change all 
data for the supply item.  

6. To save your changes, click the Save button.  

7. When you have finished editing all appropriate items, click the Close button to close 
the Supply - Add Supply Item window.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.7 - Add/Edit Locations 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Add Within Incident 
Locations. 

2. Edit Within Incident 
Locations. 

3. Add Outside Incident 
Locations. 

4. Edit Outside Incident 
Locations. 
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I. ADD/EDIT LOCATIONS 

A. Add Within Incident Locations 

B. Edit Within Incident Locations 

C. Add Outside Incident Locations 

D. Edit Outside Incident Locations 

II. ADD WITHIN INCIDENT LOCATIONS 

A. To add locations that are within the incident: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the Add/Edit Location Other button in the Supply toolbar. 

3. On the Add Location/Other window, click the Within Incident button, and then 
click the Add button.  

4. In the Location/Other Name box, type the name of the location. The Location Name
is required.  

5. In the Location Code box, type the code to assign to the location. The Location Code
is required.  

6. In the POC Name box, type the name of the point -of-contact at the location. 

7. In the POC Phone # box, type the telephone number for the point-of-contact. 

8. In the POC Email box, type the e-mail address for the point-of-contact. 

9. In the Latitude box, enter the location's latitude. 

10. In the Longitude box, enter the location's longitude. 

11. In the Remarks box, type any remarks applicable to the location.  

12. Click the Save button to save the location.  

13. Click the Close button to close the Add Location/Other window.  

III. EDIT WITHIN INCIDENT LOCATIONS 

A. To edit a location that is within the incident: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 
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2. Click the Add/Edit Location Other button in the Supply toolbar. 

3. On the Add Location/Other window, click the Within Incident button.  

4. Click the location you want to edit in the grid at the top of the window.  

5. For inside locations that you added, you can change all of the location's information. 
For inside locations that are standard in the system, you can make changes to the 
following information:  

a. POC Name  

b. POC Phone # 

c. POC Email  

d. Latitude 

e. Longitude 

f. Remarks  

6. Click the Save button to save your changes.  

7. Click the Close button to close the Add Location window.  

IV. ADD OUTSIDE INCIDENT LOCATION 

A. To add a location that is outside of an incident: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the Add/Edit Location Other button in the Supply toolbar. 

3. On the Add Location/Other window, click the Outside Incident button, and then 
click the Add button.  

4. In the Location/Other Name box, type the name of the location. The Location/Other 
Name is required.  

5. In the Location Code box, type the code to assign to the location. The Location Code
is required.  

6. From the Location Type drop-down list, select one of the following location types: 

a. B - Business Address  

b. L - Local Cache Address  

c. N - National Cache Address  

d. R - Regional Cache Address  

7. In the Address 1, Address 2, City, State, and Zip boxes, type the location's address.  

8. In the POC Name box, type the name of the point-of-contact at the location.  
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9. In the POC Email box, type the e-mail address for the point-of-contact.  

10. In the POC Phone # box, type the telephone number for the point-of-contact.  

11. In the Fax Phone # box, type the fax number for the point-of-contact.  

12. In the Remarks box, type any remarks applicable to the location. 

13. To save the new Location, click the Save button.  

14. To close the Add Location/Other window, click the Close button.  

V. EDIT OUTSIDE INCIDENT LOCATION 

A. To edit a location that is outside of an incident: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the Add/Edit Location button in the Supply toolbar. 

3. Click the Outside Incident button. Then click to select the location you want to edit 
in the grid at the top of the window.  

4. For outside locations that you added, you can change all of the location's information. 
For outside locations that are standard in the sytem, you can make changes to the 
following information:  

a. POC Name  

b. POC Email  

c. Remarks  

5. Click the Save button to save any changes you made.  

6. Click the Close button to close the Add Location window.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.8 - View Supply History 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. View a History of Supply 
Transactions. 
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I. VIEW SUPPLY HISTORY 

A. To view a history of Supply transactions: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the View History button in the Supply toolbar. 

3. Click the Resource/Location button to view a list of resources and locations with 
supply transactions. 
 
OR 
 
Click the Supply Items button to view a list of items with supply transactions. 

4. Click the plus sign (+) next to a Resource/Location or a Supply Item to display a list 
of transactions. 

5. When you have finished viewing the supply transactions, click the Close button to 
close the View Supply History window. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.9 - Supply Inventory 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Turn Inventory Tracking ON. 

2. Manually change inventory 
counts. 

3. Perform an Advanced Search 
of supply items. 

4. Change a supply item 
quantity. 
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I. SUPPLY INVENTORY 

A. Turn Inventory Tracking ON. 

B. Manually change inventory counts. 

C. Perform an Advanced Search. 

D. Change a supply item quantity. 

II. TURN INVENTORY TRACKING ON 

A. To turn Inventory Tracking on: 

1. From the Tools drop-down menu, select Options to open the Options window. 

2. Click the Supply tab. 

3. Click to check the Track Inventory checkbox. 

4. To save the change, click the Save button. Then click the OK button to close the 
Options window. 

NOTE: If supply items were not Received in the Supply module, your inventory counts will 
be off when you turn on the Inventory Tracking option.  

III. MANUALLY CHANGE INVENTORY COUNTS 

A. To use the Correct Item Inventory button to update Inventory Counts in the Supply 
module based on a manual count:  

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. From the Supply drop-down menu, select the Inventory option to open the Supply-
Inventory window. 

3. In the Items to Inventory grid, click the supply item that needs corrections made to 
the inventory count.  

4. Click the Correct Item Inventory button to open the Correct Item Inventory 
window.  

5. In the Actual NRFI box, type the total number of items that are Not Ready For 
Issue.  

6. In the Actual RFI box, type the total number of items that are Ready For Issue. 

7. Click the Save button to save the counts to the Corrected Inventory Items grid.  

8. Repeat steps 3 - 7 for each supply item that needs corrections made to the inventory 
count.  

NOTE: If your team is part of the Supply Pilot, you can scan either the bar code in the Smart 
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Book for the inventory item or the NFES Bar Code on the item. When you scan the bar code, 
the system automatically opens the Correct Item Inventory window with the scanned 
inventory item selected. Repeat steps 5-7. 

9. After all of the inventories that needed corrections have been added to the Corrected 
Inventory Items grid, click the Save button that displays on the right side of the 
window.  

B. To use the Quick Inventory button to manually change inventory counts: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. From the Supply drop-down menu, select the Inventory option. 

3. Click the Quick Inventory button to open the Quick Adjust Inventory Item Counts 
window.  

4. In the NFES # box, type the NFES number for the item that needs corrections made to 
the inventory count.  

5. If appropriate, type a property number in the Property Number box or select the 
number from the drop-down list.  

6. In the Actual NRFI box, type the total number of items that are Not Ready For 
Issue. 

7. In the Actual RFI box, type the total number of items that are Ready For Issue.  

8. Click the Save button to save the item counts to the Corrected Inventory Items grid. 

NOTE: The Quick Adjust Inventory Item Counts window remains open after you save the 
new item count. This enables you to quickly add another adjustment. 

9. Repeat steps 4 - 8 for each supply item that needs corrections made to the inventory 
counts. 

10. After all of the inventories that needed corrections have been added to the 
Corrected Inventory Items grid, click the Cancel button to close the Quick 
Adjust Inventory Item Counts window.  

11. Click the Save button that displays on the right side of the window to save the 
corrected inventory counts.  

IV. ADVANCED SEARCH 

A. To perform an Advanced Search in the Items to Inventory grid: 

1. In the Advanced Search box on the right side of the window, enter the term for which 
you want to search.  

2. Click the Search Name/Desc button. The grid now only contains those items with the 
search term in either the name or the description. For example, if you entered AXE 
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as your search term, only those items with AXE in the name or description would 
display in the grid.  

3. To clear the filter and display all items in the grid, click the Clear Advanced Search 
button.  

V. CHANGE INVENTORY QUANTITY 

A. To update the quantity define for an item listed in the Corrected Inventory Items grid: 

1. Click the item listed in the Corrected Inventory Items grid that you want to change. 

2. Click the Change Inventory button to open the Adjust Inventory Item Count 
window. 

3. In the Actual RFI box, type the total number of items that are Ready For Issue.  

4. In the Actual NRFI box, type the total number of items that are Not Ready For 
Issue.  

5. Click the Save button to save the new quantities for the item.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 10.10 - Receive Supplies 

  
OBJECTIVES: Upon completion of this unit, the 

trainee will be able to: 
  

  1. Receive Supply Items. 

2. Filter Supply Items. 

3. Perform an Advanced Search 
in the Item to Receive grid. 

4. Remove or change the 
quantity for an Item Being 
Received. 
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I. RECEIVE SUPPLIES 

A. Receive items into Supply. 

B. Filter Item to Receive grid. 

C. Perform an Advanced Search. 

D. Remove or change the quantity of Items Being Received. 

II. RECEIVE SUPPLY ITEMS 

A. To use the Receive Items button to receive items into the Supply module: 

NOTE: Supply items do not need to be received before issuing. 

NOTE: If you are using the Track Inventory option, it is a good idea to receive supply items 
to ensure your counts are correct. 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the Receive button in the Supply toolbar to open the Supply-Receive window. 

3. From the From Location drop-down list, select the location from which you are 
receiving the supply item.  

NOTE: If you do not select a location before receiving a supply item, a message displays 
indicating that a location was not selected. Click the Yes button to receive the item without 
selecting a location. Click the No button to cancel the receive procedure and select a location. 

4. In the Item to Receive grid, click the item you want to receive.  

5. Click the Receive Item button. A Receive Item window displays.  

6. In the Quantity to Receive box, enter the total number of items being received. 

NOTE: Make sure to enter the total number of actual items, rather than the unit of items (e.g. 
when receiving a box of shovels enter the number of shovels rather than the number of boxes.) 

7. Enter the Property # assigned to the item, if applicable. 

8. Enter the Serial # assigned to the item, if applicable. 

9. Enter an Additional # assigned to the item, if applicable. 

10. In the Remarks box, type any remarks that apply to the receive item transaction.  

11. Click the Save button to save the supply item to the Items Being Received grid.  

12. Repeat steps 4 - 11 for each item you are receiving from the selected location.  

NOTE: If your team is part of the Supply Pilot, you can scan either the bar code in the Smart 
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Book for the item you are receiving or the NFES Bar Code on the item. When you scan the 
bar code, the system automatically displays the item in the Items Being Received grid on the 
screen. If there are multiple quantities you are receiving, scan the bar code multiple times to 
increase the quantity amount. 

13. When all items you are receiving are listed in the Items Being Received grid, click 
the Save button to complete the Receive procedure.  

B. To use the Quick Receive button to receive items into the Supply module: 

1. From the Modules drop-down menu, select the Supply option. 
 
OR 
 
Click the Supply button in the Main toolbar. 

2. Click the Receive button in the Supply toolbar to open the Supply-Receive window. 

3. Click the Quick Receive button to open the Quick Receive Item(s) window.  

4. In the NFES # box, enter the NFES number for the supply item you are receiving.  

5. If you are receiving more than one supply item with the same NFES number, click to 
check the Do not clear NFES # checkbox. This leaves the NFES number in the 
NFES# box after you click the Save button.  

6. In the Quantity to Receive box, enter the total number being received.  

7. If applicable, enter a property number for the item in the Property # box.  

8. Click the Save button. The item displays in the Items Being Received grid and the 
Quick Receive Item(s) window remains open. You can then quickly enter another 
item.  

9. Repeat steps 4 - 8 for each item you are receiving from the selected location.  

10. When you have finished receiving items, click the Cancel button to close the Quick 
Receive Item(s) window.  

11. Click the Save button to finish receiving the items into Supply.  

III. FILTER ITEM TO RECEIVE 

A. On the Supply - Receive window, click one of the following buttons to filter the list of 
supplies:  

1. All - Displays all supply items  

2. Non NFES - Only displays supply items without NFES numbers  

3. Only NFES - Only displays supply items with NFES numbers  

4. Account - Only displays Accountable supply items  

IV. ADVANCED SEARCH 

A. To perform an Advanced Search in the Item to Receive grid: 
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1. In the Advanced Search box on the right side of the window, enter the term for which 
you want to search.  

2. Click the Search Name/Desc button. The grid now only contains those items with the 
search term in either the name or the description. For example, if you entered AXE 
as your search term, only those items with AXE in the name or description would 
display in the grid.  

3. To clear the filter and display all items in the grid, click the Clear Advanced Search 
button.  

V. REMOVE/CHANGE ITEM BEING RECEIVED 

A. To remove or change the quantity of an item in the Item Being Received grid: 

1. In the Items Being Received grid, click the item you want to edit.  

2. Click the Remove/Change Receive button to open the Receive Items window.  

3. In the Enter the correct quantity to Receive box, enter the total number being 
received.  

NOTE: To remove the item, enter 0 (zero) in the Enter the correct quantity to Receive box. 

4. Click the Save button to change the quantity or remove the item.  
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 11.0 – Injury and Illness: Overview. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Identify the purpose of the Injury/Illness 
module.  

2. Identify the basic features of the 
Injury/Illness screen.  
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I. INJURY/ILLNESS 

A. Identify the purpose of the Injury/Illness Module. 

1. Use the Injury/Illness module to track injuries and illnesses for resources during an 
incident. 

B. Identify the basic features of the Injury/Illness Screen. 

1. The Injury/Illness toolbar is located to the right of the Filter toolbar. The buttons in 
this toolbar include: 

a. Show Injury/Illness Details - If the Injury/Illness area at the bottom of the 
window is closed, click this button to open the area. 

b. Defaults - Click this button to open the Injury/Illness Options window. 
Use this window to set the defaults for the Injury/Illness module. 

c. View History - Click this button to view a history of injuries and illnesses 
recorded for resources in the database. 

d. Stats Base - Click this button to define statistics to use in generating the 
Injuries and Frequency report. 

e. Previous Injury/Illness - When this checkbox is checked, only those 
resources with Injury/Illness records are included in the Resources grid. 

2. The Resources grid contains a list of the resources currently in the I-Suite database. 

3. Use the Manage Injury/Illness area at the bottom of the window to add new injury 
illness records or edit existing records for a resource. 

4. The Injury/Illness grid at the bottom of the window displays a list of injury and 
illness records defined for the selected resource. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 11.1 – Injury and Illness: Options. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. Select Injury/Illness Columns and set the 
order.  

2. Define a default Incident Type.  

3. Define a default Management Level. 

4. Define default Estimated Hours Worked / 
Day 
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I. INJURY/ILLNESS OPTIONS 

A. Select Injury/Illness Columns and set the order. 

B. Define default Incident Type. 

C. Define default Management Level. 

D. Define default Estimated Hours Worked / Day 

II. RESOURCE GRID 

A. To identify the columns to display in the grid and the order in which to display them: 

1. From the Tools drop-down menu, select Options to open the Options window. 
 
OR 
 
Click the Defaults button on the Injury/Illness window. 

2. Click the Injury/Illness tab.  

3. Under Resource Grid Columns, click to check the checkbox next to each of the 
columns you want to include in the Resources grid. 

NOTE: You can also click to highlight a column, and then click the Show button to display 
that column in the grid. If you want to remove the selected columns from the Resources grid, 
click the Hide button.  

4. To adjust the order in which the columns display on the Injury/Illness window, click 
a column. Then click the Move Up or Move Down button to move the column. 

5. When you have made all of your changes, click the Save button to save your changes. 
Then click the OK button to close the Options window. 

III. INCIDENT TYPE DEFAULT 

A. To identify a default Incident Type to display in the Incident Type box on the 
Injury/Illness window: 

1. From the Tools drop-down menu, select Options to open the Options window. 
 
OR 
 
Click the Defaults button on the Injury/Illness window. 

2. Click the Injury/Illness tab. 

3. From the Incident Type drop-down list, select one of the following types to use as the 
default: 

• All Hazard 

• Prescribed Fire 
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• Wildland Fire 

• Wildland Fire Use 

4. Click the Save button to save your changes. Then click the OK button to close the 
Options window. 

IV. MANAGEMENT LEVEL DEFAULT 

A. To identify a default Management Level to display in the Management Level box on 
the Injury/Illness window: 

1. From the Tools drop-down menu, select Options to open the Options window. 
 
OR 
 
Click the Defaults button on the Injury/Illness window. 

2. Click the Injury/Illness tab. 

3. From the Management Level drop-down list, select the level (1-5) to use as the 
default. 

4. Click the Save button to save your changes. Then click the OK button to close the 
Options window.  

V. ESTIMATED HOURS WORKED / DAY 

A. To identify the default hours to display in the Estimated Hours Worked / Day box on the 
Stats Base window: 

1. From the Tools drop-down menu, select Options to open the Options window. 
 
OR 
 
Click the Defaults button on the Injury/Illness window. 

2. Click the Injury/Illness Tab. 

3. In the Estimated Average Hours Worked per Day per Resource box, type the 
number of hours to use as the default. 

4. Click the Save button to save your changes. Then click the OK button to close the 
Options window. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 11.2 – Injury and Illness: Adding an 

Injury/Illness. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Add injury, illness or prevention records.

2. Use advanced search to find an injury or 
illness type. 
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I. ADD INJURY/ILLNESS/PREVENTION 

A. To add an injury, illness or prevention record: 

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. In the Resources grid, click the resource for which you are adding the injury, illness 
or prevention record. 

NOTE: The resource you select must be a person. You cannot create an injury, illness or 
prevention record for a non-person resource. 

3. Click the Injury, Illness or Prevention option to identify whether this is an injury, 
illness or prevention record. 

NOTE: The labels on the window will change based on the option you select. For example, if 
you select Injury, the label Injury Date displays. If you select Illness, the label Illness Date 
displays. 

4. If the condition is pre-existing, click to check the Pre-Existing option. 

5. In the Seen Date box, enter the date when the resource was initially seen for the 
condition. You can either type the date or select it from the drop-down calendar. 

6. In the Injury/Illness/Prevention Date box, enter the date when the injury or illness 
first occurred. If this is a prevention visit, enter the date when the resource first 
needed the prevention item. You can either type the date or select it from the drop-
down calendar. 

7. In the Injury/Illness/Prevention Time box, enter the time when the injury or illness 
occurred. If this is a prevention visit, enter the time when the resource needed the 
prevention item. 

8. From the Location on Incident drop-down list, select where the resource was located 
when the injury or illness occurred. If this is a prevention visit, select the location 
where the resource needs the prevention item. 

9. From the Incident Type drop-down list, select the appropriate incident type. 

NOTE: If a default incident type was defined on the Options window, it will automatically 
display in the Incident Type box. If needed, you can change this entry by selecting another 
type from the drop-down list. 

9. From the Incident Management Level drop-down list, select the appropriate 
management level. 

NOTE: If a default management level was defined on the Options window, it will 
automatically display in the Incident Management Level box. If needed, you can change this 
entry by selecting another level from the drop-down list.  

10. From the Incident Phase drop-down list, select the appropriate phase. 

11. From the Incident Where Injury/Illness/Prevention Occurred drop-down list, 
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select the incident where the resource was working when the injury or illness 
occurred. If this is a prevention visit, select the incident where the resources needs 
the prevention item. 

NOTE: The entry in the Incident Where Injury/Illness/Prevention Occurred box 
automatically defaults to the incident where the resource is assigned. 

12. From the Injury/Illness Type drop-down, select the appropriate injury or illness. 

NOTE: If Prevention is selected, the Injury/Illness Type box does not display on the 
window. Enter information about the prevention visit in the Remarks box. 

NOTE: If you cannot find the appropriate injury or illness type, click the Search button to 
perform an advanced search. For more information on using the Advanced Search function, 
refer to section II. Advanced Search. 

13. From the Activity at Time of Injury/Illness/Prevention drop-down list, select the 
activity the resource was performing when the injury or illness occurred. If this is a 
prevention visit, select the activity for which the resource needs the prevention item.

14. From the Section Assignment drop-down list, select the appropriate section 
assignment. 

15. From the Sub Assignment drop-down list, select the appropriate sub-assignment. 

NOTE: The options available in the Sub Assignment drop-down list are based on the Section 
Assignment that is selected. 

16. In the Division/Group Name box, type the appropriate division or group name. 

17. If duties were restricted or time lost because of the injury or illness, click to check 
the Restricted Duty/Lost Time checkbox. 

18. If the resource was seen off-site for the injury or illness, click to check the 
Treatment Off-Site checkbox. 

19. In the Remarks box, enter any additional information about the injury or illness. 
Use this area to identify any known or suspected factors that contributed to or 
caused the injury or illness. If this is a prevention visit, enter any information about 
the prevention item in this box. 

NOTE: If your remarks will not fit in the Remarks box, click the Remarks button to display 
a Remarks window where you can enter additional remarks. 

20. Click the Save button to save the injury, illness or prevention record. 

NOTE: Notice that when you save the record, it automatically displays in the grid at the 
bottom of the window. This grid contains a list of all the injury, illness and prevention records 
that were defined for a resource. 

II. ADVANCED SEARCH 

A. To perform an advanced search for an injury or illness type: 
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1. Click the Search button that displays next to the Injury/Illness Type box. 

2. In the Search For box, type the name of the injury or illness that you want to find. 

3. Click the Search button to limit the grid to only list those items with the search term 
(e.g. if you enter "Headache" only those items with headache in the name display in 
the grid). 

4. In the grid at the top of the window, click the appropriate type. 

5. Click the OK button to insert the highlighted type into the Injury/Illness Type box on 
the Injury/Illness window. 



  

  
I-Suite Version 13.01.00 Injury/Illness   11.3-12 

  

STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 11.3 – Injury and Illness: Editing an 

Injury/Illness. 
  

OBJECTIVES: Upon completion of this unit, the trainee will be 
able to: 
  

  1. Edit injury, illness or prevention records.

2. Delete injury, illness or prevention 
records. 
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I. EDIT INJURY/ILLNESS/PREVENTION 

A. To edit an injury, illness or prevention record: 

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. In the Resources grid, click the appropriate resource. 

3. In the Injury/Illness/Prevention grid at the bottom of the window, click the record 
you want to edit. 

4. Make the appropriate changes to the information. 

5. Click the Save button to save the changes. 

II. DELETE INJURY/ILLNESS/PREVENTION 

A. To delete an injury, illness or prevention record: 

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. In the Resources grid, click the appropriate resource. 

3. In the Injury/Illness/Prevention grid at the bottom of the window, click the record 
you want to delete. 

4. Click the Delete button at the bottom of the window. 

5. When the Confirmation window displays, click the Yes button. 
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STUDENT MANUAL 
  
COURSE: I-Suite 

  
UNIT: 11.4 – Injury and Illness: Working with Output. 

  
OBJECTIVES: Upon completion of this unit, the trainee will be 

able to: 
  

  1. View history. 

2. Create Stats Base. 

3. Print Reports. 

4. Export Injury/Illness Data. 
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I. OUTPUT OPTIONS 

A. View History 

B. Stats Base 

C. Injury/Illness Reports 

D. Export Injury/Illness Data 

II. VIEW HISTORY 

A. To view a history of injury, illness and prevention records: 

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. Click the View History button in the Injury/Illness toolbar. 

3. To list the records by resource, click the Resource button. 

4. Click the plus sign (+) next to a resource to display those injury, illness, and 
prevention records created for the resource. 

NOTE: When Managing Incidents Separately, the grid only includes those resources 
assigned to the selected incident. If a resource was assigned to the selected incident, but 
received the injury/illness/prevention while working on a different incident, the name of the 
incident on which they were working displays in the Occurred Incident column.  
 
When Manage All Incidents as One is selected, an Assigned Incident column displays in 
the grid. This column identifies the incident to which the resource was assigned. The 
Occurred Incident column identifies the incident on which they were working when the 
injury/illness/prevention occurred. 

5. To list the records by injury, illness and prevention, click the 
Injury/Illness/Prevention button. 

6. Click the plus sign (+) next to a record to display a list of resources for which the 
injury/illness/prevention record was created. 

NOTE: When Managing Incidents Separately, the grid only includes those injures and 
illnesses that occurred for the selected incident. When you click the plus sign (+) next to an 
Injury/Illness/Prevention record, a list of resources for which the records were created 
displays. The Assigned Incident column identifies the incident to which the resource was 
assigned.  
 
When Manage All Incidents as One is selected and you click the plus sign (+) next to an 
Injury/Illness/Prevention record, an Occurred Incident column displays. This column 
identifies where the resource was working when the injury/illness/prevention occurred. 

7. After you have finished viewing the history, click the Close button to Close the View 
History window. 

III. STATS BASE 



  

I-Suite Version 13.01.00 Injury/Illness   11.4-16 

NOTE: Use the Stats Base option to calculate the cumulative hours worked on a defined date.
I-Suite uses the statistics defined in the Stats Base when generating the Injuries and 
Frequency report. 

NOTE: To Add or Edit Stats Base data, a Single Incident must be selected. You cannot Add 
or Edit Stats Base data when in Manage All Incidents as One mode. 

A. To add statistics to the Stats Base: 

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. Click the Stats Base button in the Injury/Illness toolbar. 

NOTE: If the Manage All Incidents as One checkbox is checked, a message displays 
indicating that you cannot Add or Edit Stats Base Data when Manage All Incidents As One 
is selected. If you click Yes to continue, the Stats Base window opens in View Only mode.  

1. In the Date box, enter the appropriate date for the statistics. You can either type the 
date or select it from the drop-down calendar. 

2. In the Total People box, type the total number of people working on the specified 
date. 

3. In the Est. Hrs Worked / Day box, type the average number of hours each person 
worked that day. 

NOTE: The number in this box defaults to the number defined in the Estimated Average 
Hours Worked per Day per Resource box on the Options - Injury/Illness window. 

6. Click the Save button. 

NOTE: When you save the statistics, I-Suite automatically calculates the cumulative work 
hours for that day. The statistics display in the grid at the top of the window. 

IV. INJURY/ILLNESS REPORTS 

A. To print standard Injury/Illness reports: 

1. Click the Reports button in the toolbar. Then click to select the Injury/Illness button.
 
OR 
 
From the Reports drop-down menu, select Injury/Illness Reports. 

2. Click to select one of the following reports: 

a. Injury/Illness by Type - This report identifies the total number of injury, 
illness and prevention records currently defined in the database. The 
information is broken down by injury/illness type. 

NOTE: Because no type is assigned to Prevention records, they are listed generally under 
Prevention. 
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To generate an Injury/Illness by Type report: 

• Under Report Settings, click one of the following options to identify 
the dates to include in the report: 
 
All Dates - Includes all dates in the report. 
 
Date Range - Includes the date range defined in the Date Range 
boxes. When you select this option, you must enter dates into the two 
boxes. 

• To preview the report, click the Preview button. To print the report, 
click the Print button. 

b. Injury/Illness/Prevention - This report includes detailed information about 
injury, illness or prevention records. 

NOTE: The Injury/Illness/Prevention report does not include resource names. It only 
identifies the injury, illness or prevention information. 

To generate an Injury/Illness/Prevention report: 

• Under Sort, double click each sort to use in the report. The Sort moves 
from the left frame to the right frame. The sort order in the report is 
based on the order in which you select the sort options. 

• Under Event Category, click one of the following options to identify 
the information to include in the report: 
 
Injury - Only includes Injury records in the report. 
 
Illness - Only includes Illness records in the report. 
 
Prevention - Only includes Prevention records in the report. 
 
All - Includes Injury, Illness and Prevention records in the report. 

• To preview the report, click the Preview button. To print the report, 
click the Print button. 

c. Injury/Illness by Date - This report identifies the total number of injuries, 
illnesses and prevention visits that occurred on a defined date. 

  
To generate an Injury/Illness by Date report: 

• Under Report Settings, click one of the following options to identify 
the dates to include in the report: 
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All Dates - Includes all dates in the report. 
 
Date Range - Includes the dates defined in the Date Range boxes. 
When you select this option, you must enter dates into the two boxes. 

• To preview the report, click the Preview button. To print the report, 
click the Print button. 

d. Injuries and Frequency - This report identifies the number of people 
injured as compared to the number of people working and the hours worked 
on a defined date. It also identifies the cumulative injuries and frequency of 
injuries. 

NOTE: The Injuries and Frequency report uses the statistics defined in the Stats Base to 
generate the data for this report. 

To print an Injuries and Frequency report: 

• Under Report Settings, click one of the following options to identify 
the dates to include in the report: 
 
All Dates - Includes all dates in the report. 
 
Date Range - Includes the dates defined in the Date Range boxes. 
When you select this option, you must enter dates into the two boxes. 

• Under Frequency Formula, click one of the following options to 
identify the formula to use in calculating the data for the report: 
 
OSHA (# injuries/illnesses X 200,000) / (# of hours worked) 
 
BASIC (# injuries/illnesses) / (# of hours worked) 

• To preview the report, click the Preview button. To print the report, 
click the Print button. 

e. Medical Unit Daily Summary - This report contains a summary of injuries 
and illnesses that were reported to the Medical Unit for each defined date. 

To generate a Medical Unit Daily Summary: 

• Under Report Settings, click one of the following options to identify 
the dates to include in the report: 
 
All Dates - Includes all dates in the report. 
 
Date Range - Includes the dates defined in the Date Range boxes. 
When you select this option, you must enter dates into the two boxes. 

• To preview the report, click the Preview button. To print the report, 
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click the Print button. 

f. Injury/Illness Types Report - This report contains a list of all Injury/Illness 
Types the medical or safety officer can select from the Injury/Illness Type 
drop-down list.  

To generate an Injury/Illness Types Report: 

• On the Injury/Illness Reports window, click the Injury/Illness Types 
option.  

• To preview the report, click the Preview button. To print the report, 
click the Print button. 

V. EXPORT INJURY/ILLNESS DATA 

A. To export Injury/Illness data and upload it to the Data Repository site:  

1. The Injury/Illness user must contact the Database Administrator (usually the CTSP) 
and request an Injury/Illness Export. 

NOTE: The CTSP uses the Export Data option in Database Admin to export Injury/Illness 
data to a file and upload it to the Data Repository site. 
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